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Documentation Updates

The title page of this document contains the following identifying information:

• Software Version number, which indicates the software version.

• Document Release Date, which changes each time the document is updated.

• Software Release Date, which indicates the release date of this version of the software.

To check for recent updates, or to verify that you are using the most recent edition of a 
document, go to:

http://h20230.www2.hp.com/selfsolve/manuals 

This site requires that you register for an HP Passport and sign-in. To register for an HP 
Passport ID, go to: 

http://h20229.www2.hp.com/passport-registration.html 

Or click the New users - please register link on the HP Passport login page.

You will also receive updated or new editions if you subscribe to the appropriate product 
support service. Contact your HP sales representative for details.
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Support

Visit the HP Software Support web site at:

http://www.hp.com/go/hpsoftwaresupport 

This web site provides contact information and details about the products, services, and 
support that HP Software offers.

HP Software online support provides customer self-solve capabilities. It provides a fast and 
efficient way to access interactive technical support tools needed to manage your business. 
As a valued support customer, you can benefit by using the support web site to:

• Search for knowledge documents of interest

• Submit and track support cases and enhancement requests

• Download software patches

• Manage support contracts

• Look up HP support contacts

• Review information about available services

• Enter into discussions with other software customers

• Research and register for software training

Most of the support areas require that you register as an HP Passport user and sign in. 
Many also require a support contract.  To register for an HP Passport ID, go to:

http://h20229.www2.hp.com/passport-registration.html 

To find more information about access levels, go to:

http://h20230.www2.hp.com/new_access_levels.jsp 
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Welcome to This Guide

Welcome to the HP Performance Center Installation Guide. This guide
describes how to install HP ALM Performance Center components.
To install HP ALM Performance Center, you must first install HP ALM,
as described in the HP Application Lifecycle Management Installation 
and Upgrade Guide.

How This Guide is Organized

The HP Performance Center Installation Guide describes the system
prerequisites and installation process for HP ALM Performance Center.

It contains the following parts:

 Part I Getting Started

Provides an overview of the installation flow, the system components, and 
the data flow. In addition provides installation prerequisites and 
considerations for the Performance Center components, and outlines 
required services.

 Part II Installation and Configuration

Describes how to install HP ALM Performance Center components and 
provides initial and optional configuration instructions.

 Part III Working with Previously Created Performance Center Projects

Describes how to upgrade from earlier versions of Performance Center to the 
current version, including data and project migration.
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 Part IV Working with Firewalls

Describes how to set up the ALM Performance Center components to 
communicate with other ALM Performance Center components that are 
located over a firewall.

 Part V Troubleshooting

Troubleshoots issues that may arise related to the installation of the 
Performance Center components.

ALM Help

ALM Help is an online help system that describes how to use ALM. You can 
access ALM Help in the following ways:

➤ Click Documentation Library in the ALM Help menu to open the ALM 
Help home page. The home page provides quick links to the main help 
topics.

➤ Click Help on this page in the ALM Help menu to open the ALM Help to 
the topic that describes the current page.



Welcome to This Guide

13

ALM Help Guides

The ALM Help consists of the following guides and references, available 
online, in PDF format, or both. PDFs can be read and printed using Adobe 
Reader, which can be downloaded from the Adobe Web site 
(http://www.adobe.com).

HP Application Lifecycle Management (ALM) Guides

Reference Description

Using ALM Help Explains how to use ALM Help and how it is organized.

What’s New? Describes the newest features in the latest version of 
ALM. To access, select Help > What's New.

Movies Short movies that demonstrate the main product 
features. To access, select Help > Movies.

Readme Provides last-minute news and information about ALM.

Guide Description

HP ALM User Guide Explains how to use ALM to organize and execute all 
phases of the application lifecycle management process. 
It describes how to specify releases, define requirements, 
plan tests, run tests, and track defects.

HP ALM 
Administrator Guide

Explains how to create and maintain projects using Site 
Administration, and how to customize projects using 
Project Customization.

HP ALM Lab 
Management Guide

Explains how to use Lab Management to manage lab 
resources used for functional and performance testing on 
remote hosts.

HP ALM Tutorial A self-paced guide teaching you how to use ALM to 
manage the application lifecycle management process.

HP ALM Installation 
and Upgrade Guide

Describes the installation and configuration processes for 
setting up ALM Server, and the project upgrade process.

http://www.adobe.com
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HP ALM Performance Center Guides

HP ALM Lab 
Management 
Troubleshooting 
Guide

Provides information for troubleshooting problems while 
working with HP ALM Lab Management.

HP ALM Business 
Views Microsoft 
Excel Add-in User 
Guide

Explains how to install and use the Business Views 
Microsoft Excel Add-in to create and configure business 
view Excel reports.

HP Business Process 
Testing User Guide

Explains how to use Business Process Testing to create 
business process tests.

Guide Description

HP ALM Performance 
Center Quick Start

A self-paced guide giving the Performance Center user a 
high level overview of creating and running performance 
tests.

HP ALM Performance 
Center Guide

Explains to the Performance Center user how to create, 
schedule, run, and monitor performance tests. Explains 
to the Performance Center administrator how to 
configure and manage Performance Center projects.

HP ALM Performance 
Center Installation 
Guide

Describes the installation processes for setting up 
Performance Center Servers, Performance Center Hosts 
and other Performance Center components.

HP ALM Performance 
Center 
Troubleshooting 
Guide

Provides information for troubleshooting problems while 
working with HP ALM Performance Center.

Guide Description
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HP ALM Best Practices Guides

Guide Description

HP ALM Agile 
Testing Best Practices 
Guide

Provides best practices for implementing agile testing 
principles.

HP ALM Business 
Models Module Best 
Practices Guide

Provides best practices for working with the Business 
Models module.

HP ALM Database 
Best Practices Guide

Provides best practices for deploying ALM on database 
servers.

HP ALM Entities 
Sharing Best 
Practices Guide

Provides best practices for sharing entities.

HP ALM Project 
Planning and 
Tracking Best 
Practices Guide

Provides best practices for managing and tracking 
releases.

HP ALM Project 
Topology Best 
Practices Guide

Provides best practices for structuring projects.

HP ALM Upgrade 
Best Practices Guide

Provides methodologies for preparing and planning your 
ALM upgrade.

HP ALM Versioning 
and Baselining Best 
Practices Guide

Provides best practices for implementing version control 
and for creating baselines.

HP ALM Workflow 
Best Practices Guide

Provides best practices for implementing workflows.
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HP ALM Performance Center Best Practices Guides

HP ALM API References

 

Guide Description

HP Performance 
Center of Excellence 
Best Practices

Provides best practices for successfully building and 
operating Performance Centers of Excellence.

HP Performance 
Monitoring Best 
Practices

Provides best practices for monitoring the performance of 
applications under test.

Guide Description

HP ALM Project 
Database Reference

Provides an online reference for the project database 
tables and fields.

HP ALM Open Test 
Architecture API 
Reference

Provides an online reference for the ALM COM-based 
API. You can use the ALM open test architecture to 
integrate your own configuration management, defect 
tracking, and home-grown testing tools with an ALM 
project.

HP ALM Site 
Administration API 
Reference

Provides an online reference for the Site Administration 
COM-based API. You can use the Site Administration API 
to enable your application to organize, manage, and 
maintain ALM users, projects, domains, connections, and 
site configuration parameters.

HP ALM REST API 
Reference 
(Technology 
Preview)

Provides an online reference for the ALM REST-based API. 
You can use the REST API to access and work with ALM 
data.

HP ALM COM 
Custom Test Type 
Developer Guide

Provides an online guide for creating your own testing 
tool and integrating it into the ALM environment using 
native COM development tools.

HP ALM .NET 
Custom Test Type 
Developer Guide 

Provides an online guide for creating your own testing 
tool and integrating it into the ALM environment using a 
combination of DCOM and .NET classes.
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Additional Online Resources

The following additional online resources are available from the ALM Help 
menu:

Part Description

Troubleshooting & 
Knowledge Base

Opens the Troubleshooting page on the HP Software 
Support Web site where you can search the Self-solve 
knowledge base. Choose Help > Troubleshooting & 
Knowledge Base. The URL for this Web site is 
http://h20230.www2.hp.com/troubleshooting.jsp.

HP Software Support Opens the HP Software Support Web site. This site 
enables you to browse the Self-solve knowledge base. You 
can also post to and search user discussion forums, 
submit support requests, download patches and updated 
documentation, and more. Choose Help > HP Software 
Support. The URL for this Web site is 
www.hp.com/go/hpsoftwaresupport.

Most of the support areas require that you register as an 
HP Passport user and sign in. Many also require a support 
contract.

To find more information about access levels, go to:

http://h20230.www2.hp.com/new_access_levels.jsp

To register for an HP Passport user ID, go to: 

http://h20229.www2.hp.com/passport-registration.html 

HP Software Web site Opens the HP Software Web site. This site provides you 
with the most up-to-date information on HP Software 
products. This includes new software releases, seminars 
and trade shows, customer support, and more. Choose 
Help > HP Software Web site. The URL for this Web site 
is www.hp.com/go/software.

http://h20230.www2.hp.com/troubleshooting.jsp
http://www.hp.com/go/hpsoftwaresupport
http://h20230.www2.hp.com/new_access_levels.jsp
http://h20229.www2.hp.com/passport-registration.html
http://www.hp.com/go/software
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HP ALM Extension Guides

Extensions provide added functionality to ALM. If you have a license for an 
ALM extension, you can utilitize the added functionality by enabling the 
extension on a per project basis. For more details on enabling extensions, 
refer to the HP Application Lifecycle Management Administrator Guide.

To view the list of extensions available with ALM, or to download 
documentation for ALM extensions, visit the HP ALM Add-ins Page, 
accessible from the main ALM Help menu.

Add-ins Opens the HP Application Lifecycle Management Add-
ins Page, which offers integration and synchronization 
solutions with HP and third-party tools.

Tools Opens the HP Application Lifecycle Management Tools 
Page, which offers integration and synchronization 
solutions with HP and third-party tools that are installed 
with the ALM server.

Part Description
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1
Before You Install

This chapter provides information that will help you prepare for the 
Performance Center component installations. 

This chapter includes:

➤ Performance Center Components and Data Flow on page 22

➤ System Component Considerations on page 30

➤ General Pre-installation Considerations on page 34

➤ Required Services on page 36

➤ Performance Center Prerequisite Software on page 37
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Performance Center Components and Data Flow

This section describes the HP ALM Performance Center system.

This section includes:

➤ "Architecture and Components" on page 23

➤ "Applications" on page 25

➤ "Communication Paths" on page 26

➤ "Coexistence of Installed Components" on page 28

➤ "Load Considerations" on page 28
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Architecture and Components
This section describes the architecture and components of 
HP ALM Performance Center.

Architecture/Component Description

ALM server Provides a platform for core ALM functionality. 

➤ ALM Client. Users log in to ALM (user site), Site 
Administration (project and user management), 
or Lab Management from their client machine.

➤ ALM server Repository. Used for file storage.

➤ ALM Database. Contains a schema per 
Performance Center project, as well as a separate 
schema for Lab Management and Site 
Administration.

For more details about ALM technology, see the 
HP Application Lifecycle Management Installation and 
Upgrade Guide.

HP Performance Center 
Server

Hosts the Performance Center Web pages that 
enable you to design performance tests, configure 
monitors, reserve testing resources, run and 
monitor test runs, and analyze test results.
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Lab Management The center for managing lab resources (such as hosts 
and host pools), and for managing Performance 
Center assets (such as Performance Center server, 
licenses, and usage reports).

HP Performance Center 
Hosts

Used to control performance tests, generate load, 
and analyze data. Performance Center hosts can be 
configured as Controllers, load generators, or data 
processors:

➤ Controller. The manager of a performance test. 
The Controller receives scripts, runtime settings, 
and a list of load generators to use. The 
Controller issues instructions to the load 
generators including which scripts to run, how 
many Vusers to run per script, and scheduler 
settings. At the conclusion of the test run, the 
Controller collates the data. There is only one 
Controller per performance test.

➤ Load Generator. Generate load by running 
virtual users (Vusers). The Controller dictates the 
manner in which they start and stop running. 
There can be any number of load generators for a 
given test. 

➤ Data Processor. Used for analyzing and 
publishing performance test results.

Architecture/Component Description
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Applications 
The following standalone applications integrate with your 
Performance Center system:

Use the diagram and table in the "Communication Paths" and "Load 
Considerations" sections, to determine which machines to allocate for 
which performance testing tasks.

For example, you can combine a number of components that have a light 
load on a single machine. For details on which components can be installed 
together, see "Coexistence of Installed Components" on page 28.

Application Description

HP Virtual User Generator 
(VuGen)

Generates Vusers by recording actions that typical 
end-users would perform on your application. 
VuGen records your actions into automated Vuser 
scripts which form the foundation of your 
performance tests.

HP Analysis Provides graphs and reports with in-depth 
performance analysis information. Using these 
graphs and reports, you can pinpoint and identify 
the bottlenecks in your application and determine 
what changes need to be made to your system to 
improve its performance.

MI Listener Needed when running Vusers and monitoring 
applications over a firewall. 

Monitors Over Firewall 
Agent

Used to monitor servers that are located over a 
firewall.
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Communication Paths
When installing HP ALM Performance Center, it is important to consider 
the communication paths between the various components, and their 
resource demands. This information helps you configure your system to 
evenly distribute the load, and prevent overloading any particular resource.

When running a performance test, Performance Center components share 
information with ALM components via a distinct system of communication. 
Understanding which components communicate with one another and the 
method of communication is essential for configuring your system.

The following diagram illustrates the communication paths and protocols of 
the ALM Performance Center system:
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The following table displays the connection ports that are opened by default 
on the various ALM Performance Center components:

* HTTPS is also supported on this component.

Component Ports

ALM server HTTP (8080/80) *:

➤ For Jetty Web server: 8080

➤ For IIS Web server: 80

Performance Center Server HTTP (80) *

TCP (3333, 54245)

Performance Center Host HTTP (8731)

TCP (3333, 5001, 5002, 5003, 54245, 54345)

Database TCP (1433 (SQL)), 1521 (Oracle))

Repository NetBIOS

Diagnostics Server HTTP (80, 2006) *

TCP (54345)

Standalone Load Generator TCP (5001, 5002, 5003, 54245, 54345)

MI Listener HTTP/TCP (443)

TCP (50500)

Application under test Any; HTTP (Random)

SiteScope - Topology HTTP (8080) *

SiteScope - Monitor Profiles HTTP (8888) *
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Coexistence of Installed Components
The following table describes which components can and cannot coexist on 
the same machine. 

Load Considerations
The following table provides some basic installation considerations for each 
Performance Center component:

Machine
Quantity in 
the system

Load Considerations

Performance 
Center Server

At least two Heavy load.

To balance the load, ALM has built in load 
balancing capabilities. 

For additional load balancing support, you can 
install multiple Performance Center Servers.

For more information on load balancing, see HP 
Software Self-solve knowledge base article 
KM1052520 
(http://h20230.www2.hp.com/selfsolve/
document/KM1052520).
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Performance 
Center Hosts:

➤ Controller

➤ Load 
Generator

➤ Data 
Processor

At least one 
of each

Controller has heavy load.

Load generator has medium load.

Data processor has medium to high load.

It is recommended to designate spare 
Controllers and load generators for fault-
tolerance and high availability purposes.

Note: 

➤ You can configure a host as a Controller + 
Load Generator, but this is not recommended 
because running Vusers consumes a lot of 
resources. Running Vusers on the Controller 
host is only appropriate for performance tests 
that have a very small number of Vusers.

➤ You can configure a host as a Controller + 
Data Processor, but this is not recommended 
because data processing might consume high 
amounts of CPU and resources. 

MI Listener At least 
one, if you 
are 
monitoring 
over a 
firewall

Medium load.

➤ Standalone installation is required. 

➤ Cannot exist on a machine running IIS.

Monitor Over 
Firewall 
machine

At least 
one, if you 
are 
monitoring 
over a 
firewall

Light load.

Standalone installation is required. 

SiteScope 
(optional)

One Light load.

Machine
Quantity in 
the system

Load Considerations
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System Component Considerations

The Performance Center system includes several components. This section 
provides pre-installation considerations for each of the components.

For system requirement details for each component, see the HP Application 
Lifecycle Management Readme.

➤ "Performance Center Server" on page 30

➤ "Performance Center Host" on page 32

➤ "Standalone Load Generator (Windows)" on page 32

➤ "Standalone Load Generator (Linux)" on page 32

➤ "Standalone VuGen and Standalone Analysis" on page 33

➤ "MI Listener" on page 33

➤ "Monitor Over Firewall Machine" on page 33

➤ "ERP and CRM Mediator" on page 33

➤ "SiteScope Server" on page 34

Performance Center Server

➤ Uninstall any previous installations of the Performance Center Server 
from your machine.

➤ We strongly recommend installing the Performance Center Server on a 
clean machine with a new image. 

➤ Performance Center Servers conduct Performance Center administration, 
test design, run operations, monitoring, and the user interface services for 
these operations. Because performance test run operations create heavy 
load on the Performance Center Server, we recommend installing at least 
two Performance Center Servers in your system. Using built-in load 
balancers, calls to and from ALM are balanced among the 
Performance Center Servers in a round-robin fashion. 

➤ Before you install the Performance Center Server, you must install 
Microsoft Internet Information Services (IIS 6/7/7.5).
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➤ During installation, the following Web Service Extensions are enabled on 
all Performance Center Servers using IIS:

➤ Active Server Pages

➤ ASP.NET 

➤ IIS 7 or 7.5 Management Compatibility 

➤ On all Performance Center Servers using IIS 6.0, IWAM_<machine_name> 
must exist, and must belong to the Administrators or IIS Worker Process 
groups.

➤ To install a Performance Center Server, you must have full local 
administrative rights on the designated machine.

➤ During installation of the Performance Center Server, the default 
Performance Center system user, IUSR_METRO (password 
P3rfoRm@1nce), is created in the Administrators user group of the 
machine. Ensure that there is no security system in place that will remove 
the system user from the Administrators group.

➤ If Performance Center is working with an Oracle database, ensure that the 
Oracle client installed on the Performance Center Server machine is at 
least the same version as on the Oracle server, and that connectivity is 
established with the Oracle Server. For details, see "Establishing 
Connectivity with Oracle" on page 133.

➤ You must install the 32-bit Oracle client installation, regardless of 
whether you are running the Performance Center Server on a 32-bit or 64-
bit operating system.

➤ If you install the Oracle client after installing the Performance Center 
Server, you must restart the machine after installing the Oracle client.

➤ Oracle Monitoring: If you need to define Oracle monitors, ensure that 
you install the Performance Center Server in a directory whose path does 
not include any of the following characters: ( ) : ; * \ / ” ~ & ? { } $ % | < > 
+ = ^ [ ]. For example, on a 64-bit machine, do not install the 
Performance Center Server in the default installation directory 
(C:\Program Files (x86)\....), as this path includes illegal characters.
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➤ Microsoft Windows Script Host should be version 5.6 or later. To verify 
the version number, navigate to the <Windows installation 
directory>\Windows\system32 directory. Right-click wscript.exe and 
select Properties. In the Version tab, verify the file version number.

Performance Center Host

➤ Uninstall any previous installations of Performance Center hosts from 
your machine.

➤ To install a Performance Center Host, you must have full local 
administrative rights on the designated machine.

➤ During installation of Performance Center hosts, a default 
Performance Center system user, IUSR_METRO (password 
P3rfoRm@1nce), is created in the Administrators user group of the 
machine. Ensure that there is no security system in place that will remove 
the system user from the Administrators group.

Standalone Load Generator (Windows)

➤ You cannot install the Standalone Load Generator on the same machine 
as the Performance Center Server or Performance Center host.

➤ If both Standalone VuGen and Standalone Analysis are to be installed on 
the machine where you want to install the Standalone Load Generator, 
make sure to install the Standalone Load Generator last.

➤ During installation of the Standalone Load Generator, the default 
Performance Center system user, IUSR_METRO (password 
P3rfoRm@1nce), is created in the Administrators user group of the 
machine. Ensure that there is no security system in place that will remove 
the system user from the Administrators group.

Standalone Load Generator (Linux)

➤ You can install the Standalone Load Generator on Linux to run Vusers. 
The Linux Vusers interact with the Controller that is installed on a 
Windows machine. For more information, see "Installing 
HP Load Generator on Linux" on page 82.
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Standalone VuGen and Standalone Analysis

➤ If you are installing the Standalone Load Generator on the same machine 
as Standalone applications (VuGen or Analysis), install the Standalone 
applications first, and the Standalone Load Generator last.

MI Listener

➤ The MI Listener must be installed on a standalone machine.

➤ The MI Listener cannot be installed on a machine running IIS. 

Monitor Over Firewall Machine

➤ The Monitor Over Firewall agent must be installed on a standalone 
machine.

ERP and CRM Mediator

➤ The ERP and CRM Mediator must be installed on a machine that resides 
in the same LAN as the monitored ERP/CRM server, preferably on a 
dedicated machine. It is not recommended to install the Mediator on a 
Siebel or Oracle server that is involved in the performance test.

Note: When using SAP Diagnostics, ensure that a SAPGUI client is 
installed on the same machine as the ERP/CRM Mediator.

➤ By default, the ERP/CRM Mediator agent is installed to run as a service. 
After installing the agent, verify that it is running as a service and not as a 
process. If it is running as a process, you must stop the process and run 
the agent as a service.

➤ For information about configuring the ERP/CRM Mediator after 
installation and using the ERP and CRM Mediator to collect diagnostics 
data, see the HP ALM Performance Center Guide.
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SiteScope Server

➤ SiteScope is used for monitoring applications.

➤ Refer to the HP SiteScope Deployment Guide for minimum requirements.

General Pre-installation Considerations

This section includes pre-installation considerations for all 
Performance Center components. 

➤ Before you begin installing, you should decide which machine is to be 
used for what purpose. Consider the expected load on each machine 
when determining which components to install on which machines. For 
more details, see "Coexistence of Installed Components" on page 28, and 
"Load Considerations" on page 28.

➤ Ensure that the server time on the ALM server and Performance Center 
component machines is synchronized.

➤ Default Web Site must be configured on the machines that have IIS 
installed on them. To check if this is configured, right-click My Computer, 
and select Manage. The Computer Management console opens. Expand 
the Services and Applications node, check that Default Web Site is 
displayed in the Internet Information Services folder, and that its ID=1. If 
it is not defined there, or if the ID is not defined as 1, you should contact 
your system administrator or reinstall IIS.

➤ For installation of standalone applications, you must manually install the 
prerequisite software. For the list of required prerequisites, see 
"Performance Center Prerequisite Software" on page 37. For details on 
installing the prerequisites in silent mode, see "Installing 
Performance Center Silently" on page 69.

➤ You cannot install Performance Center components on machines with 
existing LoadRunner installations. Before installing Performance Center, 
ensure that you have removed all versions of LoadRunner from the 
machine.

➤ Hyper-Threading must be disabled. Performance Center does not support 
Intel Hyper-Threading technology. Hyper-Threading can be disabled in 
the BIOS.
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➤ Ensure that the operating system and the database are both configured for 
the same language. If not, some texts displayed in Performance Center 
will be corrupted. For example, if you are working with German, ensure 
that you are working on a German operating system, and that the 
database is configured for German.

➤ IUSR_<machine_name> must exist on the Performance Center Server.
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Required Services

Before you install Performance Center components, check that the services 
defined in the table below are running on each component machine and 
that the startup type for each service is defined as Automatic.

Note: The default settings for running the services on the operating system 
may differ from one version to another. You should go through all of the 
services on each machine to ensure that the required services are running. 

Machine Services

All Performance Center 
Servers and Hosts

➤ IPSEC Services (for TCP/IP security)

➤ NTLM Security support provider

➤ Remote Procedure Call (RPC)

➤ Management Instrumentation (for 
Performance Center health check)

➤ Event Log (optional— used for debugging)

➤ COM+ services (Event System and System 
application)

➤ HTTP SSL (for SSL)

➤ System Event Notification (for COM+)

Performance Center 
Servers

➤ IIS Admin Service (Microsoft Service)

➤ Workstation

➤ TCP/IP NetBIOS Helper

➤ World Wide Web Publishing Service (Microsoft 
Service)

➤ Distributed Transaction Coordinator (MSDTC)

Performance Center 
Hosts

➤ Remote Registry Service (Windows Service)
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Performance Center Prerequisite Software

Before you can install Performance Center, some prerequisite software (for 
example, .NET Framework 4.0) must be installed on your machine. During 
installation, Performance Center checks whether the prerequisite software is 
installed on your machine. Performance Center enables you to 
automatically install missing software from the Performance Center disk.

The following table provides a list of the prerequisite software and how 
Performance Center detects whether the software is installed.

Prerequisite 
Software

Machines Means of detection

.NET 
Framework 3.5 
SP1

➤ All Performance Center 
Server and Host machines

➤ Standalone VuGen 

➤ Standalone Analysis

➤ Standalone Load 
Generator

Searches the registry key:

HKLM\Software\Microsoft\NET 
Framework Setup\NDP\v3.5

.NET 
Framework 4.0

➤ All Performance Center 
Server and Host machines

➤ Standalone VuGen 

➤ Standalone Analysis

➤ Standalone Load 
Generator

Searches the registry key:

HKLM\Software\Microsoft\NET 
Framework Setup\NDP\v4.0

Microsoft Data 
Access 
Components 
(MDAC) 2.8 
SP1 (or later)

➤ All Performance Center 
Server and Host machines

➤ Standalone VuGen 

➤ Standalone Analysis

➤ Standalone Load 
Generator

Searches the registry key:

HKLM\Software\Microsoft\Data
Access 

Microsoft Core 
XML Services 
(MSXML) 6.0

➤ All Performance Center 
Server and Host machines

➤ Standalone VuGen 

➤ Standalone Analysis

➤ Standalone Load 
Generator

Queries the existence and 
version of: 
%systemroot%\system32\msxml
6.dll
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Microsoft 
Visual C++ 
2005 Service 
Pack 1 
Redistributable 
Package MFC 
Security 
Update (x86)

➤ All Performance Center 
machines

➤ Standalone VuGen 

➤ Standalone Analysis

➤ Standalone Load 
Generator

Queries the MSI manager for 
the GUID:

{86C9D5AA-F00C-4921-B3F2-
C60AF92E2844}

Microsoft 
Visual C++ 
2005 Service 
Pack 1 
Redistributable 
Package MFC 
Security 
Update (x64)

➤ All Performance Center 
machines

➤ Standalone VuGen

Queries the MSI manager for 
the GUID: 

{A8D19029-8E5C-4E22-8011-
48070F9E796E}

Microsoft 
Visual C++ 
2008 Service 
Pack 1 
Redistributable 
Package MFC 
Security 
Update (x86)

➤ All Performance Center 
machines

➤ Standalone VuGen 

➤ Standalone Analysis

➤ Standalone Load 
Generator

Queries the MSI manager for 
the GUID: 

{DE2C306F-A067-38EF-B86C-
03DE4B0312F9}

Microsoft 
Visual C++ 
2008 Service 
Pack 1 
Redistributable 
Package MFC 
Security 
Update (x64) 

➤ All Performance Center 
machines

➤ Standalone VuGen

Queries the MSI manager for 
the GUID: 

{FDA45DDF-8E17-336F-A3ED-
356B7B7C688A}

Prerequisite 
Software

Machines Means of detection
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Microsoft 
Visual C++ 
2010 Service 
Pack 1 
Redistributable 
Package MFC 
Security 
Update (x86)

➤ All Performance Center 
Server and Host machines

➤ Standalone VuGen 

➤ Standalone Analysis

➤ Standalone Load 
Generator

Queries the MSI manager for 
the GUID: 

{1F4F1D2A-D9DA-32CF-9909-
48485DA06DD5}

Microsoft 
Windows 
Installer 3.1

➤ All Performance Center 
Server and Host machines

➤ Standalone VuGen 

➤ Standalone Analysis

Looks for one of the following:

➤ Registration of the 
WindowsInstaller. 
Installer.com object version 
3 or later 

➤ MSI.dll version 3 or later in 
the %systemroot% 

Web Services 
Enhancements 
(WSE) 3.0 for 
Microsoft .NET 
Redistributable 
Runtime MSI

➤ All Performance Center 
Server and Host machines

➤ Standalone VuGen 

➤ Standalone Analysis

➤ Standalone Load 
Generator

Queries the MSI manager for 
the GUID: 

{E3E71D07-CD27-46CB-8448-
16D4FB29AA13} 

Web Services 
Enhancements 
(WSE) 2.0 SP3 
for Microsoft 
.NET 
Redistributable 
Runtime MSI

➤ All Performance Center 
Server and Host machines

➤ Standalone VuGen 

➤ Standalone Analysis

➤ Standalone Load 
Generator

Runtime installation GUID 
{F3CA9611-CD42-4562-ADAB-
A554CF8E17F1} 

Full installation GUID 
{6F 396FFB-CC3A-4335-BC0B-
2AEF38F4492C} 

Prerequisite 
Software

Machines Means of detection
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Internet 
Information 
Services (IIS)

➤ Performance Center Server HKLM\SOFTWARE\Microsoft\In
etStp 

Looks for both Major and 
Minor numbers. 

Supports the following 
versions:

➤ 6.0 (Windows 2003)

➤ 7.0 (Windows 2008)

➤ 7.5 (Windows 2008R2)

Strawberry 
Pearl 5.10.1

➤ Standalone VuGen Queries the MSI manager for 
the GUID:

{C977182F-221A-337A-B681-
963808E0023A}

Windows 
Imaging 
Component 
(WIC)

➤ All Performance Center 
Server and Host machines

➤ Standalone VuGen 

➤ Standalone Analysis

➤ Standalone Load 
Generator

Queries the version of: 
%systemroot%\system32\Windo
wsCodecs.dll

Prerequisite 
Software

Machines Means of detection
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2
Installing HP ALM Performance Center

This chapter describes how to install HP ALM Performance Center. 

This chapter includes:

➤ Installation Flow on page 44

➤ Installing HP Application Lifecycle Management on page 46

➤ Installing and Configuring Performance Center Servers and Hosts 
on page 47

➤ Installing the Performance Center Server and Host Patch on page 62

➤ Installing Performance Center Silently on page 69

➤ Installing Standalone Components (Windows) on page 79

➤ Installing HP Load Generator on Linux on page 82

➤ Installing Additional Components on page 100

➤ Repairing the Performance Center Installation on page 103

➤ Uninstalling Performance Center Components on page 104
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Installation Flow

This section describes the steps required to install HP ALM 
Performance Center 11.50 components and patches. 

Note: To install HP ALM Performance Center, you must have full local 
administrative rights on the designated machines.
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To install HP ALM Performance Center:

 1 Install the components and patches according to the following checklists:

➤ Checklist for installing HP ALM Performance Center 11.50:
 

➤ Checklist for installing a patch on HP ALM Performance Center 11.50:
l

✔ Component Action Page

ALM Server Install ALM server 46

Performance Center Server Install Performance Center 
server

47

Performance Center Hosts Install Performance Center 
host

47

Standalone Components 
(optional)

Install Performance Center 
Standalone applications 
(Windows)

79

HP Load Generator on Linux 82

✔ Component Action Page

ALM Server Install ALM latest compatible 
patch for Performance Center

46

Performance Center Server Install Performance Center 
Server - latest patch

62

Performance Center Hosts Install Performance Center 
host - latest patch

62

Standalone Components 
(optional)

Install Performance Center 
Standalone applications - 
latest patch (Windows) 

81

HP Load Generator on UNIX - 
latest patch

82

ALM Server ALM automatically 
updates your Lab 
Management project to the 
latest patch.

103
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 2 Ensure that the ALM client browser’s Trusted Sites list includes 
Performance Center Server.

For details, see step 14 on page 62.

 3 Verify that the installation was successful.

For details, see Chapter 3, "Post Installation Verification."

Installing HP Application Lifecycle Management

As a prerequisite to installing HP ALM Performance Center 11.50 
components, you must install HP Application Lifecycle Management 11.50 
and the latest patch.

Note: Each HP ALM Performance Center version is certified with a specific 
HP ALM version. Ensure you are installing Performance Center on a 
corresponding version of HP ALM. Corresponding versions are published on 
the HP download site. For more details, contact HP Software Support.

To install HP Application Lifecycle Management 11.50:

 1 Install the appropriate version of HP ALM for your system. For details 
refer to the HP Application Lifecycle Management Installation and Upgrade 
Guide.

Note: Ensure that ALM is installed on a certified operating system. 
Consult the ALM System Configurations section of the HP ALM Readme 
for a full list of recommended and supported operating systems for 
HP ALM Performance Center.

 2 Install the latest HP ALM Patch on the ALM server machine. For details, 
see the relevant HP ALM Patch Readme.
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 3 Set up the HP ALM client machine with the correct browser 
configuration. For details, refer to the HP Application Lifecycle Management 
Installation and Upgrade Guide.

Installing and Configuring Performance Center Servers and 
Hosts

This section describes how to install and configure the Performance Center 
Server and Performance Center hosts.

Note: If you are upgrading or migrating from an earlier version of 
Performance Center, follow the instructions in Chapter 5, "Working with 
Previously Created Projects."

Pre-Installation Considerations:

➤ Before you install the Performance Center components, review the pre-
installation information, described in Chapter 1, "Before You Install."

➤ To install a Performance Center Server or Performance Center host, you 
must have full local administrative rights on the designated machine.

➤ If the Performance Center installation directory is located on a network 
drive, it is recommended to map the network drive before you run the 
installation.

➤ To enable running the installation from a network location, make sure 
that the network location path is added to the Trusted Sites of the 
machine on which you are running the installation.

➤ If you are installing a Performance Center Server or Performance Center 
host using a Remote Desktop connection (RDP), you must install through 
the console.
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➤ If you are working with an Oracle database, ensure that the Oracle client 
is installed on the Performance Center Server (with Administrator 
installation type), and that connectivity has been established with the 
Oracle Server. Ensure that the tnsnames.ora file contains the same TNS 
entry for the source and target database server.

Note: You must install the 32-bit Oracle client installation, regardless of 
whether you are running the Performance Center Server on a 32-bit or 64-
bit operating system.

➤ The Performance Center Server and the Performance Center host cannot 
be installed on the same machine.

To install a Performance Center Server or Performance Center host:

 1 Launch the Performance Center installer.

Insert the HP ALM Performance Center installation DVD and run 
setup.exe (<installation disk root directory>\setup.exe). 
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 2 Select an installation option.

The setup program starts and displays the installation menu page. 

Select Performance Center Server or Performance Center Host.
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Note: If you know in advance that a particular host machine is to be used 
as a load generator only, we recommend that you install the Standalone 
Load Generator for the following reasons: 

➤ The installation requires less disk space

➤ Moving the Load Generator’s setup files is less time consuming than 
moving the setup files of the Performance Center Host 

For details on installing the Standalone Load Generator, see "Installing 
Standalone Components (Windows)" on page 79.

To install a load generator on Linux, see "Installing HP Load Generator on 
Linux" on page 82.
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 3 If necessary, install prerequisite software.

Some prerequisite software must be installed on the machine before 
installing the Performance Center component. If any of the prerequisite 
software is not already installed on the machine, the following dialog box 
opens:
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Note: 

➤ Performance Center Server installation: If Microsoft Internet 
Information Services (IIS) 6/7/7.5 is listed on this page, it is 
recommended that you close the installation, install IIS, and restart 
the installation. However, if you choose to continue with the 
installation, you will have to re-run the post installation configuration 
before the server machine can be used. To re-run the configuration 
wizard, choose Start menu > Programs > HP Software > HP 
Performance Center Server > Tools (for more details, see 9 on page 56). 

➤ If you are working with Windows 2008 64-bit R2 Operating System, 
you must install .NET Framework 3.5 SP1 from the Server Manager 
Feature list.

Click OK and follow the on-screen instructions to install the prerequisite 
software before continuing with the Performance Center component 
installation. You cannot continue with the Performance Center 
component installation unless all the prerequisite software is installed.

Note: If you are prompted to restart the machine after installing the 
prerequisite software, you must do so before continuing with the 
installation. After rebooting the machine, run setup.exe again to 
continue with the installation. If the installation continues from where it 
left off before rebooting, we recommend starting the setup again—the 
installer will detect the installed prerequisites and continue with the 
installation.

For a full list of prerequisite software, see "Performance Center 
Prerequisite Software" on page 37.
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 4 Start the installation.

The Performance Center Setup Wizard opens, displaying the Welcome 
page for the relevant Performance Center component. Click Next.

 5 Review the License agreement.

To accept the terms of the license agreement, select I Agree. Click Next.

 6 Register your customer information on your computer.

On the Customer Information page, enter your name and organization 
name, and click Next.
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 7 Select an installation folder.

Specify the location in which to install the Performance Center 
component. To browse possible locations, click the Browse button, select 
a location, and click OK. 

To check required and available disk space on each drive, click Disk Cost. 

Click Next.
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 8 Start the installation process.

The wizard prompts you to confirm the details and start the installation. 
To review or change any settings, click Back.

Click Next to start the installation. The wizard displays the installation 
progress.
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 9 Upon completion of the installation, configure the component.

The Welcome page of the Configuration wizard opens. 

Click Next. 
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 10 Confirm the configuration.

The Confirm Configuration page opens.

Click Next. 
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 11 Performance Center Server only: Enter the Communication Security 
passphrase.

Enter the Communication Security passphrase for secure communication 
between the Performance Center Server and ALM. This must be identical 
to the passphrase defined during the ALM installation. You can view the 
passphrase in Site Administration > Site Configuration tab > 
COMMUNICATION_SECURITY_PASSPHRASE parameter. For more details, 
refer to the HP Application Lifecycle Management Administrator Guide.

Click Next.
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 12 The background configuration starts.

The wizard displays the progress bar as it performs the configurations on 
the relevant component.

The wizard performs the following configurations on the relevant 
component:

Configuration PC Server PC Host

Copies and registers files on the machine Yes Yes

Creates the Performance Center system user, 
IUSR_METRO (default password: P3rfoRm@1nce), 
and adds it to the machine's Administrators group.

For information about changing the system user, 
see the HP ALM Performance Center Guide.

Yes Yes

Configures DCOM objects Yes Yes
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Adds the Performance Center path to the 
environment variables

Yes Yes

Installs Performance Center services 

➤ DataCollectionAgent

➤ RemoteManagement Agent Service

Yes Yes

Installs Performance Center services

➤ Performance Center Agent Service

➤ Performance Center Load Testing Service

-- Yes

Configures IIS:

➤ Creates virtual directories and application pools

➤ Configures IIS application pools to work as 
32-bit application pools

➤ Sets the .Net version for the application pools to 
.Net 4 (v4.0.30319).

IIS6:

➤ Installs extensions (if not already installed): ASP 
.Net, Active Server Pages, and enables them

IIS7:

➤ Enables Windows communication foundation

➤ Adds rules: Web-ASP, Web-Asp-Net, Web-Mgmt-
Compat, Web-Metabase, web-static-content

Yes --

Configuration PC Server PC Host
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 13 Close the configuration wizard and exit the Performance Center Installer. 

When the configuration is complete, the wizard confirms the 
configuration status.

Click View Summary to view a summary of the configuration. 

Click Finish to exit the Configuration wizard.

Click Finish to exit the Installation wizard. 

On the Performance Center installation menu page, click Exit.

Note: If prompted, restart the computer.
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 14 Add the Performance Center Server to the Trusted Sites of the ALM client 
browser.

Ensure that the Performance Center Server is listed in the Trusted Sites of 
the ALM client browser. 

 a In Internet Explorer, select Tools > Internet Options. The Internet 
Options dialog box opens.

 b In the Security tab, select Trusted Sites, and click Sites. 

 c If you are not using SSL, ensure that the Require Server verification 
(https:) for all sites in this zone option is not selected.

 d In the Add this website to the zone box, enter the Performance Center 
Server internal URL (http://<ALM server name>[<:port number>]/qcbin), 
and click Add.

 15 Perform additional Performance Center configuration steps.

 a Define Performance Center servers on ALM. For more details, see 
Adding the Performance Center Server to the System on page 66.

 b Define Performance Center license and host keys. For more details, see 
Setting the License Keys on page 67.

 c Define Performance Center hosts. For more details, see Adding 
Performance Center Hosts on page 68.

Installing the Performance Center Server and Host Patch

The section describes how to install the Performance Center patch on the 
Performance Center Server and Performance Center hosts.

To install the patch on the Performance Center Server:

On the Performance Center Server, run the relevant patch installation file 
(.msp) and follow the onscreen installation and deployment instructions.
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To install the patch on Performance Center hosts:

There are two alternate methods of installing the patch on the hosts: direct 
installation or remote installation.

Direct installation. You install the patch directly on the host. To install the 
patch, on the host, run the relevant patch installation file (.msp) and follow 
the onscreen installation and deployment instructions.

Alternatively, you can install the patch from the command line. This option 
is useful when installing the patch on multiple machines (for example, 
when working with Microsoft SMS), or when installing in silent mode. Run 
the following command from the command line:

where /qn for setting in silent mode and /l*vx for setting the logging mode.

Remote Installation. You install the patch on the host remotely from Lab 
Management. The advantage of this installation method is that it allows you 
to install the patch on more than one host simultaneously.

To install the patch remotely, perform the following steps:

 1 Prerequisite step: On the host that you intend to use the remote 
installation method, make sure that the Remote Procedure Call (RPC) 
service is started, as follows: Select Start > Run and type services.msc. 
Then in the Services window, locate Remote Procedure Call (RPC) and 
verify that its status is Started. If the status is not started, right-click it and 
select Start.

 2 Log in to Lab Management.

 3 On the Lab Management sidebar, under Performance Center, select 
Patches.

 4 Click the New Patch button. The Select Patch dialog box opens.

 5 Navigate to the location of the patch file, and click Open. The New Patch 
dialog box opens.

msiexec.exe /update <full path to the msp file> [/qn] [/l*vx <full path to the log file>]
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 6 Enter the details for the new patch and click OK. The patch is added to 
the system and appears in the Patches grid. For an explanation of the New 
Patch dialog box fields, see the “Patch Management” chapter in the 
HP ALM Lab Management Guide.

 7 On the Lab Management sidebar, under Lab Resources, select Hosts.

 8 Click the New Testing Host button. The New Testing Host dialog box 
opens.

 9 Enter the details for the host on which you will install the patch. 
Then click OK. For an explanation of the New Testing Host dialog box  
fields, see the “Lab Resources” chapter in the HP ALM Lab Management
Guide.

Note: 

➤ When adding the Performance Center host, its version must be the 
same as the Performance Center Server installed version. Therefore, in 
order to add the host and then install the patch from Lab 
Management, you must define its status as Unavailable.

➤ If the host is not added successfully, make sure that the 
Performance Center Load Testing Service is running on the host: Select 
Start > Run, and type services.msc. The Services window opens. Verify 
that the Performance Center Load Testing services is started.

 10 Right-click the host in the grid on which you want to install the patch 
and select Install Patch. To view the installation progress, in Lab 
Management select Tools > Task Manager.

Tip: You can install the patch on multiple hosts simultaneously. To select 
multiple hosts, hold down the CTRL key on your keyboard while selecting 
the hosts.
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 11 When the patch installation process is complete, on the Lab Management 
sidebar, under Lab Resources select Hosts. Select the host on which you 
installed the patch, and click Reconfigure Host. 

 12 Verify the patch installation:

➤ In the host’s event log, verify that the patch installation was 
successful. For more information about the Event Log, see the 
HP ALM Lab Management Guide.

➤ You can also verify that patch was installed on the host in Control 
Panel > Add or Remove Programs or Control Panel > Programs and 
Features > View Installed Updates on the host machine.

Configuring Performance Center in Lab Management

After running the Performance Center Server installation and the 
Performance Center Server Configuration wizard, you must perform 
additional configuration steps in Lab Management before you can use the 
product. 

This section includes:

➤ "Logging In to Lab Management" on page 65

➤ "Adding the Performance Center Server to the System" on page 66

➤ "Setting the License Keys" on page 67

➤ "Adding Performance Center Hosts" on page 68

Logging In to Lab Management
All Performance Center administration tasks are done in Lab Management. 

To log in to Lab Management: 

 1 Open the Web browser and type the ALM URL
http://<ALM server name>[<:port number>]/qcbin.

The ALM Options window opens.

 2 Click Lab Management, enter the user name and password of a Site 
Administrator, and click Login. 
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Adding the Performance Center Server to the System
To use the Performance Center Server, it must be defined in ALM. 

Note: From a performance and fault tolerance perspective, it is strongly 
recommended to define at least two Performance Center Servers.

To define the Performance Center Server:

 1 Log in to Lab Management. See "Logging In to Lab Management" on 
page 65.

 2 On the Lab Management sidebar, under Servers, select PC Servers.

 3 For each Performance Center Server:

 a In the PC Servers module, click New PC Server. 

 b Enter the details of the Performance Center Server as follows:

Note: To allow for proper communication between ALM and 
Performance Center servers, make sure that you validate the correct 
internal and external URLs of the Performance Center Servers. The 
internal URL must be accessible from within ALM and the 
Performance Center Servers. The external URL can include the relevant 
port, unless it was defined as part of the URL.

Field Description

Name The name of the Performance Center Server. 

External URL The URL for accessing the Performance Center Server 
from external sources.
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Setting the License Keys
After you add the Performance Center Server to ALM, you are required to 
enter your license. 

➤ The Performance Center license enables you to use the product and run 
load tests. This license determines the number of performance tests that 
you can run concurrently, and the total number of Vusers available for 
the performance tests.

➤ The Performance Center Host license defines the Vuser protocols, 
monitors, and modules that are available on each host machine. This 
license also determines the number of Vusers available per protocol.

Note: 

To activate your license, visit the HP Software Licensing Portal 
(http://www.hp.com/software/licensing) and enter your Entitlement Order 
Number.

The license file has a .dat file extension by default. Make a note of where 
you save the file, as during the configuration process you need to refer to 
the file.

If you do not have a license, visit the HP Software Licensing Portal 
(http://www.hp.com/software/licensing) and click the Contact Licensing 
Support link.

Internal URL The URL for accessing the Performance Center Server 
from within the system. For example, the 
Performance Center Server and ALM communicate 
with each other through this URL.

Status Make sure that the Performance Center Server’s status 
is Operational so that ALM and other 
Performance Center components can access it.

Field Description

http://www.hp.com/software/licensing
http://www.hp.com/software/licensing
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To set the license keys:

 1 Log in to Lab Management. See "Logging In to Lab Management" on 
page 65.

 2 On the Lab Management sidebar, under Performance Center, select PC 
Licenses. 

 3 Click Add License Key to add a single license key. Alternatively, click Add 
License from File to add multiple license keys simultaneously.

Adding Performance Center Hosts
To work with the Performance Center hosts, you must first add them to 
ALM. To add a host, you must first define the host’s location in ALM. If the 
host is a load generator over a firewall, you must define the MI Listener 
through which the load generator will communicate with the 
Performance Center Server.

Note: 

➤ Before adding a host, ensure that at least one Performance Center server 
is in an operational state.

➤ When adding the hosts, fields in red marked with an asterisk (*) are 
mandatory, including the type of operating system, and the purpose of 
the host. For details, see the HP ALM Performance Center Guide.

To add hosts:

 1 Log in to Lab Management. 

See "Logging In to Lab Management" on page 65.

 2 Add the host’s location.

 a Under Lab Resources, select Locations. 

 b In the Host Locations module, click the New Host Location button, 
and enter the host location’s details. 
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 3 For a host over a firewall, add the MI Listener.

 a Under Performance Center, select MI Listeners. 

 b In the MI Listeners module, click the New MI Listener button, and 
enter the MI Listener’s details. 

 4 Add the host.

 a Under Lab Resources, select Hosts. 

 b In the Hosts module, click the New Testing Host button, and enter the 
host’s details. In particular:

➤ In the Installation field, select the type of host installation: 
Windows Host; Windows Standalone LG; UNIX Load Generator.

➤ In the Purpose field, select a purpose for the host.

Installing Performance Center Silently

A silent installation is an installation that is performed automatically, 
without the need for user interaction. This section describes how to perform 
a silent installation of Performance Center components.

Before you perform the installation, review the pre-installation information, 
including the system requirements, described in Chapter 1, "Before You 
Install."

This section includes:

➤ "Silent Installation of Prerequisite Software" on page 70

➤ "Setting Up the Silent Configuration" on page 74

➤ "Silent Installation of Performance Center Server and Performance Center 
Hosts" on page 75

➤ "Silent Installation of the Standalone Load Generator" on page 77
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Silent Installation of Prerequisite Software
Install the prerequisite software silently by running the relevant commands 
as follows: 

Note: Some of the paths in the table below include the <environment> 
parameter, which represents the language of the environment on which you 
are working. Replace this parameter as follows:

➤ For an English environment, replace with EN

➤ For a Korean environment, replace with KOR

➤ For a Japanese environment, replace with JPN

➤ For a Chinese environment, replace with CHS
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Prerequisite Software Command 

.NET Framework 4.0 <Installation_Disk_Root_Directory>\Setup\Common\dot
net40\dotnetfx40.exe /LCID /q /norestart /c:"install /q"

Note: If you are prompted to restart the computer 
after installing this software, you must do so before 
continuing with the installation.

.NET Framework 3.5 SP1 ➤ For Windows Server 2008 and earlier: 
<Installation_Disk_Root_Directory>\Setup\Common\
dotnet35_sp1\dotnetfx35_sp1.exe /quiet

➤ For Windows 2008 R2:

➤ 32-bit: %windir%\SysNative\dism.exe /Online  
/Enable-Feature  /FeatureName:NetFx3  
/norestart

➤ 64-bit: %windir%\dism.exe /Online  /Enable-
Feature  /FeatureName:NetFx3  /norestart

Note: If you are prompted to restart the computer 
after installing this software, you must do so before 
continuing with the installation.

Microsoft Visual C++ 
2010 Service Pack 1 
Redistributable Package 
MFC Security Update 
(x86)

<Installation_Disk_Root_Directory>\Setup\Common\vc
2010sp1_mfc_security_update_x86\vcredist_x86.exe /q 
/norestart

Microsoft Visual C++ 
2005 Service Pack 1 
Redistributable Package 
MFC Security Update

<Installation_Disk_Root_Directory>\Setup\Common\vc
2005sp1_mfc_security_update_x86\vcredist_x86.exe 
/q:a /c:"msiexec /i vcredist.msi /qn"" "

Microsoft Visual C++ 
2005 Service Pack 1 
Redistributable Package 
MFC Security Update 
(x64)

<Installation_Disk_Root_Directory>\Setup\Common\vc
2005sp1_mfc_security_update_x64\vcredist_x64.exe 
/q:a /c:"msiexec /i vcredist.msi /qn"" "
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Microsoft Visual C++ 
2008 Service Pack 1 
Redistributable Package 
MFC Security Update 
(x86)

<Installation_Disk_Root_Directory>\Setup\Common\vc
2008sp1_mfc_security_update_x86\vcredist_x86.exe 
/q:a /c:"msiexec /i vc_red.msi /qn"" "

Microsoft Visual C++ 
2008 Service Pack 1 
Redistributable Package 
MFC Security Update 
(x64)

<Installation_Disk_Root_Directory>\Setup\Common\vc
2008sp1_mfc_security_update_x64\vcredist_x64.exe 
/q:a /c:"msiexec /i vc_red.msi /qn"" "

Windows Imaging 
Component (WIC)

➤ For 32-bit machine: 
<Installation_Disk_Root_Directory>\Setup\Common\
dotnet40\wic_x86_enu.exe /q /norestart

➤ For 64-bit machine: 
<Installation_Disk_Root_Directory>\Setup\Common\
dotnet40\wic_x64_enu.exe /q /norestart

Microsoft Data Access 
Components (MDAC) 2.8 
SP1 (or later)

<Installation_Disk_Root_Directory>\Setup\<environmen
t>\prerequisites\mdac28\mdac28.exe /q:A /C:"setup 
/QNT"

Microsoft Core XML 
Services (MSXML) 6.0

For x86: msiexec /log c:\msxml.log /quiet /I 
<Installation_Disk_Root_Directory>\Common\msxml6\
msxml6.msi

For x64: msiexec /log c:\msxml.log /quiet /I 
<Installation_Disk_Root_Directory>\Common\msxml6\
msxml6_x64.msi

For ia64: msiexec /log c:\msxml.log /quiet /I 
<Installation_Disk_Root_Directory>\Common\msxml6\
msxml6_ia64.msi

Microsoft Windows 
Installer 3.1

<Installation_Disk_Root_Directory>\Setup\Common\ms
i31\WindowsInstaller-KB893803-v2-x86.exe /q 
/norestart

Prerequisite Software Command 
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Web Services 
Enhancements (WSE) 3.0 
for Microsoft .NET 
Redistributable Runtime 
MSI

msiexec /log c:\WSE3.log /quiet /I 
<Installation_Disk_Root_Directory>\Setup\Common\ws
e30\MicrosoftWSE3.0Runtime.msi /quiet /norestart

Web Services 
Enhancements (WSE) 2.0 
SP3 for Microsoft .NET 
Redistributable Runtime 
MSI

msiexec /log c:\WSE2.log /qn /i 
<Installation_Disk_Root_Directory>\Setup\Common\ws
e20sp3\MicrosoftWSE2.0SP3Runtime.msi /quiet 
/norestart

Internet Information 
Services (IIS)

Note: 
Performance Center 
Server only!

➤ Use the following to install IIS6 on 
Windows 2003:

Sysocmgr.exe /i:sysoc.inf /r /q

C:\<WINDOWS directory>\Microsoft.NET\
Framework\v2.0.50727\aspnet_regiis.exe -i

➤ Use the following to install IIS7 on 
Windows 2008:

start /w pkgmgr /iu:IIS-WebServerRole;WAS-
WindowsActivationService;WAS-
ProcessModel;WAS-NetFxEnvironment;WAS-
ConfigurationAPI

For more details, see:

http://learn.iis.net/page.aspx/136/install-typical-iis-
workloads/ 

Prerequisite Software Command 

http://learn.iis.net/page.aspx/136/install-typical-iis-workloads/ 
http://learn.iis.net/page.aspx/136/install-typical-iis-workloads/ 
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Setting Up the Silent Configuration
This section describes how to customize the file used for silent configuration 
of the Performance Center Server. The UserInput.xml file—installed with the 
Performance Center Extension—contains parameters for the 
Performance Center Server and Performance Center Host configurations. 

For the Performance Center Server configuration, you can customize the 
parameters in the UserInput.xml file. You then instruct the Installer to use 
the customized file for the silent configuration input.

To configure the properties in the UserInput.xml file: 

 1 Copy the UserInput.xml file from the installation DVD 
(..\Setup\Install\Server\TARGETDIR\dat\Setup\PCS\Xml\) to another 
location. 

 2 Open the copy of the file and enter a user-defined value for the following 
property:

 3 Save the UserInput.xml file.

 4 Specify the location of the saved file when running the silent installation 
command.

Property Description

LW_CRYPTO_INIT_STRING The Communication Security passphrase 
used for secure communication between the 
Performance Center Server and ALM.

Note: This passphrase must be identical to 
the passphrase defined during the ALM 
installation.
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Silent Installation of Performance Center Server and 
Performance Center Hosts
This section describes how to run the silent installation of the 
Performance Center Server and Performance Center hosts on a Windows 
platform.

The silent installation is followed by the silent configuration which calls the 
UserInput.xml file for configuration parameters. You can customize the 
parameters in this file for the Performance Center Server configuration.

To perform a silent installation of Performance Center:

 1 For the Performance Center Server installation: Set up the .xml file that 
provides the input for the initial Performance Center Server configuration 
that runs directly after the installation. For details, see "Installing 
Standalone Components (Windows)" on page 79.

 2 Install the prerequisite software and the Performance Center component.

 a Install the prerequisite software. For instructions, see "Installing 
Standalone Components (Windows)" on page 79.

Note: If you are prompted to restart the computer after installing the 
prerequisite software, you must do so before continuing with the 
installation. 

 b After you have installed all the prerequisite software, install the 
Performance Center component by running the appropriate command 
from the command line.
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Performance Center Server:

where <full path to UserInput file> is the path to your customized 
UserInput.xml file and <Target_Installation_Directory> is the directory 
in which to install the Performance Center Server.

Performance Center Host:

where <Target_Installation_Directory> is the directory in which you 
want to install the Performance Center host.

SIlent 
installation 
with non-
customized 
UserInput.xml

msiexec /i <Installation_Disk_Root_Directory>\Setup\Install\
Server\PCServer.msi

ADDLOCAL=PCCore

TARGETDIR="<Target_Installation_Directory>" /qnb

Silent 
installation 
with 
customized 
UserInput.xml

msiexec /i 
<Installation_Disk_Root_Directory>\Setup\Install\Server\
PCServer.msi

ADDLOCAL=Core USER_CONFIG_FILE_PATH="<full path to 
UserInput file>" 
TARGETDIR="<Target_Installation_Directory>" /qnb

For 32-bit msiexec /i <Installation_Disk_Root_Directory>\Setup\
Install\Host\PCHost_x86.msi

ADDLOCAL=Core

TARGETDIR="<Target_Installation_Directory>" /qnb

For 64-bit msiexec /i <Installation_Disk_Root_Directory>\Setup\Install
\Host\PCHost_x64.msi

ADDLOCAL=Core

TARGETDIR="<Target_Installation_Directory>" /qnb
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 Note: 

You can also install in silent mode using the setup.exe file. This 
enables you to install the prerequisites in silent mode automatically 
before running the MSI installation in silent mode. Using this option 
also invokes the correct MSI file depending on the operating system 
platform.

Server installation:

<Installation_Disk_Root_Directory>\Setup\En\setup_server.exe /s 
USER_CONFIG_FILE_PATH="<full path to UserInput file>" 
TARGETDIR="<Target_Installation_Directory>" /qnb

Host installation:

<Installation_Disk_Root_Directory>\Setup\En\setup_host.exe /s 
TARGETDIR="<Target_Installation_Directory>" /qnb

where <full path to UserInput file> is the path to your customized 
UserInput.xml file and <Target_Installation_Directory> is the directory 
in which to install the Performance Center Server or Host.

Silent Installation of the Standalone Load Generator
This section describes how to perform a silent installation of the standalone 
load generator.

Note: For instructions on installing the HP Load Generator silently on 
Linux, see "Silent Installation of the HP Load Generator on Linux" on 
page 88.
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To perform a silent installation of the standalone load generator:

 1 Install all the prerequisite software except for IIS. For details, see "Silent 
Installation of Prerequisite Software" on page 70. 

 2 Extract the Load Generator installation files to a local directory:

 a Insert the DVD labeled HP ALM Performance Center 11.50 - 
Standalone Applications, and click Load Generator.

 b In the Save files in folder box, enter the name of the local directory 
where you want to save the installation files.

 3 Run the following command from the command line:

where <Installation_Folder> is the local directory where you saved the 
installation files.

 4 After you silently install the load generator, you need to install the 
Performance Center agent service and the Remote Management agent 
service.

 a To install the Performance Center agent service, run the following 
command from the command line:

 b To install the Remote Management agent service, run the following 
command from the command line:

msiexec /i "<Installation_Folder>\HP_LoadGenerator.msi" /qb

"<load_generator_installation_directory>\Load 
Generator\launch_service\bin\magentservice.exe" -install

"<load_generator_installation_directory>\Load 
Generator\al_agent\bin\alagentservice.exe" -install IUSR_METRO 
<IUSR_METRO Password>
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Installing Standalone Components (Windows)

You can install standalone components that provide advanced features for 
working with HP ALM Performance Center. 

To install a load generator on Linux, see "Installing HP Load Generator on 
Linux" on page 82.

Note: For all standalone applications, you must first manually install the 
prerequisite applications. For more details, see "Silent Installation of 
Prerequisite Software" on page 70

This section includes:

➤ "Available Standalone Components for Windows" on page 80

➤ "Installing Standalone Components" on page 81
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Available Standalone Components for Windows
The following standalone components are available. To install these 
components, see "Installing Standalone Components" on page 81.

➤ HP Load Generator. Instead of installing a Performance Center Host and 
then configuring it as a load generator, you can install a standalone 
version of the load generator. This host can behave only as a load 
generator, unlike the Performance Center host, which can also be 
configured as a Controller or data processor.

Note: If you know in advance that a particular host machine is to be used 
as a load generator only, we recommend that you install the standalone 
Load Generator for the following reasons:

➤ The installation requires less disk space

➤ Moving the Load Generator’s setup files is less time consuming than 
moving the setup files of the Performance Center Host

➤ HP Virtual User Generator. HP Virtual User Generator (VuGen) generates 
virtual users, or Vusers, by recording actions that typical end-users would 
perform on your application. VuGen records your actions into automated 
Vuser scripts which form the foundation of your performance tests. 

➤ HP LoadRunner Analysis. HP Analysis provides graphs and reports with 
in-depth performance analysis information. Using these graphs and 
reports, you can pinpoint and identify the bottlenecks in your application 
and determine what changes need to be made to your system in order to 
improve its performance.

➤ MI Listener. The MI Listener is one of the components needed to run 
Vusers and monitor applications over a firewall. To install, run 
SetupMIListener.exe. For more information about firewalls in 
Performance Center, see Part IV, "Working with Firewalls."

➤ Monitor Over Firewall Agent. Used to monitor servers that are located 
over a firewall. For more information about firewalls in 
Performance Center, see Part IV, "Working with Firewalls."
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Installing Standalone Components
This section describes the installation process for standalone components.

To install any of the standalone components:

 1 Insert the HP ALM Performance Center Additional Components 
installation disk (DVD 2) and run the setup (<installation disk root 
directory>\setup.exe). The setup program displays the installation menu 
page. 

 2 Select one of the following options: 

➤ Load Generator. Installs the standalone Load Generator for Windows. 

➤ Virtual User Generator. Installs Standalone VuGen. For more details, 
see the HP LoadRunner Installation Guide.

➤ Analysis. Installs Standalone Analysis. For more details, see the HP 
LoadRunner Installation Guide.

➤ MI Listener. Installs the MI Listener component. For more details, see 
the HP LoadRunner Installation Guide.

➤ Monitor Over Firewall. Installs the Monitor Over Firewall component. 
For more details, see the HP LoadRunner Installation Guide.

 3 MI Listener/Monitor Over Firewall installations only: Follow the 
instructions in the installation wizard. After installation, the 
configuration wizard opens, requesting the name of the product you are 
working with. Select Performance Center.

Installing the Patch for Standalone Components
This section describes how to install the patch on the standalone 
applications needed for working with Performance Center (HP Virtual User 
Generator and HP LoadRunner Analysis, Standalone Load Generator). 

To install the patch on standalone components:

To install the patch, on the machine where the application is installed, run 
the relevant patch installation file (.msp) and follow the onscreen 
installation and deployment instructions.
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Installing HP Load Generator on Linux

This section describes how to install the HP Load Generator on Linux. It 
includes the following steps:

 1 Review system requirements

Before you install the HP Load Generator on a Linux platform, review the 
system requirements as described in "Linux System Requirements" on 
page 83.

 2 Install the HP Load Generator

➤ You install HP Load Generator using the HP Load Generator Setup 
Wizard. For more information, see "Running the Linux Load Generator 
Setup Wizard" on page 87.

➤ To install the HP Load Generator on Linux silently, see "Silent 
Installation of the HP Load Generator on Linux" on page 88.
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 3 Configure your environment

Before you can begin working with the load generator you need to 
configure your environment. This involves setting the appropriate 
environment variables, checking access to the load generator, and 
verifying the installation. See "Configuring the Linux Environment" on 
page 89.

Note: For troubleshooting tasks relating to the setup of the Linux Load 
Generator, see "Linux Load Generator Troubleshooting" on page 95.

Linux System Requirements
This section describes the system requirements necessary for installing the 
HP Load Generator on a Linux platform.

Hardware Requirements

Memory (RAM)

256 MB minimum

Note: The exact memory depends on the types of 
Vuser protocols that are run, and the system under 
test, and can vary greatly.

Available Hard Disk Space 500 MB minimum

CPU Type Intel Core, Pentium, AMD or compatible

CPU Speed 1 GHz minimum. 2 GHz or higher recommended
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Software Requirements

The following table lists the software requirements necessary for installing 
the 32-bit or 64-bit version of HP Load Generator. 

Supported Linux Distributions

The following table lists the Linux distributions on which you can install a 
Linux Load Generator. Both 32-bit and 64-bit versions of the distributions 
are supported. 

Software How to install How to configure

RSH server yum install rsh-server 1  Start rsh-server, type chkconfig rsh on.

2  Edit the /etc/xinetd.d/rsh file. Change 
disable to no.

3  Edit the /etc/securetty file. Add a new 
line at the top and type rsh.

4  Edit the ~/.rhosts file. Add the PC Server 
and the Controller FQDN hostnames to 
the list. Change file permission by 
running chmod 0600 ~/.rhosts. 

5  Edit the /etc/pam.d/rsh file to include 
auth required pam_rhosts_auth.so    
promiscuous.

6  Run service xinetd restart to restart the 
xinetd service.

7  Set C Shell as the default shell by editing 
the ~/.profile file. Add the following 
lines:

➤ set SHELL=/bin/csh

➤ export SHELL

RSH yum install rsh
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Note: The HP Load Generator supports all X Servers. 

Distribution Version

Red Hat 
Enterprise Linux

➤ Red Hat Kernel 5.0

➤ Red Hat Kernel 6.0

Oracle Enterprise 
Linux

➤ Enterprise Linux 5.0

➤ Enterprise Linux 6.0

➤ Unbreakable Enterprise Kernel 5.6

➤ Unbreakable Enterprise Kernel 6.0

Ubuntu Server ➤ 10.04 LTS

➤ 12.04 LTS

Amazon Linux 2012.03 or later
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Prerequisite Packages for 64-bit Installations

The following table lists the packages that must be installed before installing 
the 64-bit version of HP Load Generator.

Note: * The prerequisites listed in the table above indicate the naming 
patterns for the required packages. Actual names may vary depending on 
the exact system architecture.

Distribution Prerequisites*
How to check if it is 
installed

How to install

Red Hat 
family 
including 
Oracle 
Linux and 
Amazon 
Linux

➤ glibc.i686 rpm -qa --qf '%{NAME}.%
{ARCH}\n' | grep -E 
'glibc\.(i686|i386)'

yum install 
<package_name>

➤ libstdc++.i686 
(Oralce Linux 6)

➤ libstdc++.i686 
(Redhat Linux 5, 
Oralce Linux 5)

➤ libstdc++47.i686 
(Amazon Linux)

rpm -qa --qf '%{NAME}.% 
{ARCH}\n' | grep -E 
'libstdc\+\+ 
[0-9]*\.(i686|i386)'

➤ ncurses-libs.i686 
(needed by 
SecurityConsole)

➤ ncurses.i386 
(Redhat Linux 5)

rpm -qa --qf '%{NAME}.% 
{ARCH}\n' | grep -E 
'ncurses(-
libs)?\.(i686|i386)'

Ubuntu 
Server

➤ libc6-i386

➤ lib32stdc++6

➤ dpkg -l libc6-i386

➤ dpkg -l lib32stdc++6

➤ lib32ncurses5 
(needed by 
SecurityConsole)

apt-getinstall 
<package_name>
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Running the Linux Load Generator Setup Wizard
This section describes how to use the Load Generator Setup Wizard to install 
the HP Load Generator on a Linux platform.

For details on how to perform a silent installation, see "Silent Installation of 
the HP Load Generator on Linux" on page 88.

Note: There are two versions of the Load Generator Setup Wizard, a 32-bit 
version and a 64-bit version. Make sure that you run the correct version for 
your Linux installation.

➤ The 64-bit version checks that the required pre-requisite software is 
installed on the computer. If any pre-requisite software is missing, a 
message is displayed, and the setup wizard will abort. Install the required 
package and then re-run the setup wizard.

➤ The 32-bit version of the setup wizard does not check that the pre-
requisite software is installed.

To run the Load Generator Setup Wizard:

 1 Change the directory to:

 2 Use chmod -R a+x to add execute permissions to all files and subfolders in 
the installation directory.

 3 [sh and bash shells] Launch the setup wizard by typing:

[csh and tcsh shells] Launch the setup wizard by typing:

/<installation root directory>/InstData/Linux/VM 

source ./installer.sh

./installer.sh
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Note: It is recommended that you use the source command to run the 
setup wizard, as shown above. If you run the setup wizard without using 
the source command, you must set up the environment variables for the 
current shell session. For details, see "Setting Environment Variables" on 
page 90.

Follow the online instructions to install the HP Load Generator.

Note: If you encounter an error during the installation, see "Linux Load 
Generator Troubleshooting" on page 95 for a possible solution.

 4 After you install the load generator, configure your environment as 
described in "Configuring the Linux Environment" on page 89.

Silent Installation of the HP Load Generator on Linux
This section describes how to install the HP Load Generator on Linux 
silently. 

To install the HP Load Generator on Linux silently: 

 1 Change the current directory to the installer directory:

 2 Run the following command to silent-install the Load Generator:

cd <path_to_installer_cd>/InstData/Linux/VM 

source ./installer.sh -i silent 



Chapter 2 • Installing HP ALM Performance Center

89

Note: It is recommended that you use the source command to perform 
the silent installation, as shown above. If you perform the installation 
without using the source command, you must set up the environmental 
variables after installing the Load Generator. For details, see "Setting 
Environment Variables" on page 90.

If you encounter an error during the installation, see "Linux Load 
Generator Troubleshooting" on page 95 for a possible solution. 

By default, the Load Generator will be launched at the end of the 
installation. If you do not want to automatically launch the Load 
Generator, run the source command using the following command-line 
option:

Configuring the Linux Environment
This section describes the configuration steps you need to complete before 
you can begin working with the HP Load Generator on Linux. 

To complete the setup process:

 1 Set the appropriate environment variables. See "Setting Environment 
Variables" on page 90.

Note: If you used the source command to install the Load Generator, the 
setup wizard automatically sets the appropriate environment variables - 
and there is therefore no need to perform this step.

 2 Verify the Load Generator installation. See "Verifying the HP Load 
Generator Installation on Linux" on page 91.

source ./installer.sh -i silent –DSTART_PRODUCT _AFTER_
INSTALL=No
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 3 Check that the Controller can access the Load Generator. See "Checking 
Controller Connection" on page 93.

Setting Environment Variables

Note: This topic is applicable only if you ran the Load Generator Setup 
Wizard without using the source command. If you used the source 
command, there is no need to perform any of the procedures described 
below.

➤ To enable the Load Generator to run, the following environment 
variables must be defined:

➤ M_LROOT. The location of the Linux Load Generator installation 
directory.

➤ PATH. The location of the Linux Load Generator bin directory.

➤ The Load Generator Setup Wizard performs the following tasks relating to 
the environment variables:

➤ Adds the environment variable definitions to the system-wide startup 
scripts.

If the variable definitions were not correctly set during the setup, see 
"Linux Load Generator Troubleshooting" on page 95 for possible 
solutions.

➤ Sets environment variables for the current shell session if the source 
command was used to run the setup wizard. 

This topic describes how to set the environment variables for the 
current shell session if the source command was not used to run the 
setup wizard.

➤ To determine if environment variables are set, run verify_generator (see 
"Running verify_generator" on page 92) or use the following command:

echo $M_LROOT
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➤ If the name of the Load Generator installation folder is returned, then the 
environment variables are correctly set for current shell. If the name of 
the Load Generator installation folder is not returned, then manually set 
the variables as described below.

To manually set the environment variables for the current shell session (if 
the source command was not used to run the setup wizard), execute one 
of the following commands:

➤ Bash users:

➤ C Shell users:

Verifying the HP Load Generator Installation on Linux

The Load Generator installation includes a setup verification utility, 
verify_generator, that checks the Load Generator setup on your Linux 
machine. The verification utility checks environment variables and your 
startup scripts (/etc/csh. cshrc, ${HOME}/.cshrc or /etc/profile, 
${HOME}/.profile) to verify that they are set up correctly.

It is strongly recommended that you run the verify_generator utility after 
installing the HP Load Generator, before attempting to invoke the Load 
Generator. For details on how to run the verify_generator utility, see 
"Running verify_generator" on page 92.

The verify_generator utility checks the following items: 

➤ All the prerequisite software is installed. (This check is performed for 64-
bit installations only.)

➤ There are at least 128 file descriptors.

➤ The .rhosts permissions have been defined properly: -rw-r--r--

➤ The host can be contacted by using rsh to the host. If not, it checks for 
the host name in .rhosts.

➤ M_LROOT is defined.

source <Load Generator installation directory>/env.sh

source <Load Generator installation directory>/env.csh
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➤ .cshrc or .profile defines the correct M_LROOT.

➤ /etc/csh.cshrc, ${HOME}/.cshrc or /etc/profile, ${HOME}/.profile defines the 
correct M_LROOT.

➤ .cshrc or .profile exists in the home directory.

➤ The current user is the owner of the .cshrc or .profile.

➤ A Linux Load Generator installation exists in $M_LROOT.

➤ The executables have executable permissions.

➤ PATH contains $M_LROOT/bin, and /usr/bin.

➤ The rstatd daemon exists and is running.

Running verify_generator

It is recommended that you run the verify_generator utility after installing 
the HP Load Generator, before attempting to invoke the Load Generator. For 
details on what is checked by the verify_generator utility, see "Verifying the 
HP Load Generator Installation on Linux" on page 91.

Note: To run this command, you must be a "normal" user and not root user.

To run the verify_generator utility:

 1 From the <load generator installation directory>/bin, run the following 
command:

For example:

If you want to receive detailed information about the checks you can use 
the -v option, as follows:

verify_generator

/opt/HP/HP_LoadGenerator/bin/verify_generator

verify_generator -v
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 2 View the results.

➤ If the settings are correct, verify_generator returns OK. 

➤ If they are incorrect, verify_generator returns Failed and a suggestion 
on how to correct the setup.

Checking Controller Connection

If the LoadRunner Controller will connect remotely to the Load Generator 
using rsh (remote shell), you need to make sure that the Load Generator can 
be remotely accessed by the Controller.

 1 On the Load Generator machine, locate the .rhosts file which is located in 
the user home directory.

 2 In the .rhosts file, verify that the Controller is included in the list of 
machines. If it is not listed, add it to the list.

 3 If the Controller still cannot connect to the Load Generator, contact your 
system administrator.

Connecting to a Linux Load Generator Without Using rsh

You can configure the Controller to connect to the Load Generator without 
using rsh. In this case, you need to activate the agent daemon on the Load 
Generator, as described below.

To connect to a Linux Load Generator without using rsh:

 1 On the Linux Load Generator, run the agent daemon by entering the 
following command from <Load Generator installation directory>/bin:

This runs a daemon called m_agent_daemon, and if successful, you 
receive a message: m_agent_daemon <process ID>.

The agent now keeps running, even if the user is logged off. You can stop 
the agent by using the command explained in step 9 on page 94, or by 
rebooting the machine.

m_daemon_setup -install
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Note: If you look at the m_agent_daemon[xxx].log log file in the temp 
directory, you may see communication errors, even if the installation 
succeeded.

 2 In the Controller, select Scenario > Load Generators. The Load Generators 
dialog box opens.

 3 Click Add. The Load Generators dialog box opens.

 4 In the Name box, enter the name of the computer on which the Load 
Generator is running.

 5 From the Platform list, select Linux.

 6 Click More.

 7 Click the Linux Environment tab, and make sure that the Don’t use RSH 
check box is selected.

 8 Connect as usual.

 9 To stop the agent daemon, run the following command from the 
<LR_root>/bin directory:

This stops the m_agent_daemon daemon, and if successful, you receive a 
message: m_agent_daemon is down.

m_daemon_setup -remove
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Linux Load Generator Troubleshooting 
This topic describes troubleshooting tasks relating to the setup of the Linux 
Load Generator.

Environment variables were not set correctly in the system-wide 
startup scripts

To enable the Load Generator to run, the system-wide startup scripts must 
be modified to set specific environment variables. The required 
modifications to the startup scripts are made by the Load Generator Setup 
Wizard. If the startup scripts were not correctly modified during the setup of 
the Load Generator, you can manually make the required changes to the 
startup scripts as described below. The required changes differ slightly 
between C shell users, and Bourne and Korn shell users.

Solution:

➤ Manually modifying the startup scripts for C shell users

During the Load Generator installation process, the setup wizard creates 
the env.csh script. This script includes the commands to set the required 
environment variables for C shell users. A sample env.csh script is shown 
below.

Add the following line to the /etc/csh.cshrc or ~/.cshrc startup script to 
execute the env.csh script during the shell startup:

For example:

setenv PRODUCT_DIR <Load Generator installation directory>

setenv M_LROOT ${PRODUCT_DIR}

if ( ! $?PATH ) then

setenv PATH ""

endif

setenv PATH ${M_LROOT}/bin:${PATH}"

source <Load Generator installation directory>/env.csh

source /opt/HP/HP_LoadGenerator/env.csh
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The effect of making the above modification to the startup script is 
similar to the modifications that are made by the setup wizard. A sample 
of the modifications that the setup wizard makes to the /etc/csh.cshrc 
startup script is shown below:

➤ Manually modifying the startup scripts for Bourne and Korn shell users

During the Load Generator installation, the setup wizard creates the 
env.sh script. This script includes commands to set the required 
environment variables for Bourne shell and Korn shell users.

# New environment setting added by HP_LoadGenerator on Wed Jan 30

16:20:10 IST 2013 2.

# The unmodified version of this file is saved in /etc/.login1557000131.

# Do NOT modify these lines; they are used to uninstall.

setenv PRODUCT_DIR "/opt/HP/HP_LoadGenerator"

# End comments by InstallAnywhere on Wed Jan 30 16:20:10 IST 2013 2.

# New environment setting added by HP_LoadGenerator on Wed Jan 30

16:20:10 IST 2013 5.

# The unmodified version of this file is saved in /etc/.login1557000131.

# Do NOT modify these lines; they are used to uninstall.

setenv M_LROOT "/opt/HP/HP_LoadGenerator"

# End comments by InstallAnywhere on Wed Jan 30 16:20:10 IST 2013 5.

# New environment setting added by HP_LoadGenerator on Wed Jan 30

16:20:10 IST 2013 8.

# The unmodified version of this file is saved in /etc/.login1557000131.

# Do NOT modify these lines; they are used to uninstall.

if ( ! $?PATH ) then

setenv PATH ""

endif

setenv PATH "/opt/HP/HP_LoadGenerator/bin:${PATH}"

# End comments by InstallAnywhere on Wed Jan 30 16:20:10 IST 2013 8.
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Add the following line to the /etc/profile or ~/.profile startup script to 
execute the env.sh script during the shell startup:

For example:

The effect of making the above modification to the startup script is 
similar to the modifications that are made by the setup wizard. A sample 
of the modifications that the setup wizard makes to the /etc/profile 
startup script is shown below:

source <Load Generator installation directory>/env.sh

source /opt/HP/HP_LoadGenerator/env.sh

# New environment setting added by HP_LoadGenerator on Fri Jan 18

11:14:24 IST 2013 1.

# The unmodified version of this file is saved in /etc/profile1806316421.

# Do NOT modify these lines; they are used to uninstall.

PRODUCT_DIR=/opt/HP/HP_LoadGenerator export PRODUCT_DIR

# End comments by InstallAnywhere on Fri Jan 18 11:14:24 IST 2013 1.

# New environment setting added by HP_LoadGenerator on Fri Jan 18

11:14:24 IST 2013 4.

# The unmodified version of this file is saved in /etc/profile1806316421.

# Do NOT modify these lines; they are used to uninstall.

M_LROOT=/opt/HP/HP_LoadGenerator export M_LROOT

# End comments by InstallAnywhere on Fri Jan 18 11:14:24 IST 2013 4.

# New environment setting added by HP_LoadGenerator on Fri Jan 18

11:14:24 IST 2013 7.

# The unmodified version of this file is saved in /etc/profile1806316421.

# Do NOT modify these lines; they are used to uninstall.

PATH="/opt/HP/HP_LoadGenerator/bin:${PATH}"

export PATH

# End comments by InstallAnywhere on Fri Jan 18 11:14:24 IST 2013

7. LoadRunner settings #PATH=${M_LROOT}/bin:$PATH; export PATH
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Error when installing the Load Generator on a Linux platform

When you use the source installer.sh command to install the Load 
Generator [version 11.52] on a Linux machine on which the Load Generator 
[version 11.52] was previously installed, you may receive the following error 
message: "An error occurred while trying to manage the selected instance."

Solution:

 1 Open the registry file /var/.com.zerog.registry.xml and locate the element 
"product" with attribute "name"="HP_LoadGenerator".

For example: <product name="HP_LoadGenerator" id="77f695c1-1f0c-
11b2-883dc486a85f6555" version="11.52.0.0" copyright="2012" 
info_url="http://www.hp.com" support_url="http://www.hp.com" 
location="/opt/HP/HP_LoadGenerator" last_modified="2013-01-21 
13:12:14">

 2 Record the value of the location attribute.

 3 Remove the entire directory that is referred to by the location attribute.

 4 Delete the registry file /var/.com.zerog.registry.xml.

 5 Rerun the source installer.sh command.

Environment variables are not removed after uninstalling the Load 
Generator

When you uninstall the Load Generator, the Load Generator environment 
variables (M_LROOT, PRODUCT_DIR and PATH) may not be removed for 
the current shell. 

Solution:

To remove the environment variables, close the current shell session and 
invoke a new one, or manually unset the variables using the unset 
command.
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Unable to run Vusers on the Load Generator

If you are unable to run Vusers on the Load Generator, no specific error is 
reported, and the Vuser protocol requires a third-party application or client 
to be present on Load Generator side, check the dynamic libraries used by 
the application. This will enable you to establish if any shared objects 
cannot be found. A shared object that cannot be found may indicate either a 
missing prerequisite package or an environment variable issue.

Solution:

To check the dynamic libraries used by an application, type:

For example, type ldd mdrv to determine if all the dependencies of the mdrv 
executable can be found. If any dependencies are not found, run 
verify_generator as described in "Running verify_generator" on page 92.

Note: If you are running Vusers for a protocol that requires a client 
installation (for example, Oracle), make sure that the path for the client 
libraries is included in the dynamic library path environment variable 
(LD_LIBRARY_PATH or SHLIB_PATH).

ldd application_name
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Installing Additional Components

You can install additional components that provide advanced features for 
working with Performance Center. You install these components from the 
Additional Components directory, located in the root directory of the 
installation disk. The following components are available:

Component Description

Agent for Citrix Server Installs an optional component on the server 
machine that enhances VuGen’s capabilities in 
identifying Citrix client objects.

Agent for Microsoft 
Terminal Server.

Used for extended RDP protocol record-replay. This 
component runs on the server side, and is used to 
create and run enhanced RDP scripts.

Assembly Crawler for 
Analysis API

Installs a command-line utility to build a .NET 
configuration file for a LoadRunner Analysis API 
application. For more information, refer to the 
Analysis API Reference.

HP Diagnostics Mediator Gathers and correlates offline transaction data for 
the ERP/CRM diagnostics modules.

HP Performance Validation 
SDK

Provides the tools to create a custom protocol for 
running performance tests on a previously 
unsupported application. For more information, 
see the HP Performance Validation SDK Developer’s 
Guide.

IDE Add-ins Installs a component that enables you to create 
and run scripts written in your standard 
development environment, in the application's 
native language. Select an add-in from the IDE 
Add-ins directory, and run the add-in’s executable 
file.

LRTCPDump A trace file containing a log of all TCP traffic over 
the network. Using a sniffer application, you 
obtain a dump of all of the network traffic. The 
sniffer captures all of the events on the network 
and saves them to a capture file.
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Mobile Sniffer Agent The sniffer captures all of the events on the 
network and saves them to a capture file.

Monitor Probe for 
Microsoft COM+ Server 
Components

Configures the server machine for COM+ 
monitoring.

MQ Tester Installs a component on the VuGen machine to 
generate scripts that load IBM MQ Series.

SAP Tools The following SAP tools are available:

➤ SAPGUI Spy. Helps examine the hierarchy of 
GUI Scripting objects on open windows of 
SAPGUI Client for Windows. To install the 
SAPGUI Spy component, copy the three files 
mscomctl.ocx, Msflxgrd.ocx, and msvbvm60.dll 
from the SAP_Tools\SapGuiSpy\System32VBdlls 
directory to your C:\WINNT\system32 
directory, and register the files. To register each 
file, select Run from the Windows Start menu 
and type: regsvr32 <File name>. Run SapSpy.exe 
from the SAP_Tools directory.

➤ SAPGUI Verify Scripting. Helps you verify 
whether the SAPGUI Scripting API is enabled. To 
install the Verify Scripting component, run 
VerifyScripting.exe from the 
SAP_Tools\VerifySAPGUI directory.

➤ Verify RFC User. Determines whether the SAP 
user you specified to connect to the SAP system 
has permissions to invoke the required RFC 
functions necessary for working with SAP 
Diagnostics. To install the Verify RFC User 
component, copy RFCFunctionsCollection.dll 
from the Verify RFC User directory to your local 
hard drive. Then register the file by selecting 
Run from the Windows Start menu and typing: 
regsvr32 RFCFunctionsCollection.dll. In the Verify 
RFC User directory, load 
AddMTSDestinationsFolder.reg by double-
clicking the file. Then run VerifyRFCUser.exe.

Component Description



Chapter 2 • Installing HP ALM Performance Center

102

Snapshot Viewer The Snapshot Viewer enables you to view 
snapshot-on-error pages captured from Web Vusers 
during performance test runs. The viewer displays 
snapshots from files with .SOE and .INF extensions. 
A Snapshot on Error (.SOE) file is a zipped file 
containing one or more snapshots in .INF format. 
To install, run 
\Applications\SetupSnapshotViewer.exe.

WebtrendsExporter This tool enables you to export Webtrends data 
(Data Extraction API) into a PAL data set file. 
Run \Additional Components\WebtrendsExporter
\WebtrendsExporter.exe. Enter the Webtrends 
host name, user name (must have permissions to 
access Data Extraction API), and password. Click 
Login. In the Webtrends Data Extractor, select the 
Webtrends profile. Set the date and time for 
exporting the file. Click Export Dataset.

WinPcap Installs the WinPcap utility. WinPcap allows the 
user to capture network traffic into a file for later 
analysis. WinPcap is used in the Server Side 
Recording feature in the VuGen Web Services 
protocol. For more details on WinPcap, see 
http://www.winpcap.org/.

Component Description

http://www.winpcap.org
http://www.winpcap.org
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Updating Lab Management Projects to the Latest Patch

If you are upgrading from HP ALM Performance Center 11.50 to the latest 
patch, ALM automatically updates your Lab Management project to the 
latest patch. For more details, see the “Upgrading Projects to a New Version” 
chapter in the HP Application Lifecycle Management Administrator Guide.

Repairing the Performance Center Installation

If you have errors in your original Performance Center installation, such as 
missing or corrupt files, shortcuts and registry entries, you can repair them 
using the Performance Center Setup Wizard. 

To repair your Performance Center installation:

 1 Insert the Performance Center installation disk into your disk drive.

 2 From the Windows Control Panel, open the Add/Remove Programs dialog 
box.

 3 Select HP Performance Center <component> from the list of currently 
installed programs and click Change. The Performance Center Setup 
Wizard opens, displaying the Welcome page. Click Next.

 4 On the Maintenance Type page that opens, select Repair. 

Click Next and follow the instructions in the wizard to complete the 
repair process.
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Uninstalling Performance Center Components

This section describes how to uninstall Performance Center components 
from Windows and UNIX machines.

Uninstalling the Performance Center Server and Hosts
You can uninstall Performance Center servers and hosts using the 
Performance Center Setup Wizard or using the silent commands.

To uninstall Performance Center components using the setup wizard:

 1 From the Windows Control Panel, open the Add/Remove Programs dialog 
box.

 2 From the list of currently installed programs, select HP 
Performance Center and click Remove. 

 3 Follow the instructions in the wizard to complete the uninstall process.

To uninstall Performance Center components silently:

➤ Run the applicable command from the command line.

➤ Performance Center Server:

➤ Performance Center Host:

msiexec /uninstall 
“<Installation_Disk_Root_Directory>\Setup\Install\Server\PCServer.msi” /qnb

msiexec /uninstall 
“<Installation_Disk_Root_Directory>\Setup\Install\Host\PCHost_x64.msi” /qnb

Or

msiexec /uninstall
“<Installation_Disk_Root_Directory>\Setup\Install\Host\ PCHost_x86” /qnb
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Uninstalling the HP Load Generator from Linux
You can use the Load Generator Setup Wizard to uninstall the HP Load 
Generator, as described below. Note that the last step in the procedure 
enables you to perform either a regular uninstall or a silent uninstall.

To uninstall the HP Load Generator from Linux: 

 1 Make sure that you are logged in as the same user who installed the HP 
Load Generator.

 2 Change the current directory to the installation directory:

 3 Run the following command, and then follow the instructions in the 
wizard to uninstall the HP Load Generator:

To perform a silent uninstall, run the following command:

cd <path_to_installation_folder>/_HP_LoadGenerator_Installation

sh ./Change_HP_LoadGenerator_Installation

sh ./Change_HP_LoadGenerator_Installation -i silent
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3
Post Installation Verification

This section describes how to verify that the installation of the 
Performance Center Server and hosts was successful. The environment for 
this process should be a staging environment, including a 
Performance Center Server and two to three Performance Center hosts.

Note: You can run a full validation on your ALM-Performance Center 
system from Lab Management, in the System Health module’s System Check 
tab. For more details, see the HP ALM Lab Management Guide.

This chapter includes:

➤ Administrator Workflow on page 107

➤ Performance Tester Workflow on page 111

Administrator Workflow

This section describes the workflow for the Performance Center 
administrator.

 1 Log on to Site Administration.

 a Open the Web browser and type the ALM URL
http://<ALM platform server>[<:port number>]/qcbin.

The ALM Options window opens.

 b Click Site Administration, enter the user name and password of a Site 
Administrator, and click Login. 
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 2 Create a project administrator user.

 a In Site Administration, select the Site Users tab and click New User. 
The New User dialog box opens.

 b Enter the details of the project administrator user, and click OK.

 c Select the user, click Password, enter the password, and click OK.

 3 Create a domain.

 a In Site Administration, select the Site Projects tab and click Create 
Domain. The Create Domain dialog box opens.

 b Enter a name for the new domain, and click OK. 

 4 Create a new project.

In the Site Projects tab, select the domain you just created, and click 
Create Project. Follow the steps to create the project. When prompted:

 a Add the project administrator user you created above to the Selected 
Project Administrators list.

 b HP ALM (consolidated license): Select ALM Lab Extension.

 5 Assign more project administrators to the project - optional.

 a Click the Site Projects tab.

 b In the Projects list on the left, select the project you created.

 c In the right pane, click the Project Users tab.

 d Add another user, and select Project Administrator. 

 6 Log on to Lab Management. 

 a Open the Web browser and type the ALM URL
http://<ALM platform server>[<:port number>]/qcbin.

The ALM Options window opens.

 b Click Lab Management, enter the user name and password of a Site 
Administrator, and click Login. 
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 7 Verify the Performance Center configuration.

On the Lab Management sidebar: 

➤ Under Servers, select PC Servers and verify that the 
Performance Center Server is listed.

➤ Under Performance Center, select PC Licenses and verify the license 
details. 

For more details, see "Configuring Performance Center in Lab 
Management" on page 65. 

 8 Define additional hosts for the staging environment.

For the staging environment, you should have two to three 
Performance Center hosts, where at least one host purpose is configured 
as Controller, and at least one host purpose is configured as 
Load Generator.

Note: When adding hosts, fields in red marked with an asterisk (*) are 
mandatory. Make sure to include the operating system type, and the 
purpose of the host. For more details, see the HP ALM Lab Management 
Guide.

 a In Lab Management, under Lab Resources, select Hosts.

 b Click the New Testing Host button. The New Host dialog box opens, 
enabling you to define the host details. 
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 9 Create host pools.

 a In Lab Management, under Lab Resources, select Pools.

 b Click the New Host Pool button. The New Host Pool dialog box opens, 
enabling you to define a new host pool. 

 c In the Host Pools module, right-click the new host pool and select 
Host Pools Details. 

 d In the Host Pool Details dialog box, select Linked Hosts, and click the 
Add Hosts to Pool button. 

 e In the Add Hosts to Pools dialog box, select the hosts to add to the 
pool, and click Add. The hosts are added to the pool.

 10 Define project settings.

 a In Lab Management, select Project Settings.

 b Right-click the project and select Project Settings Details. In the 
Project Settings Details dialog box, define the project’s settings. In 
particular, set the Vuser limit, Host limit, and Concurrent run limit. 
Also, select the host pool you created above for the project.
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Performance Tester Workflow

This section describes the workflow for the Performance Center tester. 

 1 Log on to a Performance Center project.

Log on to the project you created in the administration workflow with 
the user credentials you created.

 2 Create a monitor profile. 

Note: The monitor profile is selected for a performance test when you 
design the test.

 a On the ALM sidebar, under Testing, select Test Resources. 

 b Click the New Resources Folder button and specify a name for the 
folder. 

 c In the tree, right-click the new folder, and select New Resource. 

 d In the New Resource dialog box, in the Type box, select Monitor 
Profile, and give the profile a name. 

 e In the tree, select the new monitor profile, and in the right pane, click 
the Monitors Configuration tab.

 f Click the Add Monitor button. 

 g In the Add New Monitors dialog box, select the monitor that you want 
to add to the profile. The relevant Edit Monitor dialog box opens.

 h Enter the details of the server to be monitored, and select the counters 
that you want to monitor.
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 3 Create a topology.

Note: The topology is selected for a performance test when you design the 
test.

You can create a topology that graphically displays the logical 
components that make up the application under test (AUT) and the 
relationships between the components.

This provides a useful method for managing your inventory of AUT hosts 
and enables topology-oriented monitoring and analysis.

 a On the ALM sidebar, under Performance Center, select Topologies. 

 b Click the New Topology button. The New Topology dialog box opens.

 c Enter the topology details. If you want to add SiteScope monitors to 
the topology, specify the SiteScope server details. Click OK. The 
Topology Designer window opens.

 d (Optional) Define your AUT hosts. For each host, click the New AUT 
Host button on the toolbar, and enter the AUT host’s details. These 
hosts are automatically added to your project’s AUT host pool. 

Note: An AUT host pool is created automatically as soon as you add an 
AUT host.

 e From the palette on the left, select relevant server/component nodes 
for your topology, and drag them onto the Topology canvas.

 f To connect two nodes, click one node and drag the mouse to another 
node.

 g (Optional) For each node, select the node and enter the relevant 
properties in the Properties pane in the top-right corner of the 
Topology Designer. 
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 h To configure a SiteScope monitor on a node, select the node and click 
the Configure Monitors button. The Configure Monitors dialog box 
opens. 

 i Create a new SiteScope monitor: Define the monitor type, the instance 
(where necessary), and the data collection interval. 

Note: If an AUT host is assigned to the node, it is passed to SiteScope as 
a remote host and inserted as a default monitored server for all 
monitors created on the node.

 j Click Save and Close to save the topology. 

 4 Create a performance test.

You create performance tests in the Test Plan module.

 a On the ALM sidebar, under Testing, select Test Plan.

 b Click the New Folder button, and specify a name for the folder.

 c In the tree, right-click the new folder and select New Test. 

 d In the New Test dialog box, in the Type box, select Performance Test, 
and enter a name for the test. 

 5 Upload Vuser scripts.

You can upload Vuser scripts either directly from VuGen or from within 
the Test Plan module.

Note: 

➤ You select scripts for a performance test when you design the test.

➤ When uploading a script in the Test Plan module, the script must be 
zipped and must be saved locally.
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To upload scripts in the Test Plan module:

 a On the ALM sidebar, under Testing, select Test Plan module. 

 b Click the Upload VuGen Script button. 

 c In the Upload Scripts dialog box, in the Select Folder box, select the 
folder you created in step 4 above as the location to save the script. 

 d In the Select Scripts fields, click Select to navigate to the location of 
the scripts. You can upload five scripts at a time.

 e Click Upload.

 6 Design the performance test.

The following steps guide you through designing a performance test with 
a basic workload, using default settings. Some options and steps may vary 
if you change any of the default settings.

 a Open the Performance Test Designer. 

On the ALM sidebar, under Testing, select Test Plan. In the tree, right-
click the test that you created above, and select Edit Test. The 
Performance Test Designer window opens, displaying the Workload 
tab.

 b Select a workload. 

In the Workload Types dialog box, select the default workload type: 
Basic Schedule, by test, by number.

 c Assign a Controller.

By default, a dedicated Automatch Controller is selected. 

Note: A dedicated Automatch Controller functions as a Controller 
only, and cannot perform the functions associated with other hosts, 
such as load generators or data processors. 



Chapter 3 • Post Installation Verification

115

 d Add Vuser scripts.

Click the Select Scripts button. The scripts you uploaded are displayed 
in the Scripts Tree in the right pane. Select scripts for the test, and click 
the left arrow button to add them to the test. A Vuser group is created 
for each script, with a default of 10 Vusers.

 e Distribute load generators among the Vuser groups.

In the LG Distribution box, keep the default selection, Assign all to 
each group, and in the LG box, enter the desired number of 
load generators to be assigned to each group—enter 1.

 f Define a test schedule.

In the Global Scheduler pane, keep the default scheduler actions or 
modify them as desired. The available scheduler actions are:

➤ Initialize. Instructs the Scheduler to prepare the Vusers so that they 
are ready to run.

➤ Start Vusers. Instructs the Scheduler to start running the Vusers.

➤ Duration. Instructs the Scheduler to continue running the current 
action for the specified amount of time.

➤ Stop Vusers. Instructs the Scheduler to stop the running Vusers.

Tip: The schedule graph on the right of the Scheduler pane provides a 
graphical representation of the schedule actions defined in the Actions 
grid.

 g Select monitor profiles.

Click the Monitors tab and click Add Monitor Profile. The defined 
monitor profiles are displayed in the Monitor Profiles Tree in the right 
pane. Select monitor profiles for the test, and click the left arrow 
button to add them to the Monitor Profiles grid.
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 h Select a topology.

Click the Topology tab and click Select Topology. The topology you 
created earlier appears in the Topologies Tree in the right pane. Select 
the topology, and click the left arrow button to select it for the test.

 i Save the test.

When you are finished designing the test, click Save. A message is 
displayed in the bottom-left corner of the Performance Test Designer 
window. Verify that the test was saved without errors and is valid. 

 7 Add the test to a test set.

 a On the ALM sidebar, under Testing, select Test Lab.

 b Click the New Folder button. Specify a name for the folder.

 c In the tree, right-click the new folder, and select New Test Set. The 
New Test Set dialog box opens.

 d Enter a name for the test set, and in the Type box, select Performance.

 e In the tree, select the new test set, and in the right pane, click the 
Execution Grid tab.

 f Click Select Tests. The performance tests defined in the Test Plan 
module are displayed on the right, under the Test Plan Tree tab. Select 
the desired test and drag it to the execution grid.

 8 Reserve a timeslot for the test.

Decide on a time in the future to run the test, and reserve a timeslot to 
ensure that the required resources are available.

 a Under Testing, select Timeslots.

 b In the Timeslots module calendar view, click the New Timeslot button. 
The Timeslot Reservation dialog box opens.

 c Define the following information:

➤ Name. Enter a name for the timeslot.

➤ Start Time. Enter a start time for the timeslot.

➤ Duration. Set the duration for the performance test.
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➤ Test. Navigate to the test set you created above, and link the test 
instance to the timeslot. The number of Vusers and the hosts 
(Controller and load generators) defined in the test are displayed 
under Vusers and Requested Hosts respectively.

➤ Vusers. You can reserve more Vusers in addition to those defined for 
the test.

 d To set the test to start running at the beginning of the timeslot, select 
Autostart. 

 e (Optional) Click Add Automatch Host or Add Specific Host to reserve 
additional load generators for the timeslot. There must be a Controller 
and at least one load generator requested for the timeslot.

 f Click Calculate Availability. ALM calculates the availability of the 
requested resources during the selected timeslot. The result of this 
calculation is displayed in the Timeslot Status tab, as well as 
graphically on the time chart.

If the timeslot cannot be reserved, reselect your resources taking into 
account the reasons displayed in the Timeslot Status tab. 

 g If the requested resources are available, click Submit to save the 
timeslot.

 9 Run the test.

 a Under Testing, select Test Plan.

 b Right-click the test in the tree, and select Run Test. The Select Timeslot 
dialog box opens, displaying available timeslots for running the test, 
including the timeslot you created above. 

Note: If no timeslot was reserved in the Timeslots module, the Select 
Timeslot dialog box can be used to create one.

 c Select a timeslot in the grid and click Run.
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Note: Running a test directly from the Test Plan module should only 
be used as a shortcut option, and not as a complete test execution 
method. The Test Lab module is specifically designed to manage test 
execution, and it is recommended to always first add the test to a test 
set before considering using the shortcut provided. The main purpose 
of the shortcut is to enable running previously designed tests without 
having to return each time to the Test Lab module.

 10 Track existing performance test runs.

Under Testing, select Test Lab, and click the Test Runs tab. In this tab, you 
can track the state of existing test runs, as well as perform other post-run 
actions, such as collate, analyze, recalculate the SLA, and generate and 
view HTML reports.
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4
Performance Center Configuration 
Options

The Performance Center system comes with default configuration settings. 
These settings enable you to use Performance Center for its intended 
purpose. This chapter describes additional tuning and configuration to help 
you get the most out of your Performance Center system. 

Note: Not all the procedures in this chapter are suitable for all usage 
scenarios. You should assess which procedures are suitable to your system’s 
needs.

This chapter includes:

➤ Configuring Host Security Settings on page 120

➤ Configuration for Windows XP Professional on page 121

➤ Configuring IIS on Performance Center Machines to Use SSL on page 122

➤ Working with Performance Center Agent on page 129

➤ Configuration for HP Load Generator (Linux) on page 131

➤ Establishing Connectivity with Oracle on page 133

➤ Enabling Downloading Standalone Applications on page 134

➤ Enabling MS-SQL Windows Authentication on page 137
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Configuring Host Security Settings

The need to secure communication channels from hackers attacking the 
corporate networks is critical. The ability to secure communication channels 
ensures confidentiality, integrity, and the user's authenticity within the 
scope of the testing application. 

Secure communication is established between Performance Center hosts 
using a security key. This security key must be defined on each host. Then, 
as long there is one host with security enforced, secure channels can be 
established between that host and other hosts.

You configure initial security settings locally on the host using the Host 
Security Setup utility. To run this utility, on the host machine select Start > 
Program Files > Performance Center Host > Tools > Host Security Setup. 

Another utility, the Host Security Manager, which is installed on the 
Performance Center Server machine, can be used to remotely and 
simultaneously update security settings on all the hosts. You can use the 
Host Security Manager to:

➤ Update the security key of all the hosts in the system simultaneously.

➤ Change the mode of security on selected hosts. That is, you can enforce 
selected hosts to communicate over secure channels, or allow selected 
hosts to communicate over non-secure channels.

Note: Initial security settings must be set locally on each host using the Host 
Security Setup utility. After that, the Host Security Manager utility can be 
used to update security settings on all of the hosts.

For more information about configuring secure host communication, see 
the HP ALM Performance Center Guide.
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Configuration for Windows XP Professional

If you are running Windows XP, the Windows Firewall is turned on by 
default. The firewall does not allow Performance Center components to 
function as designed and must be turned off on all host machines on which 
the upload/download features are used.

Note: Turning off the Windows Firewall increases the risk to your 
computer's security. 

To turn off the Windows Firewall: 

 1 Select Start > Settings > Control Panel > Security Center (not in Advanced 
look of Control Panel).

 2 Click Windows Firewall.

 3 In the General tab select Off.

For each process that needs the firewall, you can unblock the process by:

➤ clicking the unblock button in the popup window that indicates that 
the program needs it

➤ tuning the Windows Firewall manually from the Exceptions tab
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Configuring IIS on Performance Center Machines to Use SSL

IIS (Microsoft Internet Information Server) is a prerequisite software for the 
Performance Center Servers. You can configure the IIS Performance Center 
virtual directories (PCS and LoadTest) to use SSL (Secure Socket Layer).

This section describes how to configure IIS Performance Center virtual 
directories to use SSL.

Before You Configure IIS
IIS uses port 443 to work over SSL. However, certain Performance Center 
components may also be configured to use this port. Therefore, you need to 
ensure that port 443 is available to be used by IIS and configure these 
Performance Center components to use a port other than 443.

Note: The Remote Management agent may be configured to use port 443.

Changing the Port on the Remote Management Agent

On all Performance Center Server machines, you need to change the port 
being used by the Remote Management agent for over firewall 
communication.

To change the port on the Remote Management agent:

 1 On the Performance Center Server machine, open <Performance Center 
Server installation directory>\al_agent\dat\mdrv.dat in a text editor.

 2 In the [launcher] section add the following line:

where <port_number> is the port you want to open. Enter a number 
other than 443. 

 3 In the same directory, open the file channel_configure.dat in a text editor.

OFWPort=<port_number>



Chapter 4 • Performance Center Configuration Options

123

 4 In the [General] section add the following line:

where <port_number> is the port you want to open. Enter the same 
number that you entered in step 2.

 5 Restart the Remote Management agent service for the configuration 
changes to take effect. To restart the service, select Start > Run and type 
services.msc. The Services dialog box opens. Locate the service 
RemoteManagement Agent Service and restart it.

Configuring IIS to Work Over SSL
This section describes the basic steps involved in setting up IIS on the 
Performance Center Server machine to use SSL. 

To configure IIS to use SSL on the Performance Center Server machine:

 1 Create the SSL certificate.

 2 Install the certificate you created onto the relevant machine that you are 
configuring for SSL.

 3 Install the certificate on the Performance Center Server that needs to 
communicate with the relevant machine that you are configuring for SSL.

The certificate should appear in the Microsoft Management Console 
under Certificates (Local Computer) > Trusted Root Certification.

Note: For more information about how to configure IIS with SSL, see 
http://support.microsoft.com/

OFWPort=<port_number>

http://support.microsoft.com/
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Configure IIS to Support Internal Communication
The following steps must be performed to enable secure internal 
communication on the Performance Center Server and Hosts.

To support internal communication on the Performance Center Server:

 1 Configure IIS to support SSL on port 443 as described above.

 2 Edit the web.config file located in the following path: <install path>\PCS

 a Under the <system.servicemodel><services> tag, there are six areas 
where the following comment appears: Uncomment to enable SSL. 
Uncomment the XML lines which appear thereafter. For example:

Before:

After:

 b Under the <system.servicemodel><behaviors> tag, there are six areas 
where the httpsGetEnabled parameter is set to false. Change each one 
so that the parameter is set to true. For example:

Before:

After:

 <!- Uncomment to enable SSL ->
<!-- endpoint binding="basicHttpBinding" 
bindingConfiguration="BasicHttpBinding_TransportSecurity" 
contract="HP.PC.PCS.ILabService">
<identity><dns value="localhost"/></identity>
</endpoint -->

<!-- Uncomment to enable SSL -->
<endpoint binding="basicHttpBinding" 
bindingConfiguration="BasicHttpBinding_TransportSecurity" 
contract="HP.PC.PCS.ILabService">
<identity><dns value="localhost"/></identity>
</endpoint>

<serviceMetadata httpGetEnabled="true" httpsGetEnabled="false" />

<serviceMetadata httpGetEnabled="true" httpsGetEnabled="true" />
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 3 Add the Performance Center Server to ALM and define the Internal URL 
to connect through port 443. The URL must begin with https.

To support internal communication on a host:

 1 Configure SSL on the host for port 8731. For details, refer to the Microsoft 
Web Site: How To Configure a Port with an SSL Certificate, using the 
following URL: http://msdn.microsoft.com/en-us/library/ms733791.aspx.

 2 Edit the LtopSvc.exe.config file located in the following path: <install 
path>\bin

 a Under the <system.servicemodel><bindings><basicHttpBinding> tag, 
there are two areas where the following comment appears: 
Uncomment to enable SSL. Uncomment the XML lines which appear 
thereafter. For example:

Before:

<binding name="BasicHttpBinding_ILoadTestingService" 
closeTimeout="00:10:00"
             openTimeout="00:01:00" receiveTimeout="00:20:00" 
sendTimeout="00:10:00"
             allowCookies="false" bypassProxyOnLocal="false" 
hostNameComparisonMode="StrongWildcard"
             maxBufferSize="2147483647" maxBufferPoolSize="2147483647" 
maxReceivedMessageSize="2147483647"
             messageEncoding="Text" textEncoding="utf-8" transferMode="Buffered"
             useDefaultWebProxy="true">
          <readerQuotas maxDepth="2147483647" 
maxStringContentLength="2147483647" maxArrayLength="2147483647"
          maxBytesPerRead="2147483647" 
maxNameTableCharCount="2147483647" />
          <!-- Uncomment to enable SSL -->
          <!--<security mode="Transport">
            <transport clientCredentialType="None"/>
          </security>-->
        </binding>
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After:

<binding name="BasicHttpBinding_ILoadTestingService" 
closeTimeout="00:10:00"
             openTimeout="00:01:00" receiveTimeout="00:20:00" 
sendTimeout="00:10:00"
             allowCookies="false" bypassProxyOnLocal="false" 
hostNameComparisonMode="StrongWildcard"
             maxBufferSize="2147483647" maxBufferPoolSize="2147483647" 
maxReceivedMessageSize="2147483647"
             messageEncoding="Text" textEncoding="utf-8" transferMode="Buffered"
             useDefaultWebProxy="true">
          <readerQuotas maxDepth="2147483647" 
maxStringContentLength="2147483647" maxArrayLength="2147483647"
          maxBytesPerRead="2147483647" 
maxNameTableCharCount="2147483647" />
          <!-- Uncomment to enable SSL -->
          <security mode="Transport">
            <transport clientCredentialType="None"/>
          </security>
        </binding>
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 b Under the <system.servicemodel><services> tag, switch between the 
non-secured and secured endpoints and base addresses. For example:

Before:

<endpoint contract="HP.PC.LTOP.Services.ILoadTestingService" 
address="LoadTestingService" name="basicHttp" binding="basicHttpBinding" 
bindingConfiguration="BasicHttpBinding_ILoadTestingService"/>

        <!-- Use the first endpoint for regular communication and the second 
endpoint for SSL -->
        <endpoint contract="IMetadataExchange" binding="mexHttpBinding" 
name="mex" />
        <!--<endpoint contract="IMetadataExchange" binding="mexHttpsBinding" 
name="mex" />-->

        <host>
          <baseAddresses>
            <!-- Use the first address for regular communication and the second 
address for SSL -->
            <add baseAddress="http://localhost:8731/LTOP/LoadTestingService"/>
            <!--<add 
baseAddress="https://localhost:8731/LTOP/LoadTestingService"/>-->
          </baseAddresses>
        </host>
      </service>
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After:

 c Under the 
<system.servicemodel><behaviors><serviceBehaviors><behaviorname
=”CommonBasicHTTPBehavior”> tag, change the httpGetEnabled 
parameter to false, and the httpsGetEnabled parameter to true. For 
example:

Before:

After:

 3 Restart Windows on the host.

<service name="HP.PC.LTOP.Services.LoadTestingService" 
behaviorConfiguration="CommonBasicHTTPBehavior">
        <endpoint contract="HP.PC.LTOP.Services.ILoadTestingService" 
address="LoadTestingService" name="basicHttp" binding="basicHttpBinding" 
bindingConfiguration="BasicHttpBinding_ILoadTestingService"/>

        <!-- Use the first endpoint for regular communication and the second 
endpoint for SSL -->
        <!-- <endpoint contract="IMetadataExchange" binding="mexHttpBinding" 
name="mex" />-->
        <endpoint contract="IMetadataExchange" binding="mexHttpsBinding" 
name="mex" />

        <host>
          <baseAddresses>
            <!-- Use the first address for regular communication and the second 
address for SSL -->
            <!--<add 
baseAddress="http://localhost:8731/LTOP/LoadTestingService"/>-->
            <add baseAddress="https://localhost:8731/LTOP/LoadTestingService"/>
          </baseAddresses>
        </host>
      </service>

<serviceMetadata httpGetEnabled="true" httpsGetEnabled="false" />

<serviceMetadata httpGetEnabled="false" httpsGetEnabled="true" />
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 4 On the Performance Center Server, edit the PCS.config file, located in the 
<install path>\dat path, as follows: Change the value of the ItopIsSecured 
parameter to true. For example:

Before:

After:

 5 Restart IIS on the Performance Center Server.

Working with Performance Center Agent

The Performance Center Agent runs on the Load Generators and enables 
communication between the Controller, Load Generators, and MI Listeners 
(in over firewall configurations). The agent receives instructions from the 
Controller to initialize, run, pause, and stop Vusers. At the same time, the 
agent also relays data on the status of the Vusers back to the Controller. 

To check the agent’s current configuration, move your mouse over the 
Agent’s icon in the Task Bar area, and read the description. The description 
will display either Performance Center Agent Service or 
Performance Center Agent Process.

Running the Performance Center Agent as a Process
In some cases, such as SAPGUI replay, running GUI Vusers on remote 
machines, or terminal sessions, the Performance Center Agent must run as a 
process.

To change the Performance Center Agent from a service to a process:

➤ On the host machine, select Start > Programs > HP Software > HP 
Performance Center Host > Tools > Performance Center Runtime Settings 
Configuration, and select Manual log in to this machine.

<PCSSettings ltopPortNumber="8731" ltopIsSecured="false" 
StartRunMaxRetry="3" DataProcessorPendingTimeoutMinutes="2880"/>

<PCSSettings ltopPortNumber="8731" ltopIsSecured="true" 
StartRunMaxRetry="3" DataProcessorPendingTimeoutMinutes="2880"/>
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Running the Performance Center Agent as a Service
In most cases, the Performance Center Agent runs as a service.

To change the Performance Center Agent from a process to a service:

➤ On the host machine, select Start > Programs > HP Software > HP 
Performance Center Host > Tools > Performance Center Runtime Settings 
Configuration, and select Allow virtual users to run on this machine 
without user login, and enter a valid user name and password.

Configuring the Agent on Load Generator Machines
When working with protocols that use network files or Web protocol Vusers 
that access the Internet through a proxy server, the Load Generator agent 
must have network privileges. Note that the default user created by 
Performance Center, IUSR_METRO, does not have network privileges. 

By default, the agent runs as a service on the Load Generator machines. You 
can either run the agent as a process or you can continue running the agent 
as a service. To continue running it as a service, configure it to run the 
session using the local system account or another user account with 
network access privileges.

Running SAPGUI Vusers
To run SAPGUI Vusers on a remote host, make sure of the following:

➤ The Performance Center agent is configured to run as a process (as 
described in "Running the Performance Center Agent as a Process" on 
page 129).

➤ A user with administrative privileges is logged on to the host machine 
during run-time. 

Mapping Network Drives when Running Agent as Service
For all Windows platforms, when the user is logged off, the service cannot 
resolve the mapping of network drives. For Windows XP, the service also 
cannot resolve the mapping of network drives when the user is logged on. 

In cases when the service cannot work with mapped network drives, use the 
full path to the directory, for example, <\\<machine-name>\<directory>\>.
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Configuration for HP Load Generator (Linux)

You can increase the number of file descriptors, process entries, and amount 
of swap space by configuring the kernel, as described in this section.

This section includes recommendations for improving Load Generator 
performance. This section includes:

➤ "Increasing File Descriptors" on page 131

➤ "Increasing Process Entries" on page 132

➤ "Increasing Swap Space" on page 133

Increasing File Descriptors
A Load Generator uses the following File Descriptor resources:

➤ 14 file descriptors for the launch service

➤ 20 file descriptors for the agent

➤ 30 file descriptors for each Vuser driver. By default, there is a driver for 
every 50 Vusers.

➤ File descriptors for the running Vusers. Each Vuser requires two 
descriptors.

For example, to compute the number of file descriptors used in running 100 
threaded Vusers, the Load Generator requires:

Total: 294 File Descriptors

If Vusers are run as processes instead of threads, one driver is run per Vuser. 
Therefore, each Vuser requires 30 file descriptors.

14 for the launcher

20 for the agent

60 for 2 drivers (30 x 2, each one drives 50 Vusers)

200 for 100 Vusers (each Vuser requires 2)
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The procedure to increase the number of file descriptors differs between 
shells. 

In these examples, the number of descriptors is increased to the maximum 
of 1024.

➤ For sh and ksh users, type:

➤ For csh users type:

The following section describes some alternate procedures to increase file 
descriptors on Linux operating systems. In these examples, the number of 
descriptors is increased to the maximum of 8192. 

To increase file descriptors on Linux operating systems:

 1 Add the following line to the /etc/security/limits.conf file:

 2 Add the following line to the /etc/sysctl.comf file:

 3 Reboot the machine.

Increasing Process Entries 
Each Vuser requires several free process entries. To increase the number of 
process entries on your system, you must reconfigure the kernel. 

This section describes how to reconfigure the kernel for Linux.

 1 Locate the /etc/security/limits.conf file.

 2 Set the maximum number of processes in the limits file. Type:

ulimit -n 1024

limit descriptors 1024

hard nfile 8192

fs.file-max = 8192

hard nproc 8192
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 3 Reboot the machine.

Increasing Swap Space
Each Vuser requires swap space ranging from 200 KB to 4 MB. Before adding 
space to your system configuration, you should determine your paging 
requirements. For environments running programs with very large memory 
requirements, it is recommended to have paging space of four times the 
physical memory. If you do not have enough paging space, certain processes 
may be killed, and others will be unable to start.

Establishing Connectivity with Oracle

When working with Oracle, ensure that the Oracle client is installed on the 
same machine as the Performance Center Server and that connectivity is 
established with the Oracle Server. 

The tnsnames.ora file located on the Performance Center Server (for 
example: ..\oracle\product\10.2.0\client_1\NETWORK\ADMIN\
tnsnames.ora) must contain a TNS entry for the source and target database 
servers. This entry can be copied from the tnsnames.ora file on the Oracle 
server to the Oracle client machine. 

For example, for the Oracle database instance, ALMInst, the tnsnames.ora 
file, should contain the following entry:

To test that the TNS name entry is properly configured:

 1 On the Performance Center Server machine, open a command prompt.

ALMInst =
  (DESCRIPTION =
    (ADDRESS_LIST =
      (ADDRESS = (PROTOCOL = TCP)(HOST = <db_host>)(PORT = 1521))
    )
    (CONNECT_DATA =
      (SERVICE_NAME = ALMInst)
    )
  )t
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 2 Type:

where <instancename> is the name of the current instance. 

 3 Verify that you are successfully connected to the Oracle server.

Enabling Downloading Standalone Applications

This section explains the steps necessary to enable you to download 
standalone applications from the Download Applications window. 

Note: To access the Download Applications window, in Lab Management or 
in the ALM project, select Tools > Download Standalone Applications. 

To enable downloading standalone applications:

 1 Insert the HP ALM Performance Center Additional Components 
installation disk (DVD 2) and navigate to the Additional Components 
directory. This directory contains the applications’ execution (.exe) files. 

Note: The necessary .exe files for downloading VuGen, Analysis, 
Snapshot Viewer, Standalone Load Generator, Monitor over Firewall, and 
MI Listener, are located in the Applications directory, which is contained 
within the Additional Components directory.

 2 On the Performance Center server, navigate to the Downloads directory, 
which is located in C:\Program files\HP\Performance Center 
Server\PCWEB\Downloads.

sqlplus <user/password>@<instancename>
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 3 To enable downloading an application, copy the relevant execution file 
(.exe) from the Additional Components directory on the DVD to the 
Downloads directory on the Performance Center server.

Note: You may need to refresh the Download Applications window for 
the changes to take effect.
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Customizing the Download Applications Window
You can edit and customize the appearance of the Downloads Applications 
window. To customize the window, edit the downloads.xml file located in 
the Downloads directory on the Performance Center server.

The following tags in the downloads file control the following features on 
the window. Edit the tags as desired to change the appearance of the 
window.

➤ App Name. The name of the application.

➤ Image. Whether the application’s icon appears to the left or to the right 
of the name.

➤ File Name. If you changed the name of the application’s execution file, 
you must update this section so that it matches the new name of the 
execution file.

➤ Description. The application’s description.



Chapter 4 • Performance Center Configuration Options

137

Enabling MS-SQL Windows Authentication

This section describes how to configure an MS-SQL database with Windows 
authentication.

Note: The procedure below requires you to make changes to the MS-SQL 
database. It is strongly recommended that you make these changes using 
the SQL Server Management Studio tool.

To enable Windows authentication:

 1 Verify that the Performance Center Server, ALM Server, and database 
server, all belong to the same domain, and that there is a domain user 
with administrator privileges common to all the machines.

 2 Change users to domain users using the System Identity Utility. For more 
information, see the “Performance Center System Administration” 
chapter in the HP ALM Performance Center Guide.

 3 Download the SQL Server Management Studio tool from the Microsoft 
Download Center (http://www.microsoft.com/downloads/en/default.aspx).

 4 In SQL Server Management Studio, perform the following actions:

 a In the Object Explorer pane, expand the Security folder.

 b Right-click Logins and select New Login.

 c Enter the domain user in the Login name box, and make sure that 
Windows Authentication is selected.

Note: Verify that the domain user is assigned the same Server Roles as 
the database administrative user (td_db_admin).

 5 Make sure that the relevant project is created in Site Administration with 
the MS-SQL (Win Auth) database type. For more information, see the 
“Configuring Servers and Parameters” chapter in the HP Application 
Lifecycle Management Administrator Guide.
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5 
Working with Previously Created Projects

This chapter provides instructions for working with previously created 
projects.

This chapter includes:

➤ About Working with Previously Created Projects on page 142

➤ The Migration Process: Basic Steps on page 143

➤ Pre-Migration Preparation and Considerations on page 144

➤ Backing Up Performance Center Data on page 146

➤ Uninstalling Earlier Versions of Performance Center on page 147

➤ Installing and Configuring the Latest Version of Performance Center 
on page 150

➤ Verifying Successful Installation on page 150

➤ Migrating Performance Center Data on page 150

➤ Post-Migration Verification on page 177

➤ Post Migration Considerations on page 179



Chapter 5 • Working with Previously Created Projects

142

About Working with Previously Created Projects

To work with a project from a previous version, you may need to upgrade or 
migrate your project to HP ALM Performance Center 11.52. The following 
table describes the process required for working with a previously created 
project.

From Version To ALM Performance Center 11.52

Performance Center 11.50 Upgrade to Performance Center 11.52. For details, 
see the “Upgrading Projects to a New Version” 
chapter in the HP Application Lifecycle Management 
Administrator Guide

Performance Center 11.00 Upgrade to Performance Center 11.52. For details, 
see:

➤ the upgrade section in the HP Application Lifecycle 
Management Installation and Upgrade Guide

➤ the “Upgrading Projects to a New Version” 
chapter in the HP Application Lifecycle Management 
Administrator Guide

Performance Center 9.51 Migrate to Performance Center 11.52. For details, see 
"The Migration Process: Basic Steps" on page 143.

Performance Center 9.5 
and earlier

1  Migrate to Performance Center 9.51. 

2  Migrate to Performance Center 11.52. 

For details, see "The Migration Process: Basic Steps" 
on page 143.
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The Migration Process: Basic Steps

This section provides a general outline of the steps that you need to carry 
out to migrate your current version of Performance Center (versions 8.1 to 
9.51) to HP ALM Performance Center 11.52. 

Note: If you are currently working with Performance Center 11.00, you will 
need to upgrade to Performance Center 11.52. For details, see the 
HP Application Lifecycle Management Installation and Upgrade Guide and the 
HP Application Lifecycle Management Administrator Guide.

To migrate to Performance Center 11.52:

 1 Review the process required for working with a previously created 
project.

For details, see "About Working with Previously Created Projects" on 
page 142.

 2 Prepare your system for the migration process.

For details, see "Pre-Migration Preparation and Considerations" on 
page 144.

 3 Back up Performance Center data.

For details, see "Backing Up Performance Center Data" on page 146.

 4 Uninstall the current version of Performance Center.

This step is relevant only when migrating on a production environment. 
When migrating on a staging environment do not uninstall or clean any 
of the machines in your current environment.

For details, see "Uninstalling Earlier Versions of Performance Center" on 
page 147.

 5 Install and Configure the latest version of Performance Center.

For details, see "Installing and Configuring the Latest Version of 
Performance Center" on page 150.
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 6 Verify that the ALM Performance Center environment was installed 
correctly.

For details, see "Verifying Successful Installation" on page 150.

 7 Migrate the data.

Use the Performance Center Migration tool to migrate your 
Performance Center data to HP Performance Center 11.52. 

Performance Center 9.5 and earlier: If you are migrating from 
Performance Center version 8.1 through Performance Center 
version 9.50, you must first run the Performance Center 9.51 Migration 
Tool. This tool is located in a subdirectory of the 
ALM Performance Center 11.52 Migration Tool installation directory 
(..\ALM Migration\DBMigrationTool95\DBMigration95_SP1.exe).

For details, see "Migrating Performance Center Data" on page 150.

 8 Verify that the data was migrated successfully.

For details, see "Post-Migration Verification" on page 177 and "Post 
Migration Considerations" on page 179.

Pre-Migration Preparation and Considerations

Before you start migrating to HP ALM Performance Center 11.52:

➤ Estimate how long the installation, configuration, and the migration 
process will take and ensure that no timeslots are reserved from the 
time you start the migration process until you expect it to be complete. 

For example, if you start the migration process today, and expect it to 
take 2 days, ensure that there are no timeslots reserved for the next 2 
days. 
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➤ Ensure that there are no tests with any of the following run states:

➤ Ready

➤ Collating Results

➤ Running

➤ Stopping

➤ Creating Analysis Data

➤ Deleting Temporary Results

If there are runs in any of these states, make sure that the current 
operation finishes before you start the migration process.

To check the run state of the test, do one of the following:

➤ Check in the Performance Center Administration Site, on the Test 
Runs page (Site Management > Test Runs)

➤ Run the following query on the Performance Center source 
database: 

➤ Some tests may have finished running but may still be in the Before 
Collating or Before Analyzing state. To avoid losing data from these 
runs, you must collate and analyze the run results before performing 
the migration.

➤ Ensure that all host machines configured in the Administration Site 
actually exist. If a host does not exist, is turned off, or does not have a 
network connection, you must delete it from the Administration Site 
resources to prevent configuration problems later on.

➤ To avoid file server and database conflicts, stop IIS on all 
Performance Center Web server machines before backing up the data.

SELECT * FROM SessionRuns WHERE State in (1,2,3,7,8,13)
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Backing Up Performance Center Data

Before performing database migration you must back up your current 
Performance Center data. 

Note: Make sure that the file system backup is synchronized with the 
database backup. To avoid file server and database conflicts, we recommend 
stopping IIS on all Performance Center Web server machines before backing 
up the data.

This section includes:

➤ "Backing Up Host Data" on page 146

➤ "Backing Up the File System" on page 146

➤ "Backing Up the MI_LRDB Database" on page 147

Backing Up Host Data
To avoid data loss from test runs that have not yet been collated or analyzed, 
perform the following steps before you start migrating the system and data:

➤ Collate and analyze results from the load test runs on the User Site.

➤ Delete all unnecessary runs.

➤ Back up the Temp and orchidtmp directories on each host machine. To 
locate a machine’s Temp directory, open Windows Explorer, type %temp% 
in the address bar, and press Enter. To locate the orchidtmp directory, 
navigate to <Performance Center directory>\orchidtmp.

Backing Up the File System
Before migrating the Performance Center file system, you must back up the 
user data folders to protect your data in case of migration error.

 1 On the File Server machine, open the <Performance Center 
directory>\LRFS directory.

 2 Create a backup copy of the entire LRFS directory on a separate machine. 
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Note: After the file system data is backed up, this data becomes the source 
data for migration, and you should not continue working on your current 
version of Performance Center. 

In addition, we strongly recommend that you copy the backed up LRFS 
directory to a location on the ALM server repository machine. This 
backed up copy is later used for migration.

Backing Up the MI_LRDB Database
Before performing database migration, you must create a database backup to 
protect your data in case of migration error. 

For details about backing up and restoring your database, refer to the 
HP ALM Database Best Practices Guide.

Uninstalling Earlier Versions of Performance Center

After backing up relevant data, you need to uninstall earlier versions of 
Performance Center and clean the machines.

Note: We support uninstallation of host machines only. We strongly 
recommend installing the Performance Center Server and other 
Performance Center components on clean machines with a new image.

To uninstall Performance Center:

 1 From the Windows Control Panel, open the Add/Remove Programs dialog 
box. 

 2 Select HP Performance Center from the list of currently installed 
programs and click Remove. 
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 3 Follow the instructions in the wizard to complete the uninstall process.

 4 Reboot the machine.

To clean Performance Center machines:

 1 Ensure that you have backed up the relevant Performance Center 
subdirectories. For details, see "Backing Up Performance Center Data" on 
page 146.

 2 Delete the Performance Center directory.

 3 Ensure that the virtual directories were deleted. If they were not removed 
automatically, delete them manually as follows:

➤ On the User Site machine, in IIS:

➤ Under Default Web Site, delete the Loadtest virtual directory.

➤ Open the Default Web Site Properties window. In the ISAPI Filters 
tab, ensure that there are no filters. If there are filters, remove them.

➤ On the Administration Site machine, in IIS, delete the Admin virtual 
directory, located under Default Web Site.

➤ If you are uninstalling Performance Center 9.0: On all 
Performance Center machines, in IIS, delete the PCWSApplicationPool 
virtual directory, located under Application Pools.

 4 Delete the IUSR_METRO user and the crypto key from the Crypto 
directory: Delete the files starting with 
f9416f003254e6f10da1fbad8e4c383_ from C:\Documents and 
Settings\All Users\Application 
Data\Microsoft\Crypto\RSA\MachineKeys

 5 Delete cookies and temporary internet files from your browser to avoid 
user interface problems (Tools > Internet Options > General tab).

 6 If you are uninstalling Performance Center 8.1: Remove the 
Performance Center folder from the Start menu. To do this, right-click 
Start and select Explore All Users. The Start Menu folder opens. Double-
click the Programs folder, and delete the Performance Center folder. 
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 7 If you are uninstalling Performance Center 8.1: Clean the environment 
variables.

➤ On all Performance Center machines: From the path system variable, 
delete the following paths: (These are paths that include the old 
Performance Center installation folder.)

➤ <Old PC Installation folder>\java\J-INTE~1\com\bin

➤ <Old PC Installation folder>\DbSetup

➤ <Old PC Installation folder>\bin

Note: Some of the above paths may not exist on all of the 
Performance Center machines.

To edit the path system variable, right-click My Computer and select 
Properties. In the Advanced tab, click Environment Variables to open 
the Environment Variables dialog box. In the System Variables area, 
select the Path variable and click Edit.

➤ On the User Site server only: Delete the following Environment 
variables:

➤ CATALINA_HOME

➤ CLASSPATH

➤ JAVA_HOME

➤ JINTEGRA_HOME

 8 Reboot the machine.
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Installing and Configuring the Latest Version
of Performance Center

After you have backed up your Performance Center data, and cleaned your 
machines, install and configure the latest version of ALM 
Performance Center. 

For details on installing and configuring ALM Performance Center, see 
Chapter 2, "Installing HP ALM Performance Center."

Verifying Successful Installation

After you have installed and configured the latest version of ALM 
Performance Center, and before you start migrating data from your previous 
version of Performance Center to the new production environment, create a 
staging environment and verify that the components were installed 
successfully. For details, see Chapter 3, "Post Installation Verification."

Migrating Performance Center Data

This section explains how to migrate the Performance Center file system 
and database (versions 8.1, 9.0, 9.5, and 9.51) to the latest version of ALM 
Performance Center.

This section includes:

➤ "Pre-Migration Considerations" on page 151

➤ "Copying and Restoring Backed Up Data" on page 151

➤ "Configuring the ALM Repository on a Linux system" on page 151

➤ "Performing the Migration" on page 157
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Pre-Migration Considerations
During the migration of the Performance Center source database, a data 
migration report and other tables are created and added to the source 
database. Check the disk space on the source database server to ensure that 
it can accommodate these extra tables.

Note: No users should be logged in to the system while the migration 
process is running.

Copying and Restoring Backed Up Data

➤ If you backed up the host data (see "Backing Up Host Data" on page 146), 
you need to restore the orchidtmp and temp directories. To restore these 
directories, copy orchidtmp to the new installation directory (for 
example, C:\Program Files\HP\Performance Center Host\orchidtmp), and 
copy the temp directory to its original location on the host machines.

➤ To maximize performance during the migration process, copy the file 
system directory (LRFS) that you saved on a separate machine (see 
"Backing Up the File System" on page 146) to a directory on the same 
machine as the ALM server repository. 

➤ Copy the backed up database (MI_LRDB) on the database server that is to 
act as your source database server, and restore the database. For details 
about restoring your database, refer the HP ALM Database Best Practices 
Guide.

Configuring the ALM Repository on a Linux system
If ALM is installed on a Linux system, you must configure the ALM server 
repository before migrating your Performance Center database and file 
system.

To configure the ALM server repository:

 1 Log in to your ALM server repository machine.

 2 Make sure Samba is installed on the machine.
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 3 Configure the following Samba files:

Note: Separate the domain and user names with a slash '/', for example: 
DOMAIN/username. 

 a Edit the following file: /etc/samba/smb.conf

➤ Under the [global] section, set the following attributes:

➤ Add the following section at the end of the file:

workgroup = <domain name> 
password server = <domain controller>
realm = <domain name>

[slesh]
path = /
write list = user (For example: qcuser)
browseable = yes
writable = yes
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 b Create the file /etc/samba/smbusers.map with the following data:

 c Edit the following file: /etc/krb5.conf 

➤ Under the [libdefaults] section, set the following attribute:

➤ Under the [realms] section, set the following:

root = administrator admin <username> <domain name>/<user name> 
<domain>/<admin user on this domain>

default_realm = <domain name>

<domain name> = {
kdc = <server name> 
admin_server = <server name>
}
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➤ Under the [domain_realm] section, set the following attributes:

 d Run the following command:

.<full domain name> = <domain name>

.<domain name> = <domain name>
<full domain name> = <domain name>

net ads join -U <administrator username on the domain>
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 e Edit the following file: /etc/nsswitch.conf

Add the winbind option:

passwd: files nis winbind
shadow: files nis winbind
group: files nis winbind
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 f Run the following commands:

 g Verify successful configuration.

From a Windows machine, check that you can navigate to the ALM 
server repository using the UNC path and the domain user you 
defined. For example, 
\\<ALM server name>\slesh\var\opt\HP\ALM\repository.

You can now migrate your Performance Center data using the HP ALM 
Performance Center Migration tool. When prompted enter the same 
repository path as above.

/etc/init.d/winbind start
/etc/init.d/smb start
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Performing the Migration
This section describes how to install and run the HP ALM 
Performance Center Migration tool to migrate your Performance Center 
database and file system to the ALM database and repository.

Note: We recommend that you install and run the migration tool on the 
machine where the Performance Center Server is installed because the 
prerequisite software needed to run this tool is already installed on this 
machine.

To migrate the data:

 1 Install the prerequisite software.

Tip: If you are performing the migration from the Performance Center 
Server machine, skip this step as the prerequisite software is already 
installed on this machine.

Ensure that the following prerequisite software has been installed on the 
machine on which you are going to install the migration tool: 

➤ .NET Framework 4.0.

➤ Oracle client: If you are working with an Oracle database, ensure that 
the Oracle client is installed, and that connectivity has been 
established with the Oracle Server. Ensure that the tnsnames.ora file 
contains a TNS entry for the source and target database servers.

Note: You must install the 32-bit Oracle client installation, regardless 
of whether you are running the Performance Center Server on a 32-bit 
or 64-bit operating system.

 2 Access the Migration Tool.

From the latest HP ALM Performance Center Migration patch, launch 
MigrationToolSetup.exe from ..\Setup\Install\ALM Migration\Setup.
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 a The HP ALM Performance Center 11.52 Migration Tool wizard opens 
on the Welcome page. Click Next.

 b Select an installation location. If ALM is installed on an Oracle 
database, in the Destination Folder box, change the default 
installation location to a valid path. The path cannot contain special 
characters.

For example, the following path is invalid because it contains 
parentheses: C:\Program Files (x86)\HP\ALM Migration.

 c Click Next. The Confirm Installation page opens.

 d Click Next to start the installation process. 

 e When the installation completes, click the View Summary button to 
check for errors. 

 f Click Finish to close the wizard. The MigrationToolStart.exe shortcut as 
added to your desktop.

 3 Launch the ALM Performance Center 11.52 Migration Tool wizard.

Performance Center 9.5 and earlier: If you are migrating from 
Performance Center version 8.1 through Performance Center 
version 9.50, you must first run the Performance Center 9.51 Migration 
Tool. This tool is located in a subdirectory of the 
ALM Performance Center 11.52 Migration Tool installation directory 
(..\ALM Migration\DBMigrationTool95\DBMigration95_SP1.exe).

Double-click the MigrationToolStart.exe shortcut on the desktop. 
Alternatively, navigate to the location where you installed the Migration 
tool, and run MigrationToolStart.exe. The ALM Performance Center 
11.52 Migration Tool wizard opens on the Welcome page. Click Next.
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 4 Provide the details of the source database.

On the HP Performance Center Source Details - Source Database page, 
enter the details of the HP Performance Center Database Server that 
contains the source database.

➤ Database Type. Select the type of source database: Oracle or MS-SQL.

Note: You can migrate one type of database to another. That is, if the 
source Performance Center database is MS-SQL, you can migrate it to a 
target Oracle database in ALM; if the source Performance Center 
database is Oracle, you can migrate it to a target MS-SQL database in 
ALM. It is recommended to migrate all projects to the same database or 
server on which the Lab project is located.
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➤ Database Server. (MS-SQL only) Enter the path and name of the source 
database server. 

Tip: Click the Browse button to browse to a server instance where the 
database is installed.

➤ Authentication type. (MS-SQL only) Enter the method used to connect 
to the database: SQL Server Authentication or Windows 
Authentication.

➤ SID. (Oracle only) Enter the Service ID of the source database server as 
defined in the tnsnames.ora file.

➤ Username and Password. Enter the user name and password:

➤ For Oracle: Enter the Performance Center database user (DB Name), 
for example, MI_LRDB, and its password. 

➤ For MS-SQL: Enter the user name and password of the 
Performance Center database administrator user. When running the 
migration tool, always use the same database administrator user.

➤ Database Name. (MS-SQL only) Enter the name of the source database 
schema. By default, the schema name is MI_LRDB.

Click Test Connection to verify that you can connect to the source 
database. If the connection fails, a message displays the possible reasons. 
In this case, verify that the details you provided are correct and that the 
database server is up and running. 

Click Next.
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 5 Provide the details of the source file system.

On the HP Performance Center Source Details - Source File System (LRFS) 
page, enter the details of the directory containing the backed up 
Performance Center source file system (LRFS).

Tip: To avoid network traffic delays and for a more reliable migration, it is 
strongly recommended to save a copy of this directory in a location on 
the same machine and parallel to the ALM server repository.
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➤ File System Path. Enter the path and name of the backed up copy of 
the source file system (LRFS) that you saved on the same machine as 
the ALM server repository.

➤ Username and Password. Enter the user name and password of a user 
with file system administration privileges on the backed up copy of the 
source file system (LRFS).

➤ Domain. Enter the domain in which the backed up copy of the source 
file system is located.

Click Test Connection to verify that you can connect to the backed up 
copy of the source file system. If the connection fails, a message displays 
possible reasons for the failure. In this case, verify that the details you 
provided are correct. 

Click Next.
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 6 Provide ALM credentials.

On the HP ALM Target Details - Site Administration Details page, enter 
ALM Server details, and the credentials of the user with ALM 
administrative privileges.

➤ ALM Platform URL. Enter the URL of the ALM server in the following 
format: 

For example, http://alm_server139:8080/qcbin.

➤ Username and Password. Enter the Site Administrator user name and 
password, as defined when installing ALM.

http://<ALM server name><:port number>/qcbin
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➤ Communication Security Passphrase. Enter the passphrase used for 
secure communication with ALM, as defined when installing ALM. To 
get this value, open Site Administration and click the Site 
Configuration tab. See the 
COMMUNICATION_SECURITY_PASSPHRASE parameter.

Click Test Connection to verify connectivity with ALM. If connectivity 
fails, a message displays possible reasons for the failure. In this case, verify 
that the details you provided are correct. 

Click Next.

 7 Provide the details of the target database.

On the HP ALM Target Details - Target Database page, enter the details of 
the ALM database server to which the source database is to be migrated.

Note: If you are performing the migration from a remote location: 

➤ If you are migrating to an MS-SQL database, ensure that the MS-SQL 
Server name defined when configuring ALM is not localhost or 
localhost\SQLSERVER, and that its name is a full host machine name, 
for example, DbServerMachine23.domain.it. 

➤ If you are migrating to an Oracle database, the client configuration file 
(tnsnames.ora) must include a servicename section that is exactly the 
same as the servicename section located on the ALM client 
configuration. Click the Server Details button on the HP ALM Target 
Details - Target Database page to view the SID that must be used.
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➤ Database Server. From the dropdown list, select a target ALM database 
server, as defined in ALM. Make sure to select the same database server 
on which the SA schema and Lab project are located.

Click the Server Details button to view the full details of the server.

Note: You can migrate one type of database to another. That is, if the 
source Performance Center database is MS-SQL, you can migrate it to a 
target Oracle database in ALM; if the source Performance Center 
database is Oracle, you can migrate it to a target MS-SQL database in 
ALM.

➤ DB Username and DB Password. Enter the password of the database 
administrator user.

➤ Server Name (Oracle only). The SID defined in the Server Details.



Chapter 5 • Working with Previously Created Projects

166

➤ Tablespace and Temp Tablespace (Oracle only). The tablespaces to 
which the projects are migrated. Verify that the tables have enough 
space to accommodate your migration content. The minimum free 
space required is 2 GB, for an empty project you need ~ 150 MB. 

Click Test Connection to verify that you can connect to the database 
server. If the connection fails, a message displays possible reasons for the 
failure. In this case, verify that the details you provided are correct and 
that the database server is up and running. 

Click Next.

 8 Provide the details of the target file system directory.

On the HP ALM Target Details - Target File System (Repository) page, enter 
the details of the ALM server repository. The data in the 
Performance Center source file system directory (LRFS) is migrated to this 
repository.
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➤ Operating System. Select Windows or UNIX.

➤ File System Path. The path to the ALM server repository. The source 
file system (LRFS) will be migrated to this repository. This value is read-
only and is taken directly from the ALM.

➤ Username and Password. Enter the user name and password of the 
user with file system administration privileges on the ALM server 
repository. To use the same user as the source file system directory 
(LRFS) user, select Use the same user credentials as the PC FS.

➤ Domain. Enter the user domain.

Click Test Connection to verify that you can connect to the ALM server 
repository. If the connection fails, a message displays possible reasons for 
the failure. In this case, verify that the details you provided are correct. 

Click Next.
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 9 View the migration validation.

With all the relevant source and target details, the tool validates the 
feasibility of the migration. Review the list of warnings and errors. If you 
need to make any changes before you migrate the data, close the 
migration tool, and start the tool again when you are ready.

Note: If Lab Management Connection fails, open your web browser and 
type your ALM URL http://<ALM Platform server name>[<:port 
number>]/qcbin. Click the Application Lifecycle Management link. Follow 
the security steps required for downloading the ALM client.

To continue, click Next.
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 10 Specify whether to migrate administration data.

The Data Selection - Migrate Administration Data page opens. 

➤ To migrate all of the data from the Performance Center Administration 
site, such as Performance Center resources (hosts, host pools, 
locations, MI Listeners), user-project assignments, and server data, 
select Migrate Lab Project Data.

If you are running the migration tool to migrate additional projects 
only, but you do not want to migrate the administration data again, 
ensure that Migrate Lab Project Data is NOT selected.
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Note: The first time you run the Migration Tool, the Migrate Lab 
Project Data option is selected by default, and the Performance Center 
administration data is migrated the first time by default. In subsequent 
migrations, you can select whether to migrate the administration data. 
It is important to note that when you migrate the administration data 
again, all Performance Center administration data and other 
Performance Center projects that have already been migrated are 
deleted. For this reason, it is strongly recommended to ensure that the 
migration process is fully complete before working with new data and 
projects in ALM Performance Center 11.52.

➤ HP ALM Platform Domain. Enter the name of the ALM domain to 
which to migrate the projects that you select in the next wizard page. 
You can enter the name of an existing domain, or enter a new domain 
name. If you enter a new domain name, the domain is created on the 
ALM server.

Note: When entering the name of an existing domain, if the domain 
contains projects with the same name as the ones you are about to 
migrate, they will be deleted. New projects with migrated data will be 
created instead.

Note: Administration data is always migrated to the LAB_PROJECT, 
which is located on the default domain.

Click Next.
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 11 Select Performance Center projects to migrate.

On the Data Selection - Select Projects to Migrate page, select the 
Performance Center projects to migrate. You must select at least one 
project. 

To select all of the projects, click the Select All button.

Projects that have already been migrated are marked Migrated in the 
Project Migration Status column. If you select a project that has already 
been migrated, the project is deleted from ALM before it is migrated 
again.

Tip: You can sort by double-clicking on any column header.
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Note: If you are running the migration tool only to migrate additional 
projects, but you do not want to migrate the administration data again, 
ensure that the Migrate Lab Project Data option on the previous wizard 
page is NOT selected.

Click Next.

 12 Confirm the migration.

The Confirm Migration page opens, displaying a summary of the options 
you selected in the preceding steps.

Click Next.
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 13 Delete existing projects with the same name.

If a project already exists in the ALM 11.52 target domain with the same 
name, the Delete Projects dialog box opens.

➤ To delete the existing projects and continue the migration process, 
click OK.

➤ If the deletion fails, click OK to close the Delete Projects dialog box and 
repeat steps 12 - 13. 

Alternatively, you can delete the project from Site Administration. For 
more details, see the HP Application Lifecycle Management Administrator 
Guide. 

 14 Track the migration progress.

On the Migration Progress page, you can track the migration progress.

In addition, for each project, you can view the migration progress of 
project entities such as scripts, load tests, monitors, timeslots, and so on.
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 15 View the migration report.

Note: After the migration, you are prompted to restart ALM before 
starting to work in ALM Performance Center. 

To restart the machine do one of the following:

➤ Reboot the machine 

➤ Go to services (services.msc), restart the HP Application Lifecycle 
Management service.

➤ From the Windows icon tray, stop and start ALM.

When the migration is complete, the Migrate Report page opens. The 
report displays the migration results for each project, including warnings 
and errors.

Note: The report may take several minutes to generate.
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You can generate the following filtered reports: 

➤ A summary for each migrated project

➤ Errors only (per project)

➤ Warnings only (per project)

You can also select to view data from all migration procedures performed 
on the machine, or only from the latest migration.

To save the report, click the Save button, and select a location to save the 
report.

If necessary, the report data can also be accessed from the source 
Performance Center database, from the EntityMappings table that is 
created and updated during migration.
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To access the report, run the following SQL query:

Click Finish to exit the HP ALM Performance Center Migration tool.

If you did not save the migration report, you are prompted to save it 
before closing the wizard.

 16 Reconfigure the Performance Center hosts.

Note: If you did not yet restart ALM after the migration, it is 
recommended to do so before continuing with this step. See step 15 on 
page 174.

After migration, the status of all migrated hosts is Unavailable.

For staging environment: Keep the migrated hosts in the Unavailable 
status, and add several new hosts to validate your environment.

For production environment: To change the status of the hosts after 
migration to Operational and set up the host license, you must 
reconfigure the hosts. 

 a Log in to Lab Management. 

 b Select Lab Resources > Hosts, select the migrated host, and click the 
Reconfigure Hosts button.

 17 Verify the migration.

After migrating the file system and database, verify that the data was 
migrated successfully. For details, see "Post-Migration Verification" on 
page 177.

select * from EntityMappings
order by CompanyID, EntityType,PCID
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Post-Migration Verification

After migrating the files and database, verify that the data was migrated 
successfully.

Note: Ensure that the hosts were reconfigured as described at the end of the 
migration process. For details, see step 16 on page 176.

Site Administration

 1 Log in to Site Administration as Site Administrator.

 2 Check that the domain you created during migration exists and that the 
projects you selected are listed in the domain and are active.

 3 Choose two projects and check that the correct users are assigned to the 
projects.

 4 In the Lab Management tab, check that assigned users are the same as 
source Performance Center administrators.

Lab Management

 1 Log in to Lab Management with your Performance Center administrator 
credentials.

 2 Verify the following:

➤ On the Lab Management sidebar, under Lab Settings, select Project 
Settings, and verify that the migrated projects are listed and that the 
Pool and Vuser Limit, Concurrent Run Limit, and Host Limit details are 
correct.

➤ On the Lab Management sidebar, under Lab Resources, verify that the 
correct data exists in Hosts, Pools, Locations, and Timeslots (a month’s 
worth of past timeslots and, if relevant, existing future timeslots). 

➤ On the Lab Management sidebar, under Performance Center, verify 
that the correct data exists in PC Test Runs (runs from the last month), 
Usage Reports (reports for the last month), MI Listeners, and 
Diagnostics. 
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HP Application Lifecycle Management

 1 Log in to a migrated project in ALM, using your Performance Center 
administrator credentials.

 2 Verify the following:

➤ On the ALM sidebar, under Lab Resources, verify that the Testing 
Hosts module contains the hosts that belong to the project you are 
logged in to.

➤ On the ALM sidebar, under Testing, select Test Resources, and review 
the monitor profiles listed in the tree. Verify the details and monitor 
configuration for a familiar monitor profile.

➤ On the ALM sidebar, under Testing, select Test Plan. 

➤ Review the full tree for scripts and performance tests. Check also for 
failed performance tests, if you know of any that exist.

➤ Review one familiar VuGen script - Details and Test Script tabs. 

➤ Review one test in the project that you are familiar with. Click the 
Test Design tab and check the details in the General Details section. 
Verify that there are no errors. 

Click Edit Test. In the Workload tab, verify that the Controller, load 
generator distribution method, Vuser groups, runtime settings, and 
test schedule details are all correct. Check also that the monitor 
profiles selected in the Monitors tab are correct. 

➤ On the ALM sidebar, under Testing, select Test Lab. Review the data in 
the Test Runs tab. If you do not see any data, ensure that the filter is 
clear.

 3 Try to run a familiar test with its original hosts. Ensure that the hosts have 
been migrated to Performance Center 11.52 hosts.
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Post Migration Considerations

This section points out issues to consider after migration.

This section includes:

➤ "User Migration" on page 179

➤ "Roles (Groups) Migration" on page 180

➤ "Project Migration" on page 183

➤ "Host and Pool Migration" on page 184

➤ "Load Test Migration" on page 184

➤ "Timeslot Migration" on page 185

➤ "Script Migration" on page 186

➤ "General Notes" on page 186

User Migration

Deleted / Non-Active / 
Expired users in 
Performance Center

➤ Shown in entities - Timeslots (Reserved By), Test 
Runs (User Name), Event Log (not relevant, not 
migrated), Trend Reports - Run By

➤ Shown in Lab Usage reports - Site Users Report, 
Resource by Duration Report, Resource by Runs 
Report in the Resource Usage by User tab

Migrating deleted users 
(may have the same name 
as existing users)

➤ This type of user does not exist in ALM.

➤ Deleted users are not migrated.
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Roles (Groups) Migration

➤ Canned group migration

Migrating Non-Active / 
Expired users:

➤ Non-Active or Expired Users - 

➤ Migrates the user and assigns it the groups and 
project.

➤ Non-active users are migrated as Expired

➤ Users with future expiration date are migrated as 
explained above and assigned the appropriate 
expiration date.

User name issues ➤ If a user name contains invalid characters, all 
invalid characters are replaced with an 
underscore (_). For details on invalid characters, 
see "General Notes" on page 186.

➤ If ALM contains the same user name as in the 
migrated Performance Center project:

➤ If both user definitions contain an email 
address, and the email address is identical, this 
indicates that this is the same user, and the 
user is not migrated.

➤ If both user definitions contain a full name 
and they are identical, this indicates that this 
is the same user, and the user is not migrated.

➤ If there is a user in the ALM target system with 
the same user name, and it has been 
established that the two users are not the same 
user, then the new (migrated) user is created 
with a 01 (02, 03, ...) suffix appended.

PC 9.5 PC 11.52

Admin 
Site

Administrator Lab 
Management

TDAdmin 

(existing ALM group)

User Site Guest Project Viewer 

(existing ALM group)
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➤ Roles marked as Administration from User site only are not migrated, and 
users who belongs only to such roles in the scope of Performance Center 
are not added to Lab Management.

➤ Customized Groups migration

➤ A Performance Center Template project is created which includes all 
the customized groups from the source Performance Center system.

➤ Enabling the Performance Center extension on a project adds the 
canned Performance Center groups to the project.

➤ Migrated projects will be attached to a Performance Center Template 
project that will include all the customized groups defined in 
Performance Center 9.x.

User Site LT Adviser Project Performance Adviser 

(new ALM group, 
customized when 
Performance Center 
extension is deployed)

User Site Tester Project Performance Tester

(new ALM group, 
customized when 
Performance Center 
extension is deployed)

User Site Power Tester Project Performance Test Specialist

(new ALM group, 
customized when 
Performance Center 
extension is deployed)

User Site Project 
Manager 

Project Project Manager

(existing ALM group)

PC 9.5 PC 11.52
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➤ ALM Consolidated installation:

Performance
Center

Consolidated 
Installation

Flow

Internal Internal ➤ Define match - Username, Full Name 
(optional)

➤ Create unmatched users in ALM (with 
password) 

Internal LDAP ➤ Define match – Username

➤ Create unmatched users in ALM (no 
password)

➤ New users in ALM require LDAP lookup  
on the first login (no DN in ALM)

LDAP Internal ➤ Define match – Username

➤ Create unmatched users in ALM (default 
password – Welcome) 

LDAP LDAP ➤ Define match – Username

➤ Create unmatched users in ALM (no 
password) 

➤ New user in ALM will require LDAP 
lookup on the first login (no DN in 
ALM) 

SSO Internal ➤ Define match – Username

➤ Create unmatched users in ALM (default 
password – Welcome) 

SSO LDAP ➤ Define match – Username

➤ Create unmatched users in ALM (no 
password) 

➤ New users in ALM require LDAP lookup 
on the first login (no DN in ALM) 
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➤ Validation stage messages regarding authentication:

➤ If Performance Center 9.5x uses SSO, then warns that ALM does not 
support SSO.

➤ If Performance Center 9.5x uses LDAP or SSO and ALM is not LDAP, 
then warns that the user should configure LDAP in ALM before 
migration. If LDAP is not configured, all user passwords are reset to 
Welcome1.

Project Migration

Performance Center 
project expiration date

➤ If the Performance Center source project has 
expired, the project is migrated as Deactivated.

➤ If the Performance Center source project has not 
expired, it is migrated as Active. If the project 
had an expiration date, a warning is included in 
the migration report with the expiration date.

Project names ➤ Invalid characters are replaced with underscores 
(_). For details on invalid characters, see "General 
Notes" on page 186.

➤ The user enters a domain name to which to 
migrate the projects. If this domain already exists 
in ALM, projects are migrated to this domain. If 
it does not exist, then the new domain is created.

➤ When migrating a project with the same name as 
a project that was previously migrated, the 
migrated project is deleted and is migrated again. 

➤ When migrating a project, and a project with the 
same name already exists, then the migration of 
the project fails.

Migrating deleted projects ➤ Deleted projects can be viewed in the Resource 
by Duration Report and Resource by Runs Report 
in the Resource Usage by Project tab.

➤ Deleted projected are named <project>_deleted.

➤ Data from deleted projects is migrated only if it is 
requested by the user.

➤ Data is relevant to Test Runs in Lab.
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Host and Pool Migration

➤ Merged pools are not supported in Performance Center 11.52. Hosts are 
migrated with direct connection to their pools.

➤ Host priority changes:

➤ In Performance Center 9.5x the priority was a number between 1 and 
32000, where the lower the number the higher the priority. 

➤ In Performance Center 11.52 the priority has a value between 1 and 9, 
where 1 is the lowest priority and 9 is the highest priority.

➤ During migration, the values are changed based on their priority 
relative to each other. For example: Priorities 1, 2, 3 in 
Performance Center 9.5x change to 9, 5, 1 respectively.

Load Test Migration

➤ Performance Center 11.52 does not support the Real-World > By test > 
By Number scheduler mode. This needs to be changed to Real-World > By 
test > By percent. This change should be logged in the migration log.

➤ Migrating Load Generator distribution methods in Performance Test 
Designer:

Performance Center 9.5x had 5 distribution methods (see image below) 
and Performance Center 11.52 only has 2. 

Migration changes the distribution method in the following way:

PC 9.5 Distribution Method PC 11.52 Distribution Method

Assign all load generators to each group Assign all load generators to each 
group

Assign one load generator to each group Manual distribution

Assign an equal number of load 
generators to each group

Manual distribution

Assign virtual load generators to groups at 
design time

Manual distribution

Assign actual load generators to groups Manual distribution
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The following image illustrates the mapping of Performance Center 9.5x 
to Performance Center 11.52 load generator distribution methods:

➤ Controller selection was not available in Performance Center 9.5x. During 
migration this option is set to Dedicated Controller for all tests.

➤ Local Monitor Profile:

➤ Does not exist in Performance Center 11.52. A local monitor profile is 
migrated to Performance Center 11.52 as a monitor profile in the Test 
Resources module, under the name Local_Profile_<LT_Name>.

➤ The test is connected to the migrated monitor profile if the test used a 
local monitor profile.

➤ Topology: Not migrated. If a test is associated with a topology, the 
association is removed.

Timeslot Migration

➤ If the timeslot is connected to a test, then the Controller option in the 
new timeslot is set to Automatic. If the timeslot is not connected to a test 
then it is set to Allocate only Controller that is also LG or Automatic based 
on whether the timeslot in Performance Center 9.5x was set to allow 
Vusers on Controller.
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Script Migration

➤ URL-based scripts are migrated to regular Web (HTTP/HTML) scripts.

➤ When migrating script files, MDRV logs are not migrated.

General Notes

➤ Event logs and topologies are not migrated.

➤ Run states are migrated as follows:

ID
Pre-Migration 
State

Migrated State
Migrated 
Status

Comments

1 Ready Run Failure Not 
Completed

Run Failure with 
a comment

2 Collating Results Run Failure Not 
Completed

Run Failure with 
a comment

3 Running Run Failure Not 
Completed

Run Failure with 
a comment

4 Finished Finished Not 
Completed

Same

5 Run Failure Run Failure N/A Same

7 Stopping Run Failure Not 
Completed

Run Failure with 
a comment

8 Creating 
Analysis Data

Run Failure Not 
Completed

Run Failure with 
a comment

9 Before Collating 
Results

Before Collating 
Results

Not 
Completed

Same

10 Before Creating 
Analysis Data

Before Creating 
Analysis Data

Not 
Completed

Same

11 Failed Collating 
Results

Failed Collating 
Results

Not 
Completed

Same

12 Failed Creating 
Analysis Data

Failed Creating 
Analysis Data

Not 
Completed

Same
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➤ Source File System (LRFS) <=> Target File System (Smart repository) 
changes: 

In the source file system (LRFS) all project files were located in the same 
folder with meaningful file names. In the new Smart Repository all 
project files are still located in the same folder but file names have no 
meaning—they are numbers.

13 Deleting 
Temporary 
Results

Finished Not 
Completed

With a comment

14 Temporary 
Results Deleted

Finished Not 
Completed

15 Failed Delete 
Results

Finished Not 
Completed

16 Deleted Deleted Migrate only to 
lab as deleted

17 Results Deleted Finished Not 
Completed

ID
Pre-Migration 
State

Migrated State
Migrated 
Status

Comments
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➤ Special characters change as a result of migration:

➤ In Performance Center the following characters are invalid:

➤ In ALM the following characters are invalid (depends on the entity):

➤ If you experience problems with the migration process, check the 
database migration log files for any errors or relevant messages. The log 
files (log.txt) are located in the following paths:

Entity Invalid Characters

Script name Only "!" can be used. 

User cannot write any other special characters.

LT name /\<>.|:;!?&*#

MP name ;""&!@#$%*\/ 

Group name Only "!" can be used. 

User cannot write any other special characters.

User name :;&*\'/#~,?{}$%|<>+-=`@^()[]!

Project name ;:&*\"/#~?{}$%|<>+='@()[]^ 

Roles name </> 

Location name No special character can be used.

Host pools name :;"'<>%$&+`" 

Entity Invalid Characters

Test \/:\"?'<>|*% 

Resource \/:\"?'<>|*%!{} 

Library \/:*?\"<>| 

Project  =~`!@#$%^&*()+|{}()[]:'';"<>?,./\- 

Domain  =~`!@#$%^&*()+|{}()[]:'';"<>?,./\- 

Group ~`!@#$%^&*()+|{}[]:'';"<>?,/ 

User ()@\/[]'':|<>+=;",?*`%.
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➤ ..\<Migration tool 
Installation>bin\orchidtmp\LTLogger\MigrationTool

➤ ..\<Migration tool 
Installation>bin\orchidtmp\LTLogger\ProjectMigrationWrapper

For example, if you installed the migration tool on the 
Performance Center Server machine, the log files are located at 
\<PC Server installation>\orchidtmp\LTLogger\MigrationTool\log.txt and 
\<PC Server installation>\orchidtmp\LTLogger\
ProjectMigrationWrapper\log.txt. 
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6 
Working with Firewalls

You can set up your Performance Center system to run Vusers and monitor 
servers over a firewall.

This chapter includes:

➤ About Using Firewalls in Performance Center on page 194

➤ Example: Over Firewall Deployment on page 196

➤ Setting Up the System to Use Firewalls: Basic Steps on page 197

➤ Installing Over Firewall Components on page 199

➤ Initial Configuration of the Over Firewall System on page 199

➤ Specifying MI Listeners in ALM on page 204
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About Using Firewalls in Performance Center

Working with a firewall means that you can prevent unauthorized access to 
or from a private network, on specific port numbers.

For example, you can specify that no access is allowed to any port from the 
outside world, with the exception of the mail port (25), or you can specify 
that no outside connection is allowed from any ports to the outside except 
from the mail port and WEB port (80). The port settings are configured by 
the system administrator.

In a regular performance test (not over a firewall), the Controller has direct 
access to the Performance Center agents running on remote machines. This 
enables the Controller to connect directly to those machines. 

When running Vusers or monitoring applications over a firewall, this direct 
connection is blocked by the firewall. The connection cannot be established 
by the Controller, because it does not have permissions to open the firewall. 

Performance Center solves this problem by using a communication 
configuration based on HTTPS or secured TCP/IP. This configuration uses 
the standard SSL port on the firewall (port 443). For more information on 
HTTPS and TCP/IP system configuration, see "Setting Up Your Deployment 
(TCP or HTTPS)" on page 200.
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A Performance Center agent is installed on Load Generators running Vusers 
over a firewall, and on Monitor Over Firewall machines that monitor the 
servers that are located over a firewall. The agent communicates with the 
MI Listener machine through port 443 in the firewall. 

The MI Listener is a component that serves as router between the Controller 
and the Performance Center agent. 

When the Performance Center agent connects to the MI Listener, the 
MI Listener keeps a listing of the connection to the agent using a symbolic 
name that the agent passed to it. 

When the Controller connects to the MI Listener, it communicates to the 
MI Listener through port 50500. 

The Controller uses a symbolic name for the agent, and provides the 
MI Listener machine’s name. If there has been a connection from the agent 
with the same symbolic name to this MI Listener, the connection is made 
between the Controller and the agent. Once you have a connection with the 
agent, you can run or monitor Vusers over a firewall. 



Chapter 6 • Working with Firewalls

196

Example: Over Firewall Deployment

The following diagram is a basic example of a Performance Center 
deployment over a firewall.

As explained in the previous section, the Performance Center agent is 
installed on both the Load Generator machine and the Monitor Over 
Firewall machine. During installation, the Performance Center agent is 
added as a Windows service.

The MI Listener serves as a router between: 

➤ The agent on the Load Generator machine and the Controller, 
enabling the Controller to run Vusers over a firewall.

➤ The agent on the Monitor Over Firewall machine and the Controller, 
enabling the Controller to monitor the servers that are located over a 
firewall.
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Setting Up the System to Use Firewalls: Basic Steps

Setting up the system to use firewalls involves the following stages of 
configuration:

Stage Description

Installation and initial 
configuration

Install the necessary components and perform 
initial configuration settings. For details, see 
"Installing Over Firewall Components" on page 199, 
and "Initial Configuration of the Over Firewall 
System" on page 199.

Enabling running Vusers 
over a firewall

When there is a firewall between the Controller and 
Load Generator host machines, set up the system to 
run Vusers over the firewall. For details, see 
"Running Vusers Over a Firewall" on page 207.

Enabling monitoring over 
a firewall

Set up your system to monitor the application 
under test (AUT) when there is a firewall between 
the Controller and the AUT. For details, see 
"Monitoring Over a Firewall" on page 213.

Checking Connectivity After installing and configuring all the necessary 
components, check that you are able to establish a 
connection between the Performance Center agent, 
the MI Listener, and the Controller machine. For 
details, see "Checking Connectivity" on page 234.
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The following flow chart provides a general outline of the steps that you 
need to perform to set up your system to work with firewalls.
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Installing Over Firewall Components

To enable over firewall communication, ensure that you have installed the 
following Performance Center components:

Initial Configuration of the Over Firewall System

After you have installed the necessary components, you are ready to 
configure your over firewall system. 

To perform initial configuration of your over firewall system:

 1 Configure the system according to TCP or HTTPS. 

See "Setting Up Your Deployment (TCP or HTTPS)" on page 200.

 2 Modify the firewall settings to enable communication between the 
machines on either side of the firewall. 

See "Configuring the Firewall to Allow Agent Access" on page 201.

 3 Configure the MI Listener. 

See "Configuring the MI Listener" on page 202.

Component Description

MI Listener Serves as a router between the Controller and the 
Performance Center agent. You install the MI Listener 
component on a dedicated machine. For installation 
instructions, see "Installing Standalone Components 
(Windows)" on page 79.

For instructions on configuring the MI Listener 
machine, see "Configuring the MI Listener" on page 202. 

Monitor Over Firewall 
component

Used to monitor the servers that are located over a 
firewall. You install the Monitors over Firewall 
component on a dedicated machine. For installation 
instructions, see "Installing Standalone Components 
(Windows)" on page 79.

For information about configuring the Monitor Over 
Firewall machine, see "Monitoring Over a Firewall" on 
page 213.
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Setting Up Your Deployment (TCP or HTTPS)
To run Vusers or monitor servers over the firewall, configure your system 
according to one of the following configurations. Note that these 
configurations contain a firewall on each LAN. There may also be 
configurations where there is a firewall for the Over Firewall LAN only.

➤ TCP Configuration

The TCP configuration requires every Performance Center agent machine 
behind the customer’s firewall to be allowed to open a port in the firewall 
for outgoing communication. 



Chapter 6 • Working with Firewalls

201

➤ HTTPS Configuration

In the HTTPS configuration, only one machine (the proxy server) is 
allowed to open a port in the firewall. Therefore it is necessary to tunnel 
all outgoing communications through the proxy server. 

Configuring the Firewall to Allow Agent Access
You modify your firewall settings to enable communication between the 
machines inside the firewall and machines outside the firewall. 

TCP Configuration

The Performance Center agent attempts to establish a connection with the 
MI Listener using port 443, at intervals specified in the Connection Timeout 
field in the Agent Configuration dialog box. To enable this connection, 
allow an outgoing connection for HTTPS service on the firewall for port 443. 
The agent can then connect to the MI Listener, and the MI Listener can 
connect back to the agent. From this point on, the agent listens to 
commands from the MI Listener.
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HTTPS Configuration

The Performance Center agent attempts to establish a connection with the 
MI Listener, using the proxy port specified in the Proxy Port field, and at 
intervals specified in the Connection Timeout field in the Agent 
Configuration dialog box. When the connection is established, the proxy 
server connects to the MI Listener. To enable this connection, allow an 
outgoing connection for HTTPS service on the firewall for port 443. The 
proxy server can then connect to the MI Listener, and the MI Listener can 
connect back to the agent through the proxy server. From this point on, the 
agent listens to commands from the MI Listener.

Configuring the MI Listener
To enable running Vusers or monitoring over a firewall, you need to install 
the MI Listener on one or more machines in the same LAN as the Controller 
outside the firewall. For installation instructions, see "Installing Standalone
Components (Windows)" on page 79.

Note: When installing the MI Listener:

➤ The MI Listener must be installed on a dedicated machine.

➤ Make sure that IIS is not running on the MI Listener or Monitor Over 
Firewall machine. IIS uses port 443 and does not allow the access 
required by the listening and monitoring processes.
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To configure the MI Listener:

 1 Open incoming HTTPS service for port 443. The port settings are set by 
your system administrator.

 2 Stop the Performance Center agent by right-clicking its icon in the system 
tray and selecting Close.

 3 Select Start > Programs > Performance Center > Advanced Settings > 
MI Listener Configuration, or open
<Performance Center Host root>\launch_service\bin\MILsnConfig.exe.
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 4 Set each option as described in the following table:

Click OK to save your changes or Use Defaults to use the default values.

 5 Restart the Performance Center agent from Start > Programs > 
HP Performance Center Host.

Specifying MI Listeners in ALM

In Lab Management, you specify one or more MI Listeners to enable 
running Vusers or monitoring data over a firewall.

To add an MI Listener:

 1 On the Lab Management sidebar, under Performance Center, select 
MI Listeners.

 2 In the MI Listeners module, click the New MI Listener button. The New 
MI Listener dialog box opens.

Option
Default 
Value 

Description

Check Client Certificates False Select True to request that the client 
send an SSL certificate when 
connecting, and to authenticate the 
certificate.

Private Key Password None The password that may be required 
during the SSL certificate 
authentication process.
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 3 Enter the following details:

 4 Click OK. The MI Listener is added to the table.

Field Description

Description A description of the MI Listener.

Public IP The public IP address of the MI Listener.

Note: 

If you have two different IP addresses for the same MI 
Listener, one for public communication with a Load 
Generator located over a firewall and a second for 
internal communication with the Controller, enter 
the public IP address here. Enter the internal IP 
address in the MI Listener Name field (see below).

MI Listener ID The MI Listener ID.

MI Listener Name The host name of the MI Listener.

Note: If you have two different IP addresses for the 
same MI Listener—one for internal communication 
with the Controller and a second for public 
communication with a Load Generator located over a 
firewall—enter the internal IP address here. Enter the 
public IP address in the Public IP field (see above).

Purpose The role designated to the MI Listener: 

➤ Diagnostics data collection over a firewall

➤ Monitoring over a firewall

➤ Running Vusers over a firewall
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7
Running Vusers Over a Firewall

You can set up Performance Center to run Vusers over a firewall.

This chapter includes:

➤ Running Vusers Over a Firewall: Basic Steps on page 208

➤ Configuring Hosts to Run Vusers Over a Firewall on page 210
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Running Vusers Over a Firewall: Basic Steps

Note: Before you configure your system to run Vusers over the firewall, 
ensure that you have completed the configuration steps described in "Initial 
Configuration of the Over Firewall System" on page 199.
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To run Vusers over a firewall:

 1 In Lab Management, specify the details of the MI Listener that will be 
used to run Vusers over the firewall. For details, see "Specifying MI 
Listeners in ALM" on page 204.

 2 Configure the Performance Center agent on each Load Generator 
machine that will run over a firewall to communicate with the 
MI Listener.

For information on how to configure the Performance Center agent, see 
"Configuring the Performance Center Agent" on page 225.

Note: After you configure the Performance Center agent on the Load 
Generator machine, you can edit the configuration settings from Lab 
Management. For more information, see the HP ALM Lab Management 
Guide.

 3 In Lab Management, configure the relevant Load Generator hosts to run 
over a firewall. For details, see "Configuring Hosts to Run Vusers Over a 
Firewall" on page 210.



Chapter 7 • Running Vusers Over a Firewall

210

Configuring Hosts to Run Vusers Over a Firewall

To use a Performance Center host to run Vusers over a firewall, you need to 
configure the relevant hosts as Load Generators in Lab Management. 

Part of the process of configuring a Performance Center host involves 
selecting a location for your host. For example, locations can be defined 
according to physical areas. The location also determines whether the host 
is located over a firewall.

Before you configure the host, you need to ensure that you have added a 
location over a firewall. When you are configuring a host to operate over a 
firewall, you select a location that is located over a firewall.

This section describes the basic steps of how to add a host as a Load 
Generator for running Vusers over a firewall. For detailed information about 
adding hosts in Performance Center, refer to the HP ALM Lab Management 
Guide.

To configure a host to run Vusers over a firewall:

 1 Add the location that is over a firewall.

 a On the Lab Management sidebar, under Lab Resources, select 
Locations. 

 b In the Host Locations module, click the New Host Location button. 
The New Host Location dialog box opens.

 c Enter the following details:

Field Description

Description A description of the host location.

Location Name The name of the host location. The name should have 
a logical connection to the host location.

Over Firewall Indicates whether the host location is over a firewall.
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 2 Add the over firewall host.

 a On the Lab Management sidebar, under Lab Resources, select Hosts. 

 b In the Host module, click the New Host button. The New Host dialog 
box opens.

 c Enter the following details:

Field Description

Belongs to Pools The host pools to which the host is assigned. 

Host pools enable you to control which hosts are 
allocated to which projects. 

Description A description of the host.

Host Attributes Attributes of the host.

Example: Memory, strength, installed components

Installation Indicates the type of host installation.

For a standalone installation of the Load Generator, 
select Windows Standalone LG. 

Location The location of the host that is over the firewall.

MI Listener The IP address or host name of the MI Listener that 
enables data collection.

If no MI Listener is found, it means that the Load 
Generator Performance Center Agent was not 
correctly configured to operate over a firewall. In this 
case, you need to manually select an MI Listener from 
the MI Listener list and then configure the 
Performance Center Agent on the Load Generator 
machine to operate over a firewall. 

For more information about configuring the 
Performance Center Agent to operate over a firewall, 
see "Configuring the Performance Center Agent" 
on page 225. 

Name The fully qualified domain name or IP address of the 
host that was assigned when creating the host.
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Password The password of the Performance Center system user 
on the host machine.

Priority A rank assigned to the host. The higher the priority 
you give the host, the more likely the host will be 
allocated to a test. There are a number of criteria to 
consider when assigning priority. The main 
considerations are whether the host is a dedicated 
machine or a shared resource, and the type of 
hardware installed on the machine.

Purpose A host over a firewall can only have a Load Generator 
purpose.

Enable SSL Indicates whether the Load Generator is to 
communicate with the Controller via SSL (Secure 
Socket Layer) or not. This option is available when 
the Load Generator is located over a firewall.

Note: The Load Generator uses SSL to communicate 
with the Controller during run time only. For non 
runtime functionality (including collating results), 
the Load Generator does not use SSL as the 
communication protocol.

Status The status of the host. An indicator is displayed next 
to the host name, representing its current status.

The possible statuses are: 

➤ Operational. The host machine is up and running.

➤ Non-operational. The host machine is down.

➤ Unavailable. There is no information available 
about the status of the host.

User Name The user name of the Linux Load Generator machine.

Field Description
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8 
Monitoring Over a Firewall

You can set up Performance Center to monitor servers over a firewall.

This chapter includes:

➤ Monitoring Over a Firewall: Basic Steps on page 214

➤ Configuring Monitor Settings on page 216

➤ Configuring the Project to Receive Monitor Over Firewall  Information 
on page 222

➤ Editing Monitor Over Firewall Machines During a Test Run on page 223
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Monitoring Over a Firewall: Basic Steps

Note: Before you configure your system to monitor servers over a firewall, 
ensure that you have completed the configuration steps described in "Initial 
Configuration of the Over Firewall System" on page 199.
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To set up your system to monitor servers over a firewall:

 1 In Lab Management, specify the details of the MI Listener that will be 
used to monitor servers over the firewall. For details, see "Specifying MI 
Listeners in ALM" on page 204.

 2 Configure the Performance Center agent on each Monitor Over Firewall 
machine to communicate with the MI Listener.

For details, see "Configuring the Performance Center Agent" on page 225.

 3 Use the Monitor Configuration tool to configure the servers to monitor 
and define specific measurements that Performance Center collects for 
each monitored server.

For details, see "Configuring Monitor Settings" on page 216.

 4 In the relevant project, establish a connection between the tests you are 
running and the Monitor Over Firewall machines.

For details, see "Configuring the Project to Receive Monitor Over Firewall  
Information" on page 222.
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Configuring Monitor Settings

You configure the monitor settings from the Monitor Over Firewall 
machine, using the Monitor Configuration tool. You select the type of 
monitors to run and the server whose resources you want to monitor, add 
the measurements to monitor for each server, and specify the frequency at 
which the monitored measurements are to be reported.

To configure monitor settings:

 1 On the Monitor Over Firewall machine, choose Start > Programs > 
HP LoadRunner > Advanced Settings > Monitor Configuration. For 
machines without the complete Performance Center installation, choose 
Start > Programs > Server Monitor > Monitor Configuration. The Monitor 
Configuration dialog box opens.
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 2 Click the Add Server button. The New Monitored Server Properties dialog 
box opens.

 3 In the Monitored Server box, type the name or IP address of the server 
whose resources you want to monitor. 

Note: To add several servers simultaneously, you can specify IP ranges, or 
separate the server names or IP ranges with commas. For example, 
255.255.255.0-255.255.255.5, or server1, server2.

 4 From the Available Monitors list, select the monitors suitable for the 
server being monitored. 
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 5 Click OK to close the New Monitored Server Properties dialog box. The 
Monitored Servers list is displayed in the Monitor Configuration dialog 
box. 

Default measurements are displayed for some of the monitors in the 
Measurements to be Monitored section. You can specify the frequency at 
which to report the measurements in the Measurement Properties 
section. 

 6 To add additional monitored servers to the list, repeat steps 2 through 5.

 7 To edit the monitor configuration properties for a server, click the Edit 
button. The Monitored Server Properties dialog box opens enabling you 
to edit the monitors for the server whose resources you are monitoring.

 8 Click Apply to save your settings.
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Cloning a Monitored Server’s Properties
To monitor the same properties on different server machines, you can clone 
a selected server’s properties using the Clone Monitored Server Properties 
dialog box.

To clone a monitored server’s properties:

 1 Open the Monitor Configuration dialog box.

 2 Right-click the server you want to clone, and select Clone. The Clone 
Monitored Server Properties dialog box opens.

 3 In the Monitored Server box, type the name or IP address of the cloned 
server you want to create. 

Tip: To create several cloned servers simultaneously, you can specify IP 
ranges, or separate the server names or IP ranges with commas. For 
example, 255.255.255.0-255.255.255.5, or server1, server2.



Chapter 8 • Monitoring Over a Firewall

220

 4 The Available Monitors list displays the monitors that were selected for 
the server being cloned. Select additional suitable monitors for the cloned 
server. 

 5 Click OK to close the Clone Monitored Server Properties dialog box. The 
cloned server is displayed in the Monitored Servers list.

 6 Click Apply to save your settings.

Adding and Removing Measurements 
After you configure one or more server machines to monitor, you add 
measurements to monitor for each server. If Performance Center added 
default measurements, you can edit them as required.

To add a measurement to monitor:

 1 Open the Monitor Configuration dialog box.

 2 Select a server from the Monitored Servers list.

 3 Click the Add Measurement button. Select the appropriate monitor. A 
dialog box opens, enabling you to choose measurements for the monitor 
you selected.

 4 Select the measurements that you want to monitor, and click OK.

 5 Click Apply to save your settings.

To remove a measurement from the measurements list:

 1 Select the measurement, and click the Delete button. 

 2 Click Apply to save your settings.
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Configuring Measurement Frequency 
After you have configured monitor measurements, you set a schedule for 
reporting each measurement.

To configure measurement frequency:

 1 In the Monitor Configuration dialog box, under the Measurement 
Properties section, select the configured server measurement you want to 
schedule.

 2 Specify the frequency at which you want Performance Center to report 
the measurement.

 3 Click Apply to save your settings.
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Configuring the Project to Receive Monitor Over Firewall 
Information

After you configure the monitors, you configure the project to receive 
Monitor Over Firewall information during performance test runs.

Note: The steps in the section are described in more detail in the section 
about monitor profiles in the HP ALM Performance Center Guide. 

To configure the project to receive Monitor Over Firewall information:

 1 Add a monitor over firewall which can be accessed by performance tests 
in this project.

 a On the ALM sidebar, select Test Resources.

 b In the Test Resources module, right-click and select New Resource.

 c In the Type box, select Monitor Over Firewall. 

 d Enter a name, the machine key, and select the MI Listener with which 
the monitor is to connect. 

 2 Select the Monitor Over Firewall agent to use in a specific performance 
test.

 a In the Test Plan module, right-click a performance test, and click Edit 
Test to open the test in the Performance Test Designer window.

 b In the Monitors tab, select the Monitor Over Firewall agent. 
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Editing Monitor Over Firewall Machines During a Test Run

While a performance test is running, you can change the status of a Monitor 
Over Firewall agent or add another monitor to the test.

To modify the Monitor Over Firewall machines:

 1 On the Test Run page, click the Design button. The Performance Test 
Designer window opens.

 2 Click Settings. The Settings dialog box opens. 

 3 In the Server Monitors tab, you can view the Monitor Over Firewall 
agents that are monitoring the test, as well as their connection status. 

➤ To connect or disconnect a Monitor Over Firewall agent, click the 
Connect/Disconnect button.

➤ To add a Monitor Over Firewall agent to the test, select it from the Add 
Monitor Over Firewall list.

 4 Click OK.

 5 Click Close to close the Settings dialog box.
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9 
Configuring the Performance Center 
Agent

You can set up your Performance Center system to run Vusers and monitor 
servers over a firewall. As part of the process of setting up your 
Performance Center system to work over firewalls, you configure the 
Performance Center agent.

This chapter includes:

➤ About Configuring Performance Center Agents Over the Firewall 
on page 226

➤ Configuring the Windows Performance Center Agent on page 227

➤ Configuring and Running the UNIX Performance Center Agent 
on page 229

➤ Agent Configuration Settings on page 231

➤ Checking Connectivity on page 234
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About Configuring Performance Center Agents Over the 
Firewall

As part of the process of setting up your Performance Center system to work 
over firewalls, you configure the Performance Center agent on each Load 
Generator machine that will be running over a firewall and on each Monitor 
Over Firewall machine.

You configure the Performance Center agent to communicate with the 
MI Listener. The MI Listener serves as a router between the 
Performance Center agent and the Controller.
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Configuring the Windows Performance Center Agent

This section describes how to configure the Performance Center Agent on 
Windows machines to communicate with the MI Listener.

To configure the Performance Center agent on Windows machines:

 1 Select Start > Programs > HP Performance Center Host> Advanced 
Settings > 
Performance Center Agent Configuration, or run 
<Performance Center root>\launch_service\bin\AgentConfig.exe.

The Agent Configuration dialog box opens.

 2 Select Enable Firewall Agent.

 3 Click Settings. The Agent Configuration dialog box displays a list of 
settings.
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 4 Set each option as described in "Agent Configuration Settings" on 
page 231. Pay careful attention to the first three settings.

Note: When specifying the Local Machine Key, you must use the format 
hostname_locationname where hostname is the name of the host, as 
defined in the Hosts module in Lab Management, and locationname is the 
name of the host location, as defined in the Host Location module.

 5 Click OK to save your changes.

 6 When prompted, click OK to restart the Performance Center agent.

 7 Check the connection status between the Performance Center agent and 
the MI Listener. 

An illuminated green light next to the Performance Center Agent icon in 
the system tray indicates a successful connection between the agent and 
the MI Listener. A red light indicates that there is no connection between 
the agent and the MI Listener.

Notes:

➤ When you configure the Performance Center agent on Windows 
machines, the Remote Management agent is automatically configured 
with the same settings. The Remote Management agent enables you to 
manage remote machines from Lab Management or from ALM.

➤ After you have configured the Performance Center agent on the Load 
Generator machine, you can edit the configuration settings from Lab 
Management. For more information, see the HP ALM Performance Center 
Guide.
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Configuring and Running the UNIX Performance Center 
Agent

Load Generator hosts can be installed on Linux machines. This section 
describes how to configure and run Performance Center agents on UNIX 
machines.

Note: As part of the process of configuring the Performance Center Agent on 
UNIX machines, you also need to configure the Remote Management agent. 
The Remote Management agent enables you to manage remote machines 
from Lab Management or from ALM.

To configure the Performance Center Agent on UNIX machines:

 1 Activate the firewall service for the Performance Center agent:

 a Open <Performance Center root folder>/dat/br_lnch_server.cfg in a 
text editor.

 b In the Firewall section, set FireWallServiceActive to 1 and save your 
changes.

 2 Activate the firewall service for the Remote Management agent:

 a Open <Performance Center root folder>/al_agent/dat/
br_lnch_server.cfg in a text editor.

 b In the Firewall section, set FireWallServiceActive to 1 and save your 
changes.

 3 Run agent_config from the <Performance Center root folder>/bin 
directory and enter the agent configuration settings (see "Agent 
Configuration Settings" on page 231).

Note: When you set the agent configuration settings, they are applied to 
both the Performance Center and Remote Management agents.
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 4 Restart the Performance Center agent for the configuration changes to 
take effect.

 a To stop the Performance Center agent, run the following command 
from the <Performance Center root folder>/bin directory:

 

 b To start the Performance Center agent, run the following command 
from the <Performance Center root folder>/bin directory:

 

Note: When the Performance Center agent is configured to run over a 
firewall, and the agent is connected to the MI Listener, a file called 
<local_machine_key>_connected_to_MI_Listener is created in the 
temporary directory of the Performance Center agent machine. This file is 
deleted when the Performance Center agent disconnects from the MI 
Listener.

 5 Restart the Remote Management agent for the configuration changes to 
take effect.

 a To stop the Remote Management agent, run the following command 
from the <Performance Center root folder>/al_agent/bin directory:

 

 b To start the Remote Management agent, run the following command 
from the <Performance Center root folder>/al_agent/bin directory:

 

m_daemon_setup -remove

m_daemon_setup -install 

al_daemon_setup -remove 

al_daemon_setup -install 
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Agent Configuration Settings 

The following table provides an explanation of the agent configuration 
settings:

Setting Default Value Description

MI Listener name none The host name, fully qualified 
domain name, or IP address of the 
MI Listener.

Local Machine Key none A symbolic string identifier used 
to establish a unique connection 
between the Controller host and 
the agent machine, via the MI 
Listener machine.

When configuring to monitor 
over a firewall, you can enter any 
logical name, using lowercase 
letters only.

When configuring to run Vusers 
over a firewall, you must use the 
format hostname_locationname 
where:

➤ hostname is the name of the 
host as found in Lab 
Management’s Hosts module.

➤ locationname is the name of the 
host location as found in Lab 
Management’s Host Locations 
module.

Connection Timeout 
(seconds)

20 seconds The length of time you want the 
agent to wait before retrying to 
connect to the MI Listener 
machine. If zero, the connection 
is kept open from the time the 
agent is run.

MI Listener User Name none The user name needed to connect 
to the MI Listener machine.
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MI Listener Password none The password needed to connect 
to the MI Listener machine.

Server Domain none The domain name needed to 
connect to the MI Listener 
machine. This field is required 
only if NTLM is used.

Connection Type - 
TCP/HTTP

TCP Select either TCP or HTTP, 
depending on the configuration 
you are using.

Connection Type - 
HTTP Proxy Name

none The name of the proxy server. This 
field is mandatory if the 
Connection Type setting is HTTP.

Connection Type -
HTTP Proxy Port

none The proxy server connection port. 
This field is mandatory if the 
Connection Type setting is HTTP.

Connection Type - 
HTTP Proxy User Name

none The user name of a user with 
connection rights to the proxy 
server.

Connection Type - 
HTTP Proxy Password

none The password of the user with 
connection rights to the proxy 
server.

Connection Type - 
HTTP Proxy Domain

none The user’s domain if defined in 
the proxy server configuration. 
This option is required only if 
NTLM is used.

Use Secure Connection 
(SSL)

disabled Enable to connect using the 
Secure Sockets Layer protocol.

Setting Default Value Description



Chapter 9 • Configuring the Performance Center Agent

233

Use Secure Connection 
(SSL) - Check Server 
Certificates

none Authenticates the SSL certificates 
that are sent by the server. Select 
Medium to verify that the server 
certificate is signed by a trusted 
Certification Authority. Select 
High to verify that the sender IP 
matches the certificate 
information. This setting is 
available only if Use Secure 
Connection is set to True. 

Use Secure Connection
(SSL) - Private Key 
Password

none The password that might be 
required during the SSL certificate 
authentication process. This 
option is relevant only if the 
Client Certificate Owner option is 
enabled.

Use Secure Connection
(SSL) - Use Client 
Certificate

disabled Enables you to upload the SSL 
certificate (if required by the 
server to allow the connection to 
be made). This option is relevant 
only if the Use Secure Connection 
option is enabled.

Setting Default Value Description
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Checking Connectivity

To run Vusers or monitor servers over a firewall, you must be able to 
establish a connection between the Performance Center agent, MI Listener, 
and the Controller machine. 

If you encounter connectivity problems after installing and configuring all 
the necessary components, check the table below for troubleshooting tips. 

Check Solution

To check that the Firewall 
service was activated on the 
agent machine:

➤ Windows Installation: There should be a 
traffic light to the right side of the 
Performance Center Agent icon on the 
machine running/monitoring Vusers over 
a firewall. If there is no traffic light, you 
need to reconfigure the Performance 
Center Agent on your Windows machine. 
For details, see "Configuring the Windows 
Performance Center Agent" on page 227.

➤ Linux Installation: In the temporary 
directory of the Performance Center Agent 
machine, locate the 
<local_machine_key>_connected_to_
MI_Listener file. If the file is missing, this 
indicates that the FirewallServiceActive=1 
is not set in the [FireWall] section of the 
Agent Settings. For details, see 
"Configuring and Running the UNIX 
Performance Center Agent" on page 229.

To check that port 443 is open: On the agent machine, open a command 
prompt window, and type the following: 
telnet <MI_Listener_IP> 443. 
For example: telnet 111.111.111.1111 443. 
If port 443 is open, a new Telnet window 
opens. If port 443 is not open, contact your 
network administrator. 
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To check that port 443 is 
available:

If a Web server is running on the MI Listener 
or Monitor Over Firewall machine, port 443 
does not allow the access required by the 
listening and monitoring processes. Contact 
your network administrator to change the 
Web server port.

To check connectivity between 
the agent and the MI Listener, 
when running the 
Performance Center agent as a 
service:

If there is a red light to the right of the 
Performance Center agent icon  when 
running the Performance Center agent as a 
service, do the following:

➤ Check that port 443 is open. See above.

➤ Check that the Agent Settings and Agent 
Configuration are correctly set. For details, 
see "About Configuring 
Performance Center Agents Over the 
Firewall" on page 226.

➤ Run the agent as a process by launching 
Installation>\Launch_service\bin\magent
proc.exe. If you are successful, this 
indicates an authentication issue with the 
Performance Center Agent Service. Browse 
to the Administrative Tools > Services > 
Performance Center Agent Service and 
change the properties of this service to 
System User Account, or provide the 
username and password of a user who has 
administrative privileges on this machine.

Check Solution
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10
Troubleshooting

This chapter provides troubleshooting for issues that arise when installing 
ALM Performance Center components and patches, when migrating data 
from earlier versions of Performance Center, and during initial 
configuration.

This chapter includes:

➤ During Performance Center Server Setup Installation of a Prerequisite 
Fails on page 241

➤ Performance Center Server Installation Cannot be Completed: IIS is not 
Installed on page 242

➤ Fails to Install .NET Framework 3.5 SP1 on Windows 2008 R2 on page 243

➤ Cannot Connect to Performance Center Server or Host on page 243

➤ Performance Center Host Installation Hangs at Registering Modules 
on page 244

➤ Performance Center Server Cannot be Added to ALM Due to Mismatch in 
Communication Security Passphrase on page 245

➤ Performance Center Host Cannot be Added to Lab Management, or is 
Non-Operational, Due to Mismatch in Communication Security 
Passphrase on page 246

➤ Performance Center Server Cannot be Added to Lab Management: 
HostNotFound Error on page 247

➤ Connection to Controller Failed when Starting a Run and the Online Run 
Screen Did Not Load on page 247

➤ Working with Performance Center when Windows Firewall is Enabled 
on page 248



Chapter 10 • Troubleshooting

240

➤ Cannot Start Remote Management Agent Service Automatically 
on page 251

➤ Uninstall of Host Failed or Has Frozen on page 251

➤ Patch Installation Fails on page 252

➤ Installing a patch requires you to stop the Performance Center Load 
Testing Service on the host machine on page 253

➤ Cannot Launch ALM: Message That Software Not Installed on page 254

➤ Cannot Log in to Performance Center via the Client Machine: Error 
Regarding JavaScript on page 254

➤ When Starting a Test Run, the Host is Added, but the Initializing Run 
Page Does Not Load on page 255

➤ Cannot Run Performance Center Component Installation from a Network 
Drive on page 256

➤ Installing Performance Center Components Does Not Start when 
Selecting Them from the DVD Menu on page 257

➤ Installing One of the Performance Center Components Cannot Use 
Default Port: Port Already in Use on page 258

➤ Unable to Use Non-Default Ports in Microsoft SQL on page 261

➤ Errors in the Migration Tool Report on page 261

➤ Cannot Connect to Oracle Database on 64-bit Windows OS on page 263

➤ Cannot Migrate a Project Again Because it Cannot be Deleted on page 264

➤ Errors in the Migration Log on page 265

➤ The Migrated Project is Not Linked to the PC_PROJECT_TEMPLATE 
Project After the Migration on page 265

➤ Migration Tool Logs on page 267

➤ Migration Tables Not Found on page 269

➤ Migration Tool Report Data Not Found on page 270

➤ Load Test Fails to Start and Issues no Error Message on page 271

➤ Unable to View Topology Monitors Online on page 271
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During Performance Center Server Setup
Installation of a Prerequisite Fails

Problem Description

Some of the system components require installation of various software as a 
prerequisite to successful setup of the component.

For example, the setup of the Performance Center Server requires an 
installation of WSE 2.0. This installation may fail during installation of 
Performance Center components.

Example of the error:

 

Troubleshooting

Component setup uses MSI. This error is often related to problems with the 
MSI engine. 

Restart the machine and try again. If the problem persists, contact 
Microsoft. 
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Performance Center Server Installation Cannot
be Completed: IIS is not Installed

Problem Description

The Performance Center Server installation did not complete successfully. 
The virtual directories are not created on the Performance Center Server.

Troubleshooting

This error occurs when IIS is not installed prior to installation of the 
Performance Center Server.

 1 Complete the Performance Center Server installation by skipping the 
ALM and Performance Center Server configuration steps.

 2 Install IIS.

 3 Run Performance Center Server Configuration Tool from:

Start > Program Files > HP Performance Center Server > Tools > 
HP Performance Center Server Configuration Wizard

 4 (Optional) Set Performance Center and Performance Center Host license 
keys.
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Fails to Install .NET Framework 3.5 SP1 on Windows 2008 
R2

Problem Description

While installing .NET 3.5 SP1 on Windows 2008 R2, the installation fails 
and the following error is displayed:

The installation and configuration of Microsoft. NET Framework 3.5 SP1 
must be made using the role management tools. 

Troubleshooting

Enable the .Net feature from the server configuration.

Cannot Connect to Performance Center Server or Host

Problem Description

Connection issues may cause different errors.

These include:

➤ Inability to add Performance Center Server to the system

➤ Inability to add Performance Center Host to the system

➤ Cannot view Performance Center web pages (for example: License page, 
Performance Test Designer, and so on)

Troubleshooting

Make sure a network connection is available from one machine to the other. 
To check connectivity, make sure you can ping from one machine to 
another, or alternatively use telnet <port number>.
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Performance Center Host Installation Hangs
at Registering Modules

Problem Description

Both the installation and the MSI user interface hang at registering modules. 
This problem occurs because MSI creates a separate process for each 
registration action and then waits for each process to end. 

Troubleshooting

To solve this problem, do one of the following:

➤ Stop and restart the installation.

➤ Open task manager and sort the processes by name. Locate the msiexec 
processes that are running with the user name system. Terminate the 
msiexec process that is consuming the highest CPU.
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Performance Center Server Cannot be Added to ALM Due
to Mismatch in Communication Security Passphrase

Problem Description

The Communication Security passphrase on the Performance Center Server 
and the ALM server do not match and the servers cannot communicate.

Troubleshooting

This can occur if an incorrect Communication Security passphrase was 
provided during the initial configuration of the Performance Center Server, 
or if the passphrase on the ALM server was changed.

To solve the mismatch, update the Communication Security passphrase on 
the ALM server and on the Performance Center Server.

To update the Communication Security passphrase on the ALM server:

 1 Log in to Site Administration.

 2 In the Site Configuration tab, update the 
COMMUNICATION_SECURITY_PASSPHRASE parameter.

 3 Restart the HP Application Lifecycle Management service on the ALM 
server.

To update the Communication Security passphrase on the 
Performance Center Server:

 1 On the machine where the Performance Center Server is installed, run the 
Performance Center Server Configuration Wizard:

Start > Program Files > HP Performance Center Server > Tools > 
HP Performance Center Server Configuration Wizard

 2 On the Communication Security page, enter the new Communication 
Security passphrase.

 3 Click Next on all of the subsequent wizard pages and Finish to close the 
wizard.
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Performance Center Host Cannot be Added to Lab
Management, or is Non-Operational, Due to
Mismatch in Communication Security Passphrase

Problem Description

The Communication Security Passphrase should be the same on both the 
host and the Performance Center Server. The mismatch may occur if you 
run the Host Configuration wizard, since this wizard resets the 
Communication Security Passphrase value.

Troubleshooting

Check that both the host and the Performance Center Server have the same 
Communication Security Passphrase value. If the values are not the same, 
you can change them directly on the Performance Center Server or host, or 
by reconfiguring the Performance Center Server or host from Lab 
Management:

From Lab 
Management

For information about reconfiguring 
Performance Center Servers and hosts, see the 
HP ALM Performance Center Guide.

Directly on the 
Performance Center 
Server

On the Performance Center Server, navigate to the 
PCS.config file as follows: <Performance Center Server 
path>\dat\PCS.config. Under the <appSettings> tag, 
the value appears by the LW_CRYPTO_INIT_STRING key.

For information about how to configure the 
Communication Security Passphrase via the 
Performance Center Server Configuration Wizard, see 
"Performance Center Server Cannot be Added to ALM 
Due to Mismatch in Communication Security 
Passphrase" on page 245.

Directly on the host On the host, navigate to the LTS.config file as follows: 
<Performance Center Host path>\dat\LTS.config. 
Under the <appSettings> tag, the value appears by the 
LW_CRYPTO_INIT_STRING key.
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Performance Center Server Cannot be Added to Lab 
Management: HostNotFound Error

Problem Description

When adding a Performance Center server, the ALM system performs a 
name lookup operation. At times, the system changes the IP address or the 
short DNS name into a full DNS name. When this situation occurs, the 
system fails to add the server because the name is incorrect.

Troubleshooting

Validate that the Performance Center server URL is correct. Make sure that 
the server is up and that it can be reached from the ALM server.

If the problem persists, add the fully qualified name of the Performance 
Center server to the Host file (typically under 
c:\Windows\System32\drivers\etc) in the ALM machine.

Connection to Controller Failed when Starting a Run
and the Online Run Screen Did Not Load

Problem Description

A connection to a Controller must be made during run initialization in 
order to start the test. The initialization screen shows that the connection 
failed and as a result the online run screen did not open.

Troubleshooting

➤ Check the Performance Center Server names and make sure they are 
recognized by the host.

➤ If the Performance Center Server and host are in separate domains, use 
fully qualified names.

➤ When using machine names, make sure the Performance Center Server 
and host belong to the same domain.
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To verify that the Performance Center server is recognized by the host, 
perform the following steps on each host:

 1 Open the Host machine.

 2 Open the Hosts file from C:\windows\system32\drivers\etc\hosts.

 3 Add the Performance Center Server machine name and IP to this file.

Working with Performance Center when
Windows Firewall is Enabled

Problem Description

To work with Performance Center, we recommend that you disable the 
Windows Firewall on all host machines (see "Configuration for Windows XP 
Professional" on page 121). To enable Performance Center to work with the 
Windows Firewall enabled, the Windows Firewall must be reconfigured. 
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Troubleshooting

The Windows Firewall must be configured to allow inbound and outbound 
communication on specific ports used by Performance Center. 

The following configurations are required for all Performance Center 
machines in the system (servers and hosts), except for Site Scope and 
Diagnostics.

Performance Center server:

Process / Service Direction Protocol
Local 
Port

Remote 
Port

Path

Datacollectionagent.exe Inbound TCP 3333 Any <PCS install dir>\bin
\datacollectionagent.exe

World Wide Web 
Services (HTTP Traffic-
In)

Inbound TCP 80 Any Service

RemoteManagement 
Agent Service

Inbound TCP 54245 Any <PCS install 
dir>\al_agent\bin
\alagentservice.exe

HP.PC.LTOP.QCOTA
OperationService
Wrapper.exe

Outbound TCP Any 8080 < PCS install dir>\bin
\HP.PC.LTOP.QCOTA
OperationServiceWrapper.exe

ALWrapperServer.exe Outbound TCP Any 54245 <PCS install dir>\bin
\ALWrapperServer.exe

w3wp.exe Outbound TCP Any 8080, 
8731, 
1433, 
3333
(Use port 
1433 for 
MS SQL 
Server. For 
Oracle, 
use port 
1521.)
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Hosts:

Process / Service Direction Protocol
Local 
Port

Remote 
Port

Path

Datacollectionagent.exe Inbound TCP 3333 Any <Host install dir>\bin
\datacollectionagent.exe

RemoteManagement 
Agent Service

Inbound TCP 54245 Any <Host install 
dir>\al_agent\bin
\alagentservice.exe

Performance Center 
Agent Service

Inbound TCP 54345, 
50500

Any <Host install 
dir>\launch_service
\bin\magentservice.exe

System Inbound TCP 8731 Any

HP.PC.LTOP.QCOTA
OperationService
Wrapper.exe

Outbound TCP Any 8080 <Host install dir>\bin
\HP.PC.LTOP.QCOTAOperati
on
ServiceWrapper.exe

LTOPSvc.exe Outbound TCP Any 80, 8080 <Host install 
dir>\bin\LTOPSvc.exe
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Cannot Start Remote Management Agent Service
Automatically

Problem Description

After installing PCS on Windows 2008 with UAC enabled, the Remote 
Management Agent Service is not enabled.

Troubleshooting

Disable UAC and reboot the PCS machine. The service status should be set 
to Started.

Uninstall of Host Failed or Has Frozen

Problem Description

This error may present itself in various ways:

➤ Uninstall of the Performance Center host did not complete successfully.

➤ Uninstall of the Performance Center host is taking a long time and seems 
to have frozen.

➤ When trying to uninstall the Performance Center host again, the 
Performance Center host is not found in Add/Remove Programs.

Troubleshooting

 1 Try to reboot the machine and uninstall again (unless the Performance 
Center host no longer appears in Add/Remove Programs).

 2 Open a command prompt and run: 

<Host installation path>\bin\HP.PC.PCS.Configurator.exe 
/CFG:..\dat\setup\lts\xml\Configurator.xml /G:Uninstall

 3 Delete the host installation folder. The default path for the host 
installation folder on a Windows 2008 64-bit machine is: 

C:\Program Files (x86)\HP\Performance Center Host

 4 Delete HP Performance Center Host from Start menu > Programs.
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 5 Delete the product from the MSI manager using the Windows Installer 
CleanUp Utility (http://www.windows-installer-cleanup-utility.com/).

Patch Installation Fails

Problem Description

Installing a patch on the Performance Center Server or host from Lab 
Management fails and the following message is displayed:

“Patch installation on host/server <host/server name> failed. Reason: Failed 
installing Patch. Abnormal termination. The installation process is not 
found”

Troubleshooting

To install the patch from Lab Management, you must make sure that the 
Remote Procedure Call (RPC) service is started. You start the service as 
follows:

 1 On the Performance Center Server or host, select Start > Run, and type 
services.msc. The Services window opens.

 2 Right-click the Remote Procedure Call (RPC) service and select Start.
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Installing a patch requires you to stop the
Performance Center Load Testing Service
on the host machine

Problem Description

The HP Performance Center Host Files in Use dialog box appears, displaying 
the following message: 

Troubleshooting

It is recommended that you click Continue and continue with the 
installation. Alternatively, you can perform the procedure below:

 1 Select Start > Run, and type services.msc. The Services window opens.

 2 Stop the Performance Center Load Testing service.

 3 When the service has stopped, click Try Again.

 4 When the installation is complete, manually restart the service.
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Cannot Launch ALM: Message That Software Not Installed

Problem Description

When launching ALM, a message such as the following is displayed:

“Microsoft Visual C++ 2005 SP1 ATL Security Update Redistributable is not 
installed. Application will not be able to run. Contact your system 
administrator.”

Troubleshooting

This problems occurs if one of the client prerequisites, .NET Framework 4.0 
or Microsoft Visual C++ 2005 SP1 ATL Security Update Redistributable, is 
not installed. 

To solve this problem, install the software manually from the following 
locations:

Cannot Log in to Performance Center via
the Client Machine: Error Regarding JavaScript

Problem Description

Login to Performance Center fails, and the following error is displayed:

JavaScript is not installed or is disabled in your browser......

Troubleshooting

This problem is related to running JavaScript in your browser.

.NET Framework 4.0 <Installation_Disk_Root_Directory>\Setup\Common\d
otnet4.0

Microsoft Visual C++ 2005 
SP1 Redistributable Package 
(x86)

<Installation_Disk_Root_Directory>\Setup\<environm
ent>\prerequisites\vc2005_sp1_redist\vcredist_x86.e
xe



Chapter 10 • Troubleshooting

255

To resolve this issue:

 1 In Internet Explorer, select Tools > Internet options >Security.

 2 Select Internet zone.

 3 Click Custom Level.

 4 Make sure that Active Scripting is enabled.

 5 Enable the following items under ActiveX controls and Plug-ins:

➤ Automatic prompting for ActiveX controls

➤ Binary and script behaviors

➤ Run ActiveX controls and plugins

➤ Script ActiveX controls marked safe for scripting

When Starting a Test Run, the Host is Added, but the
Initializing Run Page Does Not Load

Problem Description

When starting a test run, the host is added, but the Initializing Run page 
does not load.

Troubleshooting

The client needs to have access to the machine. For example, if the 
Administrator inserted the machine name without the domain, you might 
need to add the IP address and machine name to the host file 
(C:\WINDOWS\system32\drivers\etc\hosts) on the client machine.
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Cannot Run Performance Center Component Installation
from a Network Drive

Problem Description

Cannot run the setup (Performance Center Server or host) when attempting 
to run it from a network drive.

Troubleshooting

To run setup.exe from a network location, you need to add the network 
server location to your Trusted Sites, and then run setup.exe again.

To add the network server to your Trusted Sites in Internet Explorer:

 1 Open Tools > Internet Options.

 2 Select the Security tab and click Trusted Sites:
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 3 Click Sites. 

 4 In the Trusted Sites dialog box, add the location of the network server 
where the Performance Center component setup file is located, to the list 
of trusted sites.

Installing Performance Center Components Does Not
Start when Selecting Them from the DVD Menu

Problem Description

When clicking the installation option on the DVD menu nothing happens.

Troubleshooting

 1 Make sure the user running the installation has sufficient permissions to 
launch executable files.

 2 Restart the machine and try again.
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Installing One of the Performance Center Components
Cannot Use Default Port: Port Already in Use

Problem Description

The installation cannot use a default port because it is already in use.

Troubleshooting

If the installation cannot use a default port because it is already in use, 
change the port as per the instructions in the following table:

Component How to change the port

Performance Center 
Server IIS

To change this port, see 
http://support.microsoft.com/kb/149605.

Performance Center host To change port 8731 to a different port: 
1  On each Performance Center host, open 

LTOPSvc.exe.config (located in <Host Installation 
directory>\bin\) and change all four occurrences 
of 8731 to a new port number. Restart the 
Performance Center Load Testing Service.

2  On the Performance Center Server, open 
pcs.config (located in <Performance Center 
Server Installation directory>\dat\). Under 
PCSSettings, change ltopPortNumber to the new 
port number.

http://support.microsoft.com/kb/149605
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MI Listener To change port 443 to a different port, perform the 
following steps on the following machines:

➤ Controller machine (if used as MI Listener)

➤ Load Generator machine

➤ MI Listener

To change port 443:
1  Open <Component installation 

directory>\launch_service\dat\mdrv.dat. and 
locate the [launcher] section.

2  Add OFWPort=<port>, where <port> is the new 
port number.

3  Go to <Component installation 
directory>\launch_service\dat\channel_configu
re.dat and locate the [General] section.

4  Add OFWPort=<port>, where <port> is the new 
port number.

5  Restart the agent.

Note: There is no support for changing port 50500.

LoadRunner/ 
Performance Center 
Agent

Autolab Agent

To change HTTP tunneling ports 5001 and 5002:
1  Open <LR>\launch_service\dat\mdrv.dat, and 

locate the [launcher] section.

2  Add the following to the ExtCmdLine= key:

➤ For port 5001 add: 
-lnch_http_nd_port=<port>

➤ For port 5002 add: 
-lnch_http_dummy_port=<port>

where <port> is the new port number.

To change HTTP tunneling port 5003:
1  Create or open 

<LR>\launch_service\dat\merc_agent.cfg

2  Locate the [Attributes] section, and add the 
following: NMMRouterPort=<port>, where 
<port> is the new port number.

Note: There is no support for changing ports 54345 
and 54245.

Component How to change the port
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SiteScope (Topology) In Performance Center, change the port of the 
Topology entity to the same port as that defined 
during the SiteScope configuration.

SiteScope (Topology) - 
SSL

In Performance Center, change the port of the 
Topology entity to the same port as that defined 
during the SiteScope configuration.

SiteScope (Monitor 
Profiles)

In Performance Center, change the port of the 
Monitor Profile entity to the same port as that 
defined during the SiteScope configuration.

Diagnostics Server In Lab Management, change the port of the 
Diagnostics Server entity to the same port as that 
defined during the Diagnostics Server 
configuration.

Diagnostics Server - SSL In Lab Management, change the port of the 
Diagnostics Server entity to the same port as that 
defined during the Diagnostics Server 
configuration.

Component How to change the port
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Unable to Use Non-Default Ports in Microsoft SQL

Problem Description

Performance Center does not work on non-default ports in Microsoft SQL.

Troubleshooting

The Microsoft SQL instance must use a static port. The correct port must be 
defined in the connection string.

Errors in the Migration Tool Report

Problem Description

The migration tool report may contain errors about specific entities or 
projects.

The errors in the migration tool report indicate two types of problems:

➤ The entity is corrupted in the PC 9.51 database and thus could not be 
migrated properly to ALM Platform.

➤ There was a temporary error in the environment while the migration tool 
was running. 

Troubleshooting

The troubleshooting instructions depend on the nature of the problems.

Troubleshooting the migrated database

If the migrated database exists and it's possible to locate the problematic 
entity, open the ALM platform, find the problematic project and entity, and 
manually fix the problem.
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Troubleshooting an entity problem that existed in the database before 
migration

 1 Open the PC 9.51 environment.

 2 Open the project with the problematic entity.

 3 Check if the entity has errors in the PC 9.51 environment.

 a Fix the errors in the PC 9.51 environment or delete the entity if it is 
not needed.

 b Check the log files of the migration tool (MigrationTool, 
ProjectMigrationWrapper). The log files may contain additional data 
about the error. For more information about locating the log files, see 
the Migration Tool Logs section of this document.

 c In the log files find the section containing the project with the 
problematic entity, based on the PC 9.51 database project ID (located 
in the Companies table).

 d Find the problematic entity error.

 4 Migrate the project again.

Troubleshooting an environment problem that existed before migration

The following environment problems can cause migration errors: 

➤ Network problems that caused errors while copying the script files - 
migrate the project again, or manually upload the problematic scripts.

➤ Database problem (insufficient resources, connection problems) - 
migrate the project again.

➤ ALM Platform errors 

➤ not enough memory - restart the ALM Platform and migrate the 
project again.

➤ somebody was working on the environment during the migration and 
caused some operations to fail - migrate the project again.

➤ Insufficient resources on the machine running the migration tool - 
migrate the project again.
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➤ Not enough disk space on the ALM Platform repository - free enough 
storage on the ALM Platform repository and migrate the failed projects 
again.

If there is a problem migrating the project again, see "Cannot Migrate a 
Project Again Because it Cannot be Deleted" on page 264.

Cannot Connect to Oracle Database on 64-bit Windows OS

Problem Description

When you began running the migration, an error appeared when trying to 
define an Oracle database.

The following error message appears when you define an Oracle source or 
target database: "Failed to connect to the database. Reason: ORA-12154: 
TNS: could not resolve the connect identifier specified."

Troubleshooting

This is caused by a bug in the Oracle client. The Oracle client cannot resolve 
third party software applications which have "special" characters in their 
installation paths (including parentheses).

For example, the following path is invalid because it contains parentheses: 

C:\Program Files (x86)\HP\ALM Migration

Check that the migration tool installation path does not contain invalid 
characters. If the path contains invalid characters, reinstall the migration 
tool to a directory without any invalid characters.
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Cannot Migrate a Project Again Because it Cannot be 
Deleted

Problem Description

You may want to migrate a project again after modifying something in the 
project or environment.

Before migrating a project again, the migration tool deletes the first project 
(migrated for the first time) from the ALM Platform, including its database.

If the database has open sessions it may not be successfully deleted.

Troubleshooting

 1 Close all open sessions to the project's database schema and migrate the 
project again.

 2 If the project still cannot be deleted, delete it from the ALM Site 
Administration and migrate the project again.
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Errors in the Migration Log

Problem Description

The following error is received:

MigrationLogic.Tasks.Transformers.MonitorProfileTransformer -  Error re-
encoding Password field for {MONITOR_TYPE} Monitor on 
{SERVER_NAME}, Monitor Profile {MONITOR_PROFILE_NAME}. Probably 
incompatible decryption key.

Troubleshooting

The source monitor has a password which cannot be decrypted. The 
encryption key originally used is different from the default key used in the 
Migration application. First recreate the monitor in the same Monitor 
Profile using a correct password and then run the migration again.

Problem Description

The following error is received: Failed to dispose ProjectMigrationProxy

Troubleshooting

This error can be ignored.

The Migrated Project is Not Linked to the
PC_PROJECT_TEMPLATE Project After the Migration

Problem Description

The following error message, "Maximum retries exceeded 2. Manual apply 
customization required," indicates that the project needs to be manually 
linked to the PC_PROJECT_TEMPLATE project.

The project may not be linked to the template if it was migrated to a 
different domain.
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Note: This troubleshooting procedure can also be used for new projects that 
need to be linked to a PC_PROJECT_TEMPLATE project.

Troubleshooting

 1 In Site Administration > Site Projects tab, verify that the project appears 
in the Linked Projects list of the PC_PROJECT_TEMPLATE. If necessary, 
add it to the Linked Projects list.

 2 Log in to the PC_PROJECT_TEMPLATE project in ALM.

 3 Select Tools > Customize.

 4 From the left menu pane, select Cross Project Customization.

 5 In the Cross Project Customization table, select your project and click the 
Verify toolbar button.
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 6 Click the Apply Customization toolbar button.

Migration Tool Logs

Problem Description

Cannot find the Migration Tool log files.

Troubleshooting

The migration tool creates log files in two directories:

➤ MigrationTool directory - general migration tool logs.

➤ ProjectMigrationWrapper directory - log related to project and entity 
migration.
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These directories are located in the following location: 
<InstallationDir>\orchidtmp\LTLogger.

➤ If there are other Performance Center components installed in the 
machine, like the Performance Center Server or Performance Center Host, 
the <InstallationDir> directory is the installation folder of the 
performance center component.

➤ If there are no other Performance Center components installed on the 
machine, the directories are located in 
<MigrationToolInstallation>\bin\orchidtmp\LTLogger.

To check the value of <InstallationDir> in the registry, find the following 
key:

[HKEY_LOCAL_MACHINE\SOFTWARE\Mercury 
Interactive\LoadRunner\CurrentVersion]

If you still cannot find the log files, check that the 
<InstallationDir>\dat\ltlogconf.xml file exists. If this file is missing, no logs 
will be written.

Problem Description

The migration tool writes error messages to the log file by default. You can 
change the migration tool log level to view additional messages.

Troubleshooting

 1 Open the <InstallationDir>\dat\ltlogconf.xml file with a text editor.

 2 Scroll to the bottom of the file and find the <root> section: 

   <root>

      <level value="Error" />

      <appender-ref ref="ROLLING_4CHAINSAW"/>

      <appender-ref ref="ROLLING" />

    </root>

 3 Replace the word Error with one of the following: Debug, Warn, Info.
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 4 Save the file.

Note: 

➤ Switching the log level to Debug may significantly affect the 
performance of the migration tool.

➤ When you modify the log level, it takes effect immediately. You can 
repeatedly modify the log level while the migration tool runs.

➤ Changing the log level may affect other Performance Center 
components installed on the machine.

Migration Tables Not Found

Problem Description

Tables not found: ProjectMigrationState, EntityMappings, 
MigrationConfiguration. These three tables are created in the source (PC 
9.51) database to save the migration processing state.

If they do not exist the first time the migration runs, the log indicates that 
the tables are not found.
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Troubleshooting

These errors can be ignored. These tables are created by the migration 
process, so they will not exist the first time that migration runs. 

Migration Tool Report Data Not Found

Problem Description

Report Data Not Found: Cannot find the report data because the migration 
report wasn't saved at the end of the migration. 

Troubleshooting

The status of the migration of all projects can be found in the 
ProjectMigrationState table.

The report data is saved on the source (PC 9.51) database, in the 
EntityMappings table. This table contains all of the mappings between PC 
9.51 entities and the migrated ALM Platform entities.

Here are some details about entity mappings:

➤ CompanyID = 0 means that this is either a LAB_PROJECT project entity 
(like host, pool, or location), or a Site Administration entity (like user or 
group).

➤ The EntityType field values are defined as:

LoadTest - 1 Host - 7 Trending - 13

Reservation - 2 MonitorProfile - 8 MIListener - 14

Script - 3 DiagnosticsServer - 9 MonitorOfw - 15

Run - 4 DiagnosticsMediator - 
10

Project - 16

Location - 5 User - 11 TargetIP - 17

Pool - 6 Role - 12
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Load Test Fails to Start and Issues no Error Message

Problem Description

An error message is not issued when a load test fails to start. 

Troubleshooting

This problem is possibly caused by the configuration process. Validate the 
following:

➤ The Performance Center LoadTesting Service in running on the host 
machine under the system account.

➤ The PC user (IUSR_METRO) exists.

➤ In the wlrun7.ini, under the %systemroot% folder, make sure that 
IsOrchid and IsOrchid10 are both set to 1. For more information, see HP 
Software Self-solve knowledge base article KM1098097 
(http://h20230.www2.hp.com/selfsolve/document/KM1098097).

Unable to View Topology Monitors Online

Problem Description

When running a load test that contains topology, the topology monitors 
data is not shown. You may get the following error when clicking the 
topology tab view: This node does not have a monitor. 

Troubleshooting

 1 On the Host machine, validate that EnableInUi is set to 1  in <install 
folder> dat\online_graphs\online_resource_graphs.rmd

 2 In Sitescope, set the monitor frequency to a higher value (by default it is 
set to 10 minutes). Make sure it is set for less than 10 seconds. For more 
information, see HP Software Self-solve knowledge base article 
KM1357671 
http://support.openview.hp.com/selfsolve/document/KM1357671
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